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คํานํา 

ผูเ้ขียนไดมี้ผลงานในการจดัทาํเอกสารเพืDอใชใ้นการสอนจาํนวนมากมายในเวบ็ไซต ์แต่ยงัไม่เคยทีDจดัทาํเป็น

รูปเล่มเพืDอทีDจะจาํหน่ายในทอ้งตลาด เนืDองจากหนา้ทีDการงานทีDค่อนขา้งมากทั�งงานสอนประจาํ และงานทีDปรึกษาทีDทาํอยู ่จน

เมืDอปลายปี 2552 ผูเ้ขียนก็ไดรั้บทาบทามจากทางสาํนกังานส่งเสริมอุตสาหกรรมซอฟตแ์วร์แห่งชาติ (องคก์ารมหาชน) หรือ 

SIPA ใหเ้ขา้มาช่วยจดัทาํเอกสารในการช่วยสอนระบบปฏิบติัการSuriyan ซึDงผูเ้ขียนคิดวา่การจดัทาํเอกสารครั� งนี�คงเป็น

ประโยชน์ต่อบุคคลจาํนวนมาก และเป็นแนวคิดทีDมุ่งเนน้การพฒันาทรัพยากรมนุษยใ์หมี้การความรู้ความสามารถทีDเพิDมขึ�น 

ตลอดจนเป็นการยกระดบัศกัยภาพของการพฒันาและผลิตซอฟตแ์วร์ทีDไม่คิดค่าลิขสิทธิV  จึงตกลงรับจดัทาํงานนี� ขึ�น โดยมีทั�ง

รูปแบบของหนงัสือ และสืDอบนัทึกวดีีโอทีDช่วยใหก้ารถ่ายทอดมีความชดัเจน และเป็นประโยชน์มากยิDงขึ�น 

 ระบบปฏิบติัการ Suriyan เป็นซอฟตแ์วร์ระบบปฏิบติัการภาษาไทยทีDพฒันาต่อจากระบบปฏิบติัการอูบุนตูซึDงเป็น

ทีDนิยมอยา่งมากในทัDวโลก และทีDสาํคญัคือระบบปฏิบติัการนี�ไม่มีค่าลิขสิทธิV  ซึDงหลายคนอาจจะคิดไม่ถึงเลยวา่ซอฟตแ์วร์ทีD

ไม่มีค่าใชจ่้ายใดๆจะมีประสิทธิภาพสูง และใชง้านไดอ้ยา่งง่ายไม่แพก้บัระบบปฏิบติัยอดนิยมทีDเราใชง้านอยูเ่ดิม ซึDงท่านใด

ถา้ยงัไม่เคยทีDใชร้ะบบปฏิบติัการใดเลย หรือหน่วยงานใดทีDตอ้งการลดค่าใชจ่้ายเรืDองลิขสิทธิV ซอฟตแ์วร์ ผูเ้ขียนขอแนะนาํให้

ลองเขา้มาใชง้านดู ซึDงแน่นอนวา่เมืDอท่านใชง้านจะพดูไดค้าํเดียววา่ “ไม่น่าเชืDอ” 

 หนงัสือเล่มนี�ค่อนขา้งเป็นหนงัสือทีDจดัทาํดว้ยระยะเวลาอนัสั�น แต่ก็ไดรั้บความร่วมมือจากหลายฝ่าย ทั�งทีมงาน

บริษทั และสาํนกังานส่งเสริมอุตสาหกรรมซอฟตแ์วร์แห่งชาติ (องคก์ารมหาชน) ซึDงถา้มีขอ้ผดิพลาดประการใดผูเ้ขียน

ขอรับผิดแตเ่พียงผูเ้ดียว โดยผูอ่้านสามารถทีDแนะนาํติชมไปยงัทีDอยูจ่ดหมายอิเลก็ทรอนิกส์ทีDอยูด่า้นล่างนี�  สุดทา้ยนี�ผูเ้ขียน

ขอขอบคุณทางสาํนกังานส่งเสริมอุตสาหกรรมซอฟตแ์วร์แห่งชาติ (องคก์ารมหาชน) และทีมงานทีDไดเ้ขา้มามีส่วนช่วยให้

งานนี�สาํเร็จลุล่วงไปไดด้ว้ยดี 

        ขจร สินอภิรมยส์ราญ 

        Khajorns@gmail.com 
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บทที� 1 เรียนรู้กบั Linux-Suriyan 

1.1 ลนุิกซ์คอือะไร  

ลินุกซ์ ถือกาํเนิดขึ�นมาในปี คศ1991 โดยนกัศึกษาชาวฟินแลนดชื์Dอวา่ Linus Torvalds โดยช่วงแรกนั�นเป็นการเขียนเลียน 
แบบเคอร์เนลของ UNIX และรองรับการทาํงานบนสถาปัตยกรรม i386 เท่านั�นแต่ในปัจจุบนั ดว้ยความ
พยายามของนกัพฒันาซอฟตแ์วร์จากทัDวโลกจึงผลกัดนัใหลิ้นุกซ์รองรับกบัสถาปัตยกรรมคอมพิวเตอร์รุ่น
ใหม่เกือบทุกชนิด ทุกรุ่น 
เคอร์เนลลินุกซ์ใหค้วามสาํคญักบัแนวคิดของซอฟตแ์วร์เสรีพอๆกบัดา้นเทคนิค โดยผลงานทั�งหมดเป็น

ฝีมือของกลุ่มคนทีDเชืDอในแนวคิดเรืDองซอฟตแ์วร์เสรี และใชเ้วลาวา่งจากการทาํงานช่วยกนัพฒันาเทคโนโลยโีอเพนซอร์ส 
ใหดี้ทีDสุดเท่าทีDเป็นไปได ้และยงัไดริ้เริDมโครงการอยา่ง Ubuntu, Mozilla Firefox และซอฟตแ์วร์ดงัๆทีDมีการใชง้านอยา่ง
แพร่หลายโดยไม่มีค่าใชจ่้าย 
จิตวญิญาณของโอเพนซอร์สโดยเฉพาะลินุกซ์ไดมี้อิทธิพลต่อนกัพฒันาและผูใ้ชซ้อฟตแ์วร์ทีDมีแนวคิดร่วมกนัจนเกิดเป็น 
ชุมชนของโอเพนซอร์ส และแนวคิด GNU 
เคอร์เนลลินุกซ์ เป็นระบบแกนหลกัของระบบปฏิบติัการ Suriyan ซึDงพฒันาต่อมาจาก Ubuntu หลงัจากนี�ไปเราจะกล่าวถึง
ประวติัความเป็นมาเฉพาะของ Ubuntu เนืDองจาก Suriyan ไดน้าํเคอร์เนลลีนุกซ์ของ Ubuntu มาพฒันาต่ออีกทอดหนึDง 

1.2 ประวตัคิวามเป็นมาของระบบปฏบิัตกิาร Linux 

เมืDอ Ritchie และ Thomson เริDมมาทาํในอุตสาหกรรมทีDไม่หวงัผลทางธุรกิจ ทาง AT&T ก็จบัมาเป็นระบบปฏิบติัการ Unix 
ซึDงเริDมมีการคิดไลเซนตก์ารใชง้าน  

MIT ไดพ้ฒันาระบบปฏิบติัการและประกาศการใช ้GNU (“GNU’s not Unix”) เป็นโครงการทีDเหมือนกบั UNIX แต่เนน้
เป็นกองทุนซอฟตแ์วร์ฟรี หรือภาษาองักฤษคือ Free Software Foundation (FSF) ในปี 1983 

Linux Kernel มีพฒันาการดงันี�   

ปี เวอร์ชั(น จาํนวนผู้ใช้ ขนาดเคอร์เนล 
(Kbyte) 

เป้าหมาย 

1991 0.01 100 63 Linus Torvalds เขียนเคอร์เนลของ Linux 

1992 0.99 1,000 431 ซอฟตแ์วร์ GNU ไดร้วมกบั Linux Kernel และทาํ
หนา้ทีDไดเ้ตม็ประสิทธิภาพ 

1993 0.99 20,000 938 มีอตัราการกระจายโคด้อยา่งมากมาย 

1994 1.0 100,000 1,017 มีการออกเคอร์เนลเป็นผลิตภณัฑค์รั� งแรก 
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1995 1.2 500,000 1,850 Linux มีบนโปรเซสเซอร์ต่างๆมากมาย 

1996 2.0 1,500,000 4,718 รองรับไดห้ลากหลาย CPUs, มีหลายไอพี, และรองรับ 
Java 

1999 2.2 7,500,00 10,593 Linux มีอตัราโตกวา่ Microsoft Windows NT 

2001 2.4 10,000,000 19,789 Linux เริDมมีการใชใ้นวงการซอฟตแ์วร์ขนาดใหญ่ 

เพืDอให ้Linux ใชง้านไดง่้ายจึงมีการพฒันาระบบ X-Window ขึ�น โดยแนวคิดนี� เกิดขึ�นมาจาก MIT ในปี 1984 

X เป็นการทาํงานภายใตก้ราฟฟิก โดยไดน้าํการใชง้านกราฟฟิกมาใชร่้วมกบัระบบเครือข่ายทีDมีความแขง็แกร่งใน
ระบบปฏิบติัการ UNIX โดยในปี 1988 ไดป้ระกาศ X ใหก้บัสาธารณะชนไดท้ราบ 

ปัจจุบนั Linux ไดแ้ตกแขนงเป็นหลากหลายสายพนัธ์ุทีDนาํมาเป็นส่วนหนึDงของ Linux ทีDไดรั้บความนิยมมีดงันี�  

แหล่ง เวบ็เพจ 

Debian GNU/Linux http://www.debian.org 

 

Linux-Mandriva http://www2.mandriva.com/ 
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Fedora Linux http://fedoraproject.org  

 

Slackware Linux http://www.slackware.com 
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SuSe Linux http://www.suse.com 

 

Linux TLE 

ลีนุกซ์สาํหรับคนไทย 

http://www.opentle.org 
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Thailand Open 
Source Federation 

http://www.tosf.org 

เป็นเวบ็ทีDรวบรวมกลุ่มผูใ้ชง้านโปรแกรมเปิดเผยรหสัพฒันา 
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Suriyan.in.th 

 

1.3 ประสิทธิภาพของ Linux  

เนืDองจากเป็นระบบปฏิบติัการเปิดทาํใหผู้ที้Dเป็นนกัพฒันาสามารถทีDเพิDมเติมสิDงต่างได ้และมีการจดัการดิสกเ์ป็น ext2, ext3 
ext4 หลกัโครงสร้างนี�คลา้ยกบั Network File System (NFS), NTFS, หรือ Netware FS คือมีระบบความปลอดภยัในระบบ
ไฟลด์ว้ย ในขณะทีD FAT/FAT32 ไม่มี 

Linux รองรับระบบการจดัการดิสกร์ะดบัสูงเช่น Redundant Array of Inexpensive Disks (RAID) ซึDงทาํใหข้อ้มูลมีความ
ปลอดภยัแมว้า่มีดิสกที์Dเสียเกิดขึ�น 

การใชง้านถา้ยงัจาํไดก่้อนทีDเราใชว้นิโดวทุ์กวนันี�  เคยมีการใชค้าํสัDงในการสัDงงานบน DOS คาํสัDงในเชลลข์อง Linux มี
หลกัการเดียวกนับางทีอาจพบวา่คาํสัDงในเชลลข์อง Linux ง่ายกวา่ และแน่นอนวา่ประสิทธิภาพดีกวา่โดยไม่ตอ้งพดูถึง 

สาํหรับผูพ้ฒันาก็เช่นกนัระบบปฏิบติัการ Linux มีเครืDองมือในการพฒันาต่างๆมากมายเช่น Assembler, C/C++ compilers, 
เพืDอใชพ้ฒันาพร้อมกบัไลบารีDทีDช่วยในการเขียนแอพพลิเคชัDนภายใต ้GNU 

1.4 เคอร์เนลคอือะไร  

เคอร์เนลถือเป็นส่วนสาํคญัทีDสุดของระบบปฏิบติัการต่างๆ  โดยหนา้ทีDของเคอร์เนลคือประสานการทาํงานระหวา่ง
ฮาร์ดแวร์และซอฟตแ์วร์ 

1.5 GNU คอือะไร  

โครงการ GNU จดัตั�งขึ�นในปี คศ1984 เพืDอพฒันาระบบปฏิบติัการทีDคลา้ยกบัระบบปฏิบติัการ 
Unix โดยมุ่งเนน้ฟรีซอฟแวร์, ระบบ GNU ต่างๆทีDใชพื้�นฐานของระบบปฏิบติัการ GNU ทีDใชลิ้
นุกซ์เป็นแกนหลกัตอนนี� มีใชก้นัแพร่หลายระบบเหล่านั�น จึงถูก เรียกวา่ลินุกซ์แต่ชืDอทีDถูกตอ้ง
ควรจะเป็น GNU/Linux 
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ปรัชญาของโครงการ GNU นั�น ใกลเ้คียงกบัปรัชญาของฟรีซอฟแวร์, ทีDโครงการต่างๆนาํมาใชเ้ช่น Ubuntu คาํอธิบาย
แนวคิดของฟรีซอฟแวร์สามารถหาอ่านไดที้Dตอนนี� เรียกวา่ “ฟรี ซอฟแวร์” 
ดูรายละเอียดเพิDมเติมจากเวบ็ไซต ์http://www.wikipedia.org/wiki/GNU หรือ http://th.wikipedia.org/wiki/GNU 

1.6 ความเข้าใจเกี(ยวกบัที(มาของชื(อ Suriyan  

Suriyan เป็นซอฟตแ์วร์ระบบปฏิบติัการทีDสามารถใชง้านไดบ้นเครืDองคอมพิวเตอร์ทัDวไป โดย SIPA เห็นวา่การทีDประชากร

ในชาติจะตอ้งใชซ้อฟตแ์วร์ระบบปฏิบติัการทีDเป็น ซอฟตแ์วร์เชิงพาณิชยน์ั�น นอกจากจะสิ�นเปลืองและไม่ปลอดภยัแลว้ เรา

จะไม่สามารถใชง้านไดอ้ยา่งย ัDงยนือีกดว้ย ทาง SIPA จึงพฒันาระบบปฏิบติัการ Suriyan ทีDเป็นระบบปฏิบติัการโอเพน

ซอร์สทั�งระบบขึ�นมาใหใ้ชง้าน 

1.7 จาก Ubuntu สู่ Suriyan 

Suriyan เป็นโครงการพฒันาลินุกซ์ของสาํนกังานส่งเสริมอุตสาหกรรมซอฟตแ์วร์แห่งชาติ (องคก์ารมหาชน) หรือทีDรู้จกักนั
ในชืDอ SIPA เพืDอเป็นทางเลือกสาํหรับผูที้Dตอ้งการใชร้ะบบปฏิบติัการลินุกซ์บนเครืDองเดสท็อป ซึDงทาง SIPA เลือกใช้
ระบบปฏิบติัการลินุกซ์ Ubuntu มาเป็นฐานในการพฒันา Suriyan เป็นลินุกซ์กึDงสาํเร็จรูป ไม่ไดร้วมโปรแกรมทีDน่าใชง้านไว้
ทุกตวั แต่ Suriyan มาพร้อมกบัความสามารถหลกัของ Ubuntu ผนวกกบัภาษาไทย ฟอนตไ์ทย งานพฒันาทีDไดรั้บการ
สนบัสนุนจากนกัพฒันาอิสระ และชุดโปรแกรมพื�นฐาน ทีDทุกคนตอ้งใชง้าน ไม่วา่จะเป็นงานดา้นสาํนกังาน ดา้น
มลัติมีเดีย ดา้นกราฟิกและโปรแกรมอรรถประโยชน์ต่างๆ สาํหรับ Suriyan สามารถใชค้ลงัซอฟตแ์วร์ (Software 
Repository) ของ Ubuntu ไดแ้ละยงัสามารถใชง้านคลงัซอฟตแ์วร์ PPA โดยปกติ และยงัสามารถอพัเกรดไปเป็น Ubuntu ใน
เวอร์ชนัถดัไปไดอ้ตัโนมติั ซึDงจะยงัคงใชง้านชุดแพคเกจบางส่วนทีDมาพร้อมกบั Suriyan ได ้

Suriyan มีแผนการพฒันาโดยจะออกรุ่นทุกๆ 1 ปี โดยใชชื้Dอรุ่นตามการโหวตชืDอและกิจกรรมบนเวบ็ไซต ์Suriyan.in.th เป็น
หลกั สาํหรับงานพฒันา Suriyan เนน้การพฒันาทีDตน้นํ� าคือ Ubuntu และซอฟตแ์วร์ตน้นํ� าอืDนๆ เช่น Gnome, OpenOffice.org 
เป็นตน้ สาํหรับการพฒันาในส่วนของ Suriyan เองมีกิจกรรมใหร่้วมพฒันาอยู ่4 ส่วนไดแ้ก่ 

• Package Maintainer ในอนาคตจะรวมเป็นทีม MOTUs (Master of The Univers) ของ Ubuntu Contributor 

• Bug Report 

• Manual โปรแกรมต่างๆ ทีDมีอยูใ่น Suriyan และโปรแกรมทีDน่าใชอื้Dนๆ  

• กิจกรรมอืDนๆ เช่น โหวดชืDอรหสัพฒันา, ประกวดตกแต่ง Desktop, ภาพพื�นหลงั, ออกบูธ ฯลฯ 

(ขอ้มูลจากเวบ็ไซต ์Suriyan.in.th) 
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1.8 ความเข้าใจเกี(ยวกบั Suriyan 

Suriyan เป็นระบบปฏิบติัการทีDพฒันาต่อมาจาก Ubuntu ซึDง Ubuntu นั�นเป็นระบบปฏิบติัการลินุกซ์ดิสโทรทีDกาํลงัเป็นทีD
นิยมกนัอยา่งแพร่หลายทีDสุดทัDวโลก ซึDงในปัจจุบนัระบบปฏิบติัการลินุกซ์มีหลากหลายสายพนัธ์ุ ขอ้ดีของลินุกซ์ดิสโทร 
(Linux Distribution) หมายถึงลินุกซ์สาํเร็จรูปทีDมีการปรับแต่งเพืDอใหเ้หมาะแก่การใชง้านแลว้ในเบื�องตน้ และ ลินุกซ์ดิส
โทรทีDเป็นทีDรู้จกักนัดีก็คงจะหนีไม่พน้ลินุกซ์สายพนัธ์ุดงัๆ อยา่งเช่น Redhat, SUSE, Mandriva เป็นตน้ ทีDมาของ Ubuntu 
นั�นไดพ้ฒันาต่อสายพนัธ์ุมาจาก Debian GNU/Linux ซึDงเป็นระบบปฏิบติัการทีDนิยมกนัอยา่งแพร่หลายในการใชก้บั
ระบบปฏิบติัการบนเครืDองแม่ข่าย  

1.9 เหตุใดจงึควรสนใจกบั Suriyan 

สาเหตุทีDทาํให ้Suriyan เป็นระบบปฏิบติัการทีDไม่ควรมองขา้มเนืDองจากการคดัสรรโปรแกรมทีDเหมาะสมกบัการใชง้านใน
ปัจจุบนัของผูใ้ชง้านเมืDอเปรียบเทียบกบัลินุกซ์ดิสโทรอืDนๆทีDมีความซํ� าซอ้นของซอฟตแ์วร์ และรูปแบบคาํสัDงทีDมากเกินไป
จนผูใ้ชง้าน หรือผูดู้แลเองยงัสบัสนในการนาํโปรแกรมมาใช ้หรืออธิบาย นอกจากนี�  Suriyan ยงัพฒันาเป็นภาษาไทยเพืDอ
ช่วยเหลือในการเรียกเมนู และการตดัแต่งคาํ 

1.10 ฟรี ซอฟแวร์ทาํไมจะดไีม่ได้ 

โครงการ Suriyan นั�นยดึถือแนวคิดของการพฒันาซอฟตแ์วร์แบบโอเพนซอร์สอยา่งจริงจงั โดยมีองคก์รส่งเสริมใหบุ้คคล
ใชแ้ละต่อยอดการปรับปรุงซอฟตแ์วร์ นัDนหมายความวา่คุณไม่จาํเป็นตอ้งเสียค่าใชจ่้ายสาํหรับ Suriyan และรับประกนัวา่จะ
เป็นเช่นนี�ตลอดไปในอนาคตอยา่งไรก็ตาม 

1.11 ความแตกต่างที( Suriyan มใีห้เหนือระบบปฏิบัตกิารอื(น 

มีระบบปฏิบติัการลินุกซ์มากมายทีDมีพื�นฐานมาจาก GNU/Linux ยกตวัอยา่งเช่น Redhat, Mandriva, Debian เหตผุลทีD 
Suriyan เเป็นพื�นฐานเพราะอยา่งทีDทราบ Debian เป็นสายพนัธ์ุลินุกซ์ทีDมีชืDอเสียงโด่งดงัในดา้นความกา้วหนา้ และความ
เสถียร ดงันั�น Suriyan จึงนาํพื�นฐานของ Ubuntu, พฒันาต่อยอดโดยแบ่งเป็นระบบปฏิบติัการสาํหรับเดสกท์๊อป และ
เซิร์ฟเวอร์ นอกจากนี�ยงัมีการคดัเลือกเฉพาะแอพพลิเคชัDนทีDเด็ดมาใส่ โดยลดความซํ� าซอ้นของซอฟตแ์วร์ 

1.12 บริการสนบัสนุนระยะยาว (Long term Support: LTS) 

ทุกรุ่นของอูบุนตูจะมีบริการดูแลอยา่งนอ้ย 18 เดือนในดา้นการปรับปรุงความปลอดภยั และเพิDมเติมงานดา้นต่างๆ บางรุ่น
อาจจะมีการสนบัสนุนทีDยาวนานกวา่นั�นเช่นบริการ 3 ปีสาํหรับเดสกท์็อป และ 5 ปีสาํหรับเซิร์ฟเวอร์ สาเหตุทีD
กระบวนการพฒันาทีDยาวนานนี� เก็บเพืDอ: 

- ลดการปรับเปลีDยนระบบปฏิบติัการบ่อยๆ เนืDองจากการปรับเปลีDยนจะมีความเสีDยงต่อแอพพลิเคชัDนทีDพฒันา 
- ผูใ้ชเ้กิดความคุน้เคยต่อระบบปฏิบติัการนั�นไม่ตอ้งเรียนรู้บ่อยๆ 
- ทาํใหมี้เวลาเพิDมขึ�นในกรณีทีDมีการพฒันาสาํหรับในภาษาทอ้งถิDนตา่งๆ 
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1.13 ทาํไมต้องใช้ Suriyan? 

Suriyan เป็นซอฟตแ์วร์ระบบปฏิบติัการทีDสามารถใชง้านไดบ้นเครืDองคอมพิวเตอร์ทัDวไป โดย SIPA เห็นวา่การทีDประชาชน
ในชาติจะตอ้งใชซ้อฟตแ์วร์ระบบปฏิบติัการทีDเป็น ซอฟตแ์วร์เชิงพาณิชยน์ั�น นอกจากจะสิ�นเปลืองและไม่ปลอดภยัแลว้ เรา
จะไม่สามารถใชง้านไดอ้ยา่งย ัDงยนือีกดว้ย ทาง SIPA จึงพฒันาระบบปฏิบติัการ Suriyan ทีDเป็นระบบปฏิบติัการโอเพน
ซอร์สทั�งระบบขึ�นมาใหใ้ชง้าน เหตุผลหลกัทีDใชง้าน Suriyan มีดงันี�  

• Suriyan ปลอดภยัจากไวรัส 

• Suriyan ไม่มีค่าลิขสิทธิV การใชง้าน 

• Suriyan สามารถคดัลอกและแจกจ่ายได ้

• Suriyan เป็นระบบปฏิบติัการโอเพนซอร์ส 

• Suriyan มีโปรแกรมใหเ้ลือกใชก้วา่ 4,000 โปรแกรม ไม่รวมโปรแกรมสาํหรับระบบปฏิบติัการลีนุกซ์อืDนๆ 

1.14 การสนับสนุนและการให้บริการ 

Suriyan นั�นไดถู้กสนบัสนุนจาก SIPA ซึDงมุ่งเนน้การกาํจดัซอฟตแ์วร์ระบบปฏิบติัการเถืDอนทีDมีอยูใ่นทอ้งตลาด ใหห้มดไป 
และเพืDอใหป้ระเทศไทยมีระบบปฏิบติัการสาํหรับคนไทยโดยทีมงานภายในประเทศ 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 12 

 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 13 

 

บทที� 2 การติดตั�ง และการเริ�มใช้งาน Suriyan 

ซอฟตแ์วร์ Suriyan สามารถทีDจะบูตดว้ยแผน่ซีดีรอม/ดีวดีีรอม หรือเลือกทีDจะติดตั�งบนเครืDองทีDตอ้งการได ้ ขึ�นอยูก่บัความ
ตอ้งการของผูใ้ชซึ้Dงหลายคนอาจจะตอ้งการสมัผสัการใชง้านก่อนทีDจะตดัสินใจเลือกติดตั�งลงบนเครืDอง 

2.1 การบูตด้วยแผ่นซีดรีอม/ดวีดีรีอม 

1. ใส่แผน่ติดตั�ง Suriyan 

2. เลือกภาษาทีDตอ้งการ, เคาะ Enter หรือรอประมาณ 30 วนิาที จะถูกเลือกเป็นภาษาองักฤษ 
กรณีทีDตอ้งการเลือกภาษาไทยใหเ้ลือกในขั�นตอนนี� เมนูคาํสัDงต่างๆจะปรากฎเป็นภาษาไทย  

 

- Try Suriyan without any change to your computer เป็นการบูตเพืDอเลือกใชง้านระบบปฏิบติัการ Suriyan โดยไม่มี
การติดตั�งซอฟตแ์วร์ใดๆลงบนเครืDอง 

- Install Suriyan เป็นการติดตั�งระบบปฏิบติัการ Suriyan ลงบนเครืDองเป้าหมาย ซึDงจะตอ้งมีการจดัเตรียมพาร์ติชัDน
ดว้ย 

- Check disc for defects เป็นการตรวจสอบคุณภาพมีเดีย หรือแผน่ทีDติดตั�ง 

- Test memory เป็นการทดสอบหน่วยความจาํทีDใช ้

- Boot from first hard disk เป็นการระบุบูตจากฮาร์ดดิสกที์Dมีระบบปฏิบติัการอยูเ่ดิม 
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2.2 การตดิตั%ง แบบกราฟิก 

Suriyan มีระบบการติดตั�ง แบบ GUI (Graphic User Interface) ทาํใหง่้ายอยา่งมากในการทีDจะติดตั�ง Suriyan ซึDงบอกไดเ้ลย
วา่ง่ายกวา่การติดตั�ง Windows XP เสียอีก นอกจากนี� คุณยงัสามารถทดลองก่อนติดตั�งจริง 
คุณสามารถทดลองใชง้าน Suriyan ก่อนได ้โดยทีDไม่ตอ้งติดตั�ง ลงในเครืDองคอมพิวเตอร์ของคุณ ซึDงคุณสามารถแน่ใจไดเ้ลย
วา่ขอ้มูลในเครืDองคอมพิวเตอร์ของคุณจะปลอดภยั และเมืDอคุณทดลองจนพอใจจึงค่อยตดัสินใจทีDจะใช ้เมืDอนั�น คุณจึงค่อย
ติดตั�งลงในฮาร์ดดิสกใ์นตอนหลงัก็ได ้โดยการติดตั�งจะใชเ้พียงแคห่นึDงแผน่ซีดีรอมเท่านั�น 
Suriyan ไดค้ดัสรรโปรแกรมทีDดีทีDสุดสาํหรับคุณ ทาํใหไ้ฟลแ์ละโปรแกรมทั�งหมดสามารถบรรจุไดอ้ยูใ่นหนึDงแผน่ซีดีรอม 
และป้องกนัความสบัสนกบัผูใ้ชที้Dจะเลือกใหโ้ปรแกรมทีDดีในการทาํงานอยา่งหนึDงอยา่งใด 

2.3 ระบบอพัเดตที(มปีระสิทธิภาพ 

เนืDองจาก Suriyan เป็นลินุกซ์สายพนัธ์ุ Debian จึงใชร้ะบบ APT (Advanced Package Tool) ในการจดัการแพค็เกจ ซึDงระบบ
นี� มีขอ้ดีทีDสามารถอพัเดตหรือติดตั�ง แพค็เกจเพิDมเติมผา่นอินเทอร์เน็ตไดต้ลอดเวลา แถมยงัจดัการปรับแต่งค่าพื�นฐานใหโ้ดย
อตัโนมติัอีกดว้ย 

2.4 การอพัเดตระบบให้ทนัสมยัอยู่เสมอ 

ดว้ยการทีD Suriyan ออกเวอร์ชัDนใหม่ในทุกๆ 6 เดือน ทาํใหคุ้ณมัDนใจไดว้า่ คุณจะไดใ้ชโ้ปรแกรมในเวอร์ชัDนทีDใหม่ล่าสุด
ตลอดเวลา รวมทั�ง สามารถมัDนใจไดใ้นเรืDองของระบบรักษาความปลอดภยัทีDอพัเดตกนัแบบรายวนั 
ในบทเรียนนี� เราจะกล่าวถึงตั�งแตก่ารดาวน์โหลดซอฟตแ์วร์ติดตั�งจนถึงการติดตั�งระบบปฏิบติัเพืDอนาํมาทดแทน
ระบบปฏิบติัการเดิมทีDมีอยู ่
 

2.5 การดาวน์โหลดโปรแกรม 

เนืDองจากระบบปฏิบติัการ Suriyan เป็นระบบปฏิบติัการเสรีทาํใหเ้ราสามารถทีDจะดาวน์โหลด และนาํซอฟตแ์วร์มาติดตั�ง
โดยไม่ตอ้งเสียค่าใชจ่้าย เพียงแคคุ่ณมีเครืDองคอมพิวเตอร์ และเปิดเวบ็บราวเซอร์อยา่งเช่น Internet Explorer หรือ Firefox 
และเขา้ไปในเวบ็ไซต ์http://suriyan.in.th หลงัจากนั�นก็ตรวจสอบเวอร์ชัDนโดยดูตวัเลขทีDไดท้าํการประกาศใหม่ล่าสุด 

 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 15 

 

เมืDอคุณเขา้มาถึงขา้งในของโฟลเดอร์ทีDเก็บ Suriyan เวอร์ชัDนล่าสุดแลว้ ในนี�จะมีไฟลด์าวน์โหลดของ Suriyan สาํหรับ CPU 
รุ่น 32 บิตคือ i386 ปัจจุบนัเวอร์ชัDนคือ Suriyan 53.04 ใหค้ลิกทีDลิงกข์องไฟล ์(ดงัภาพ) เพืDอทาํการดาวน์โหลดอิมเมจไดเ้ลย 
ซึDงคุณควรจะใชโ้ปรแกรมช่วยดาวน์โหลดเพืDอป้องกนัความผิดพลาดของไฟล ์คุณอาจใชโ้ปรแกรมช่วยดาวน์โหลดทีDเป็น 
Open Source สาํหรับ Windows อยา่งTrueDownloader ทีDสามารถดาวน์โหลดมาใชไ้ดฟ้รีจาก 
http://sourceforge.net/projects/downloadplus 
 

2.6 ตรวจสอบความสมบูรณ์ของไฟล์ 

ระบบปฏิบติัการ Suriyan ทีDดาวน์โหลดจากเวบ็ไซต ์http://suriyan.in.th/download แบ่งเป็นสองเวอร์ชัDนคือเวอร์ชัDนทีDเป็น
แบบแผน่ดีวดีีรอม และเวอร์ชัDนทีDเป็นซีดีรอม 
คุณสามารถคลิกดาวน์โหลดไฟล ์suriyan-53.04-i386-dvd.iso ทีD ISO Image เพืDอโหลดเวอร์ชัDนทีDเป็นดีวดีีรอม 

 
ซึDงไฟลที์Dดาวน์โหลดมามีขนาดใหญ่มาก (ประมาณหนึDง Gigabyte สาํหรับเวอร์ชนั 52.10.1) อาจจะใชร้ะยะเวลา และ
เสน้ทางการดาวน์โหลดผา่นหลายฮอป เราจึงควรทีDจะตรวจสอบความสมบูรณ์ของไฟลที์Dดาวน์โหลดก่อนนาํมาสร้างแผน่
ซีดีรอม/ดีวดีีรอม โดยคลิกทีD MD5Sum: suriyan-53.04-i386-dvd.iso.md5 จะขึ�นโคด้ MD5 ดงันี�    
1c193f728528583a1d39e993c4aecb0d 
 
กรณีทีDเลือกดาวน์โหลดเวอร์ชัDนทีDเป็นซีดีรอมใหค้ลิกเลือกทีD Suriyan-internalwarm-live-8386_v52.10.iso 

 
คลิกทีD suriyan-internalwarm-live-i386_v52.10.iso.md5 เพืDอตรวจสอบค่า  md5 ซึDงค่าทีDแสดงคือ
395b6de7006b999a73c859f8ae3a4db6 
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การตรวจสอบค่า MD5Sum เพืDอเปรียบเทียบวา่อิมเมจทีDไดน้ั�นสมบูรณ์หรือไม่ ถา้เป็น Linux จะใชค้าํสัDง MD5Sum และระบุ
ตาํแหน่งไฟล ์แต่ถา้เป็นระบบปฏิบติัการ Windows คุณสามารถดาวน์โหลด md5summer (ดาวน์โหลดไดจ้าก 
http://www.md5summer.org/download.html) เพืDอตรวจสอบค่าตรวจสอบ MD5 ถา้ค่าทีDไดต้รงกนัแสดงวา่ไฟลที์Dดาวน์
โหลดนั�นสมบูรณ์ 
 

2.7 การสร้างแผ่นซีด ี

เมืDอไดไ้ฟลแ์ละไดท้าํการตรวจสอบความสมบูรณ์ของไฟลเ์ป็นทีDเรียบร้อยแลว้ ก็ถึงเวลาทีDจะสร้างแผน่ Suriyan จากไฟล ์
.iso โดยในทีDนี� เราจะใชโ้ปรแกรม Nero Burning ROM เป็นหลกั เพราะคิดวา่น่าจะเป็นโปรแกรมทีDมีคนใชม้ากทีDสุดขั�นตอน
มีดงันี�  

1. ใหเ้ปิดโปรแกรม Nero 
2. ไปทีDเมนูหลกัของโปรแกรม เลือกทีD Recorder แลว้คลิกเลือกทีD Burn Image... 
3. จากนั�น ใหท้าํการเลือกไฟล ์.iso ทีDเราไดด้าวน์โหลดมาเลือกความเร็วในการเขียนแผน่ทีDเหมาะสม ไม่ตอ้งเร็ว

จนเกินไปนกั อาจเป็น 16x ก็ได ้จากนั�น  
4. ใหค้ลิกทีDคาํสัDง Burn รอเขียนจนเสร็จ 

หรือถา้ตอ้งการใช ้Opensource ใหใ้ชซ้อฟตแ์วร์ใน Chantra ซึDงจะมี Infrarecorder สามารถดาํเนินการไดเ้หมือนกนั 
 

2.8 ความต้องการของระบบ 

ระบบปฏิบติัการ Suriyan มีความตอ้งการทรัพยากรนอ้ยมากเมืDอเทียบกบัระบบปฏิบติัการ Windows ทีDใชก้นัอยูท่ัDวไป มี
รายละเอียดดงันี�  
  
ตารางที(  1 คาํอธิบายความต้องการของระบบ 

หัวข้อ คาํอธิบาย 
สถาปัตยกรรม CPU รองรับระบบปฏิบติัการ 32 บิตทีDมีความเร็ว 1 GHz ขึ�นไป 
หน่วยความจาํ หน่วยความจาํ 512 MB 
เนื�อทีDวา่งในการ
ติดตั�งระบบ(ขั�นตํDา) 

เนื�อทีDวา่งในฮาร์ดดิสก ์4 GB 

2.9 การตดิตั%ง Suriyan 

เมืDอไดแ้ผน่ซีดีมาเป็นทีDเรียบร้อยแลว้เราก็พร้อมทีDจะไปทดลองใชง้าน และติดตั�ง กนัแลว้ครับ สิDงแรกทีDคุณตอ้งทาํคือ ตอ้งตั�ง
ค่าไบออสใหบู้ตจากซีดี/ดีวรีอมเสียก่อน ซึDงวธีิการตั�งค่าของแต่ละเครืDองนั�น ขอใหคุ้ณดูคู่มือของ Mainboard หลงัจากนั�นก็
ใส่แผน่แลว้เปิดเครืDองเพืDอบูตทาํการติดตั�ง  
ขั%นตอนตดิตั%ง 
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1. เมืDอขึ�นหนา้จอติดตั�งใหเ้ลือกภาษา – ไทย 

 
2. เลือกทีD Install Suriyan, เคาะ Enter 

 
3. ในหนา้ “ยนิดีตอ้นรับ” เลือกภาษา เป็น “ภาษาไทย”, คลิกปุ่ม ถดัไป 
4. ในหนา้ “คุณอยูที่Dไหน” ใหเ้ลือก ภูมิภาค:เอเซีย, Zone:ไทย , คลิกปุ่ม ถดัไป 
5. ในหนา้ “ผงัแป้นพิมพ”์ ใหเ้ลือก Thailand, คลิกปุ่ม ถดัไป 
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6. ในหนา้ “จดัเตรียมพื�นทีDบนฮาร์ดดิสก”์, เลือก Erase and use the entire disk,  คลิกปุ่ม ถดัไป 

หมายเหตุ กรณีทีDเลือก Erase and use the entire disk จะมีขอ้ความแจง้เตือนใหท้ราบวา่ระบบปฏิบติัการเดิม
ทั�งหมดจะถูกทาํลาย ดงันั�นถา้ตอ้งการทีDจะติดตั�งแบบ Dual Boot ตอ้งอ่านคู่มือดาํเนินการไดจ้าก 
http://ubuntuforums.org/showthread.php?t=1035999  

7. ในหนา้ “คุณคือใคร” ระบุชืDอทีDใช,้ รหสัผา่น และยนืยนัรหสัผา่น, ชืDอเครืDอง, คลิกปุ่ม ถดัไป 
8. ในหนา้ “พร้อมทีDติดตั�งแลว้”, คลิกปุ่ม ติดตั�ง 
9. รอติดตั�งแพค็เกจ, จนถึงหนา้การติดตั�งเสร็จสิ�นแลว้, คลิกปุ่ม เริDมใหม่ 
10. นาํแผน่ซีดีรอม/ดีวดีีรอมออก และเคาะ Enter 

เราสามารถทีDติดตั�ง Suriyan หรือ Ubuntu บนระบบปฏิบติัการ Windows ทีDมีอยูเ่ดิมได ้โดย Suriyan จะทาํการสร้างบูตโหลด
เดอร์ขึ�นมาแทนระบบปฏิบติัการเดิม และสร้างเมนูในการเลือกบูตไดท้ั�งระบบปฏิบติัเดิม และระบบปฏิบิตการใหม่ทีDติดตั�ง 

ขั%นตอนที(มกีารปรับเปลี(ยน 
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1. ในขั�นตอนทีD 6 หนา้จอจะเปลีDยนแปลงดงันี�  

  
แถบสีนํ� าเงินเป็นระบบปฏิบติัการเดิม ซึDงระบบปฏิบติัการ Suriyan จะถูกแนะนาํติดตั�งในแถบสีนํ� าตาล ซึDงถา้ผู ้
ติดตั�งตอ้งการระบุขนาดเองก็สามารถทีDจะทาํไดโ้ดยเลืDอนแถบสีเทาดา้นบน 

2. ในขั�นตอนทีD 7 จะมีเพิDมขึ�นมาหนึDงขั�นตอนคือการยา้ย User Profile ของระบบปฏิบติัการเดิม 

 

3. เมืDอบูตเขา้สู่ระบบปฏิบติัการจะปรากฎเมนูในการเลือกบูต (Boot Loader) 
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2.10 การเปิดเครื(องหลงัตดิตั%งเสร็จ 

หลงัจากทีDไดท้าํการติดตั�ง Suriyan เป็นทีDเรียบร้อยแลว้ เมืDอคุณทาํการเปิดเครืDองคอมพิวเตอร์ คุณจะไดพ้บกบัเมนูสาํหรับ
เลือกระบบปฏิบติัการ (กรณีติดตั�งคู่กบั Windows) เพืDอทีDคุณจะสามารถเลือกไดว้า่จะเขา้ใชง้าน Suriyan หรือ Windows จะ
เห็นวา่ในเมนูจะมีใหเ้ลือกอยูห่ลายตวั ซึDงจะมีอยู ่3 ตวัเลือกทีDสาํคญัคือ 

-  Suriyan : สาํหรับเขา้ใชง้าน Suriyan 
-  Recovery mode : เพืDอแกไ้ขปัญหาสาํหรับ Suriyan 
-  Windows : สาํหรับเขา้ใชง้าน Windows 

เมืDอผา่นจากเมนูสาํหรับเลือกระบบปฏิบติัการมาแลว้ คุณจะพบกบัหนา้ต่างลอ็กอินเพืDอเขา้ระบบ  
1. คลิกทีDชืDอ และใส่รหสัผา่น 

2. ตรวจสอบหนา้จอหลงัจากติดตั�ง 

 
 

 
 

 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 21 

 

2.11 การเริ(มต้นใช้งานหลงัจากตดิตั%ง 

เมืDอลอ็กออนเขา้ใชง้าน Suriyan เวอร์ชัDน 52.10 จะปรากฏหนา้จอการใชง้านคลา้ยระบบปฏิบติัการ Windows ซึDง
ประกอบดว้ย  

- พื�นหลงั (Desktop) 

- ไอค่อน (Icon) 

- เมนูหลกั (Main menu) 

- พาเนล (Panel) 

 

 

 

2.12 การลอ็กออฟออกจากระบบ Suriyan 

• คลิกปุ่ม Power Switch 
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• ระบุเลือกกิจกรรมทีDตอ้งการดงัรูป 
 

 
 

 
 
 
 
 
 
 

- ค่าทีDระบุประกอบดว้ย 3 ส่วนคือ 
 

ตารางที(  2 คาํอธิบายค่าต่าง ๆ ในการล๊อกออฟ 

หัวข้อ คาํอธิบาย 
Status  จะหมายถึงการกาํหนดสถานะผูใ้ช ้ ซึDงจะมีผลอยา่งเช่นในโปรแกรม Empathy  

โปรแกรม pidgin หรือโปรแกรมอืDนๆ ทีDสามารถระบุ Status ไดว้า่ ไม่อยู ่หรือไม่
วา่ง 

Session - Lock Screen เป็นการลอ็คหนา้จอเมืDอไม่อยูที่DเครืDอง 
- Guest Session  เป็นการกาํหนดเขา้เซสชัDนในระดบั Guest ซึDงไม่ตอ้งระบุ

รหสัผา่นในการลอ็กออน 
- Switch User เป็นการเปลีDยนผูใ้ชที้Dลอ็กออน 

Shutdown ชุดคาํสัDงทีDปิดเครืDองประกอบดว้ย 
- Logout เป็นการออกจากผูใ้ชที้Dดาํเนินการอยู ่

- Suspend เป็นการปิดเครืDองขณะทีDมีไฟเลี�ยงหน่วยความจาํ 

- Hibernate เป็นการปิดเครืDองโดยจะนาํขอ้มูลในหน่วยความจาํจดัเก็บเป็น
ไฟล ์และไม่มีไฟเลี�ยงเมืDอเปิดเครืDอง 

- Restart เป็นการปิด และเปิดเครืDองใหม่ 

- Shutdown เป็นคาํสัDงในการปิดเครืDอง 
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2.13 การปิดเครื(อง 

1. ในหนา้จอใชง้าน Suriyan 

2. คลิกปุ่ม Power Off และคลิกทีDคาํสัDง Shutdown 

3. คลิกคาํสัDง Shutdown เพืDอปิดระบบ หรือรอ 60 วนิาทีเพืDอปิดระบบ 

2.14 เริ(มต้นลอ็กออนเข้าสู่ระบบ Suriyan 

1. หลงัจากทีDคลิกชืDอผูใ้ชเ้พืDอลอ็กออนแลว้ เราสามารถทีDจะปรับค่าต่างไดด้งันี�  

 
 

ตารางที( 3  คาํอธิบายการปรับค่าต่าง ๆ เมื(อลอ็กอนิแล้ว  

หัวข้อ ค่าที(ระบุ คาํอธิบาย 
ภาษา  ไทย ระบุหนา้จอในการเขา้ใชง้านระบบปฏิบติัการ ซึDงสามารถระบุ

ภาษาอืDนๆไดโ้ดยคลิกเลือก “อืDนๆ” และระบุภาษาทีDตอ้งการ 

 
แป้นพิมพ ์ USA สามารถระบุแป้นพิมพอื์Dนๆไดโ้ดยคลิกเลือก อืDนๆ (Other) และ

เลือกชนิดภาษาเช่น  
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หัวข้อ ค่าที(ระบุ คาํอธิบาย 

 
วาระ   GNOME สามารถระบุ Failsafe, xterm หรือถา้มีการติดตั�ง KDE ก็

สามารถทีDระบุเพิDมเติมได ้
ฟังกช์ัDน
ช่วยเหลือผู ้
บกพร่องทาง
กายภาพ  

ไม่ไดร้ะบุ 

 
วนัทีD และเวลา เวลาทอ้งถิDน ประกอบดว้ยวนัทีD และเวลา 
ปุ่มปิดเครืDอง สญัลกัษณ์ปุ่ม Power 
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บทที� 3 การปรับแต่งค่ากาํหนดพื�นฐานบน Suriyan 

ในบทนี�จะแนะนาํเรืDองของการใชง้านในเบื�องตน้ ตั�งแต่แนะนาํใหคุ้ณรู้จกักบัส่วนต่างๆบนหนา้จอ การปรับแต่งค่าพื�นฐาน
เลก็ๆนอ้ยๆ ไปจนถึงแนะนาํโปรแกรมสาํหรับใชง้านทัDวไปทีDไดร้วบรวมมาแลว้พร้อมกนัในแผน่ Suriyan 
 

3.1 หน้าจอการทาํงาน 

หนา้จอของ Suriyan แมจ้ะมีความเรียบง่ายมากแลว้ แต่สาํหรับผูที้DเพิDงเริDมใช ้ก็ไม่น่าแปลกใจอะไรหากจะหยบิจบัอะไรไม่
ค่อยถูกเพราะความไม่เคยชิน เพราะฉะนั�น ผมจะพาไปทาํความรู้จกักบัส่วนต่างๆของหนา้จอกนัสกัเลก็นอ้ยครับ 

 
อธิบายตามภาพดา้นบน 

1. Main Menu คือทีDเก็บเมนูต่างๆสาํหรับเรียกโปรแกรม อยูต่าํแหน่งซา้ยล่าง 
2. Application Launcher สาํหรับเรียกโปรแกรมซึDงเป็นแถบเหมือน Task Bar บน Windows 
3. System tray สาํหรับแสดงสถานะของระบบ และโปรแกรมทีDทาํการซ่อนตวัอยู ่
4. ปุ่มปิดเครืDองและออกจากระบบ 
5. ปุ่มแสดงหนา้จอ สาํหรับซ่อนและแสดงหนา้ต่างทั�งหมด 
6. Window List จะแสดงโปรแกรมต่างๆทีDกาํลงัทาํงานอยู ่
7. Workspaces Switcher สาํหรับสลบัหนา้จอการทาํงานเสมือน 

1 

2 

3 4 

5 
7 

6 

8 
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8. Trash ถงัขยะเก็บไฟลที์Dถูกลบแลว้ 
เมนูหลกัของ Suriyan 
จากภาพ ในลาํดบัทีDหนึDงจะเห็นเมนูอยูท่ั�งหมด 3 เมนูคือ Applications, Places และ System ซึDงเมนูแตล่ะอยา่งจะมีหนา้ทีD
ต่างกนัดงันี� เครับ 
เมนู Applications 
โปรแกรมต่างๆจะถูกจดัหมวดหมู่เก็บไวเ้ป็นอยา่งดีในเมนูนี� ซึDงคุณสามารถเรียกใช ้
โปรแกรมต่างๆทีDมีไดผ้า่นทางเมนู Applications นี� เลยครับ 
เมนู Places 
ทีDเมนูนี�จะเก็บ Shortcut สาํหรับเขา้ถึงโฟลเดอร์สาํคญัต่างๆไว ้เช่น Home (คลา้ย My Document), Computer (คลา้ย My 
Computer) หรืออืDนๆ ทีDเห็นตามในเมนูครับ 
เมนู System 

 
ในเมนู System จะมีอยูส่องส่วนสาํคญัคือ  

- “ปรับแต่งพื�นโตะ๊”(Preferences) หมายถึงการตั�งค่าส่วนตวั  
- “ดูแลระบบ”(Administration) หมายถึงการปรับแต่งค่าของระบบทั�งหมด 

ทั�งสองนี� คือส่วนประกอบหลกัๆบนหนา้จอของ Suriyan เมืDอเราติดตั�งเสร็จ และดว้ยความยดืหยุน่ของ Linux ทาํใหเ้รา
สามารถปรับแต่งค่าไดห้ลากหลายแบบ 
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3.2 ค่าปรับแต่งพื%นโต๊ะ 

 
 

ตารางที( 4 คาํอธิบายค่าปรับแต่งพื%นโต๊ะ 

ค่ากาํหนด คาํอธิบาย 
IBus Preferences ซึDงตอ้งเปิดบริการ IBus daemon ขึ�นมาก่อนใชง้าน 

เป็นค่ากาํหนดปรับเปลีDยนคียบ์อร์ด และฟอนตที์Dใช ้
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ค่ากาํหนด คาํอธิบาย 

 
Network Connections เป็นการกาํหนดค่าการเชืDอมต่อเครือข่ายซึDงรองรับการบริหารงานใน 

- Wired 
- Wireless 
- เครือข่ายบรอดแบนดมื์อถือ 
- VPN 
- DSL 

 
เกีDยวกบัฉนั เป็นการปรับเปลีDยนขอ้มูลของผูใ้ช ้ประกอบดว้ย 

- การติดต่อ 
- ทีDอยู ่
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ค่ากาํหนด คาํอธิบาย 

- ขอ้มูลส่วนตวั 

 
การใชพ้ลงังาน เป็นการกาํหนดค่าปรับแตง่การในการใชไ้ฟประกอบดว้ย 

- การกระทาํ 
- หนา้จอ 

 
จอแสดงผล กาํหนดความละเอียดของจอภาพ และความถีD 
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ค่ากาํหนด คาํอธิบาย 

 
เทคโนโลยสิีDงอาํนวยความ
สะดวก 

ค่ากาํหนดนี�สามารถระบุโปรแกรมหลกัทีDเรียกในการใชง้านได ้และกาํหนดค่าสาํหรับ
การใชแ้ป้นพิมพ ์กบัเมาส์ 

 
ค่ากาํหนดในการเลือกโปรแกรมหลกั 
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ค่ากาํหนด คาํอธิบาย 

 
ประกอบดว้ย 

- อินเทอร์เน็ต 
- ระบบสืDอผสม 
- ระบบ 
- สิDงอาํนวยความสะดวก 

บลูทูท เป็นการกาํหนดค่าติดตั�ง และบริหารงานอุปกรณ์ Bluetooth 
ปุ่มลดั ในการใชง้านหลายครั� งเราจะกาํหนดคียล์ดัเพืDอใหส้ะดวกในการเรียกโปรแกรม หรือ

ฟังกช์ัDนต่างๆอยา่งรวดเร็ว 
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ค่ากาํหนด คาํอธิบาย 

 
ประกอบดว้ย 

- เสียง 
- เดสกท์็อป 
- สิDงอาํนวยความสะดวก 
- Desktop 
- Window Management 
- การจดัการหนา้ต่าง 

แป้นพิมพ ์ เป็นการปรับเปลีDยนการตอบสนองของคียบ์อร์ด และค่ากาํหนดชนิดของแป้นพิมพ ์ซึDงผู ้
กาํหนดสามารถทดสอบค่าทีDระบุได ้



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 33 

 

ค่ากาํหนด คาํอธิบาย 

 
โปรแกรมรักษาหนา้จอ กรณีทีDเครืDองไม่ไดใ้ชง้านสกัพกัระบบสามารถทีDจะเรียกโปรแกรมรักษาหนา้จอเพืDอ

ป้องกนัการไหมข้องจอ 

 
โปรแกรมเริDมวาระ เป็นการกาํหนดค่าเริDมตน้เมืDอเปิดเครืDอง 
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ค่ากาํหนด คาํอธิบาย 

 
พร๊อกซีเครือข่าย Proxy เป็นค่าทีDระบุ Proxy Server เพืDอเพิDมประสิทธิภาพในการติดต่อกบัเครือข่าย

อินเทอร์เน็ต และป้องกนัขอ้มูลใหมี้ความปลอดภยั 

 
เมนูหลกั เป็นการบริหารจดัการคาํสัDง และกลุ่มคาํสัDงทีDจะปรากฎขึ�นใน Main menu 
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ค่ากาํหนด คาํอธิบาย 

 
เมาส์ เป็นค่ากาํหนดในการตอบสนองของเมาส์ 

 
ซึDงสามารถกาํหนดการจาํลองเมืDอมีการดบัเบิ�ลคลิก หรือเมืDอมีการคลิกแลว้หยดุเคลืDอน
เมาส์ 

รูปโฉม เป็นการกาํหนด รูปโฉมทีDแสดงโดยค่าทีDกาํหนดจะมี 
- ชุดตกแต่ง 
- พื�นหลงั 
- แบบอกัษร 
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ค่ากาํหนด คาํอธิบาย 

- ติดต่อผูใ้ช ้
- แสดงลูกเล่น 

 
เลือกโปรแกรมหลกัๆ เป็นการระบุโปรแกรมหลกัต่างๆทีD 

- เล่นอินเทอร์เน็ต 
- ระบบสืDอผสม 
- ระบบ 
- สิDงอาํนวยความสะดวก 
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ค่ากาํหนด คาํอธิบาย 

 
เสียง สามารถปรับแต่งความดงั และรูปแบบเสียงเอฟเฟ๊กตต่์างๆ 

 
หนา้ต่าง กาํหนดค่าตั�งของหนา้ต่าง เช่น 

- Windows Selection 
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ค่ากาํหนด คาํอธิบาย 

- Titlebar Action 
- Movement key 

 
หลงัจากทีDทราบถึงส่วนประกอบต่างๆ เราจะอธิบายเฉพาะค่ากาํหนดทีDใชก้นัอยูเ่ป็นประจาํ 

3.3 ปรับแต่งการแสดงผล 

ในตอนนี� เราจะมาปรับแต่ง Suriyan ของเราในส่วนของการแสดงผลกนัครับ เช่นเดียวกบัระบบปฏิบติัการอืDนๆ Suriyan 
สามารถปรับแต่งการแสดงผลไดใ้นระดบัหนึDง ซึDงมีความคลา้ยกบัระบบปฏิบติัการ Windows ทีDหลายท่านเคยใชง้าน 
ปรับแต่งจอแสดงผล 
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เมืDอคุณติดตั�ง Suriyan เสร็จ Suriyan จะเลือกความละเอียดมากทีDสุดทีDจอภาพและการ์ดแสดงผลรองรับซึDงบางครั� งเรากาํหนด
ละเอียดมากจนทาํใหไ้อคอนและตวัหนงัสือต่างๆนั�นดูเลก็เกินไป ซึDงเราสามารถปรับความละเอียดของหนา้จอใหต้รงตาม
ความตอ้งการได ้การปรับค่าความละเอียดหนา้จอนั�นสามารถทาํได ้โดย 

• ไปทีD Main menu > ระบบ > ปรับแต่งพื�นโตะ๊ > จอแสดงผล หนา้ตา่งการตั�งค่าความละเอียดหนา้จอจะถูกเรียก
ขึ�นมา ซึDงคุณสามารถเลือกความละเอียดไดต้ามตอ้งการ 

 
•  เสร็จแลว้กดทีD “เริDมใช”้ และคลิก “ใชค้่าตั�งนี� ” เพืDอใชง้านค่าทีDเลือกไดท้นัทีครับ  

ไม่เช่นนั�นระบบจะนบัถอยหลงั 30 วนิาที และกลบัไปใชค้่าดั�งเดิม 

• คลิกปุ่ม “ปิด” 
 

3.4 เปลี(ยนภาพพื%นหลงั 

ก่อนทีDจะเริDมเปลีDยนภาพพื�นหลงัหรือ Wallpaper นั�นเราตอ้งมัDนใจวา่ไดจ้ดัเตรียมภาพพื�นหลงัไวก่้อนในไฟลรู์ปแบบทีDนาํมา
ทาํภาพพื�นหลงัไดเ้ท่านั�น และควรพยายามหาภาพทีDมีความละเอียดสอดคลอ้งกบัค่ากาํหนดในการแสดงผลของจอ โดย
วธีิการกาํหนดทาํไดด้งันี�  

1. ไปทีD Main menu > ระบบ > ปรับแต่งพื�นโตะ๊ > รูปโฉม 
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2. เลือกทีDแทบ็ “พื�นหลงั” 
3. เลือกรูปแบบทีDตอ้งการ 
4. คลิกปุ่ม “ปิด” 

นอกเหนือจากวธีิทีDกล่าวมาขา้งตน้คุณสามารถปรับเปลีDยน Background ไดโ้ดยคลิกขวาทีDวา่งบนหนา้จอแลว้เลือก “เปลีDยน
พื�นหลงัของพื�นโตะ๊” แต่ถา้คุณไม่อยากใชภ้าพพื�นหลงั คุณสามารถเซตใหเ้ป็นสีเดียวก็ไดโ้ดยเลือกรูปซา้ยบน (No 
WallPaper) และเลือกสีทีDตอ้งการตรง Solid Color  
ถา้ตอ้งการนาํภาพมาทาํ Wallpaper นั�น ใหค้ลิกทีDปุ่ม “เพิDม” แลว้เลือกไฟลภ์าพทีDคุณตอ้งการ เพียงเท่านี�ภาพทีDคุณตอ้งการก็
จะปรากฏขึ�นมาเป็น Wallpaper  

3.5 การกาํหนดค่ารักษาหน้าจอ 

เป็นการป้องกนัจอไหมจ้ากการเปิดหนา้จอทิ�งไวน้านๆ ซึDงค่าทีDกาํหนดมีรูปแบบใหเ้ลือกมากมาย 
วธีิการกาํหนด 

1. ไปทีD Main menu > ระบบ > ปรับแต่งพื�นโตะ๊ > โปรแกรมรักษาหนา้จอ 
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2. เลือกรูปแบบทีDตอ้งการ ดา้นซา้ยจะแสดงตวัอยา่ง  
3. ในแถบ “ถือวา่เครืDองไม่ถูกใชง้านหลงัจาก” เลืDอนเลือกเวลาทีDตอ้งการโดยทัDวไปคือ 5 นาที 
4. เลือกกิจกรรมทีDตอ้งการประกอบดว้ย 
- แสดงโปรแกรมรักษาหนา้จอเมืDอเครืDองไม่ถูกใชง้าน 
- ลอ็คหนา้จอเมืDอโปรแกรมรักษาหนา้จอทาํงาน 
5. คลิกปุ่ม “ปิด” เมืDอเสร็จเรียบร้อย 

3.6 ปรับแต่งการใช้พลงังาน 

คุณสามารถทีDจะทาํการกาํหนดค่าปรับแตง่การใชพ้ลงังานไดผ้า่น “โปรแกรมรักษาหนา้จอ” หรือจะเรียกโดยตรงก็ได ้ 
วตัถุประสงคข์องการกาํหนดเพืDอทีDจะกาํหนดค่าประหยดัพลงัานของเครืDองประกอบดว้ย 

- การพกัฮาร์ดดิสก์ 
- การพกัหนา้จอ 

วธีิการกาํหนดทาํไดด้งันี�  
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• ไปทีD Main menu > ระบบ > ปรับแต่งพื�นโตะ๊ > ปรับแต่งการใชพ้ลงังาน 

 
• ค่ากาํหนดสามารถระบุ “การกระทาํ” คือการระบุกรณีทีDเสียบปลั�ก AC อยู ่ซึDงทัDวไประบุไม่ใหเ้ครืDองพกั หรือหลบั 

และใหก้าํหนดภาพหลบัเป็นเวลา 30 นาที 

• คลิกแท็บ “ทัDวไป” เป็นการระบุคา่ดงันี�  
- การกดปุ่ม “เปิด/ปิด” ใหด้าํเนินกิจกรรมทีDตอ้งการประกอบดว้ย ถาม/จาํศีลเครืDอง/ปิดเครืDอง 
- การกดปุ่ม “พกั” เพืDอ จาํศีลเครืDอง 

 
5. การแสดงในพื�นทีDแจง้เหตุ สามารถทีDระบุใหแ้สดงหรือไม่แสดงไดต้ามรายการดา้นบน โดยทัDวไปจะกาํหนดให้

แสดงไอคอนเมืDอแบตเตอรีDประจุไฟ หรือจ่ายไฟเท่านั�น 
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6. เสร็จเรียบร้อยคลิกปุ่ม “ปิด” 

3.7 การเปลี(ยนและตั%งชุดตกแต่ง 

หนา้ตาของ Suriyan ทีDคุณเห็นอยูนี่� เป็นการจดัวางองคป์ระกอบลกัษณะหนึDงคือการจดัวาง Panel ในรูปแบบทีDเห็นและใน
ส่วนของหนา้ต่างไอคอน หรือปุ่มกดต่างๆทีDเราเห็นวา่มีหนา้ตาเช่นนี�  นั�นเกิดขึ�นจากการจดัการของชุดตกแต่ง หรือทีDเรียกวา่ 
Theme ซึDง Theme มาตรฐานทีD Suriyan ใชอ้ยูนี่� จะมีชืDอวา่ Human ทีDมีสีออกไปในโทนนํ� าตาล Theme ในระบบปฏิบติัการ 
SuriyanสามารถเปลีDยน Theme ไดต้ามตอ้งการ 
วธีิการกาํหนด 

• ไปทีD Main menu > ระบบ > ปรับแต่งพื�นโตะ๊ > รูปโฉม 

• ในแทบ็ “ชุดตกแต่ง” ค่าโดยทัDวไปทีDกาํหนดจะเป็น Human ดงัรูป 

 
• คุณสามารถทีDจะเลือกรูปแบบอืDนๆได ้และคลิกปุ่ม “ปิด” 

กรณีทีDรูปแบบไม่ตรงสามารถทีDจะคลิกปุ่ม “ติดตั�ง” เพืDอระบุเพิDม หรือคลิกปุ่ม “ปรับเลือก” เพืDอเปลีDยนแปลงองคป์ระกอบทีD
ตอ้งการเองได ้
องค์ประกอบของชุดตกแต่ง 
ก่อนทีDคุณจะติดตั�ง “รูปโฉม” หรือ Theme ได ้คุณตอ้งเขา้ใจองคป์ระกอบของ รูปโฉมก่อน โดยคลิกทีDปุ่ม “ปรับเลือก” คุณ
จะเห็นวา่ในหนึDง “รูปโฉม” หรือ Theme จะประกอบดว้ย 
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- ปุ่มควบคุมต่าง (Controls): ส่วนประกอบต่างๆ ของหนา้ต่างโปรแกรม เช่น Scroll bar, ปุ่มกดต่างๆ 
- สี (Colors): เป็นการปรับสีส่วนตา่งๆของ Theme จะปรับไดต้่อเมืDอ Theme นั�น ๆรองรับ 
- กรอบหนา้ต่าง (Window Border): ส่วนขอบของหนา้ต่าง 
- ไอคอน (Icons): ไอคอนทีDเราเห็นทัDวไปบนหนา้จอในเมนู 
- ตวัชี�  (Pointers): กาํหนดตวัชี� เมาส์ทีDใชใ้น Suriyan 

องคป์ระกอบต่างๆนี� คุณสามารถหยบิเอาส่วนทีDตอ้งการ เช่นกรอบหนา้ต่างของอีก Theme มาประกอบกบั Icons ของอีก 
Theme เพืDอใชเ้ป็น Theme ใหม่ได ้ซึDงคุณคงจะพอเห็นเป็นแนวทางแลว้วา่หนา้ตาของ Suriyan นั�น สามารถปรับแต่งไดแ้ละ
มีความยดืหยุน่พอสมควร  

3.8 เปลี(ยนฟอนต์ที(ใช้แสดงผล 

แบบอกัษร หรือทีDเรียกวา่ฟอนตที์Dใชใ้นการแสดงผล ในส่วนต่างๆของ Suriyan เราสามารถเปลีDยนเป็นรูปแบบอกัษรแบบ
อืDนไดต้ามใจชอบ  
วธีิการเปลี(ยนแบบอกัษร 

1. ไปทีD Main menu > ระบบ > ปรับแต่งพื�นโตะ๊ > รูปโฉม 
2. ไปทีDแทบ็ “แบบอกัษร” 
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3. หนา้ต่างการตั�ง ค่า Font Preferences จะเปิดขึ�นมา ซึDงคุณสามารถเลือกแบบอกัษรใหก้บัส่วนประกอบต่างๆของ

หนา้จอได ้ในขั�นตอนนี�ใหคุ้ณเลือกและทดสอบการตั�งค่าต่างๆตามตอ้งการ 
4. ในส่วนของ Font Rendering นั�น เป็นรูปแบบวธีิในการแสดงผลของแบบอกัษรบนหนา้จอ วธีิการเลือกทีDง่ายและ

ดีทีDสุดนั�น คือ ใหเ้ลือกแบบทีDคุณมองแลว้สบายตาเป็นใชไ้ดค้รับถา้หากคุณใชห้นา้จอเป็นภาษาไทย คุณตอ้งเลือก
แบบอกัษรทีDเป็นภาษาไทยดว้ยเช่นเดียวกนั ซึDงแบบอกัษรภาษาไทยทีDมีใหใ้ชใ้นSuriyan จะมีแบบอกัษรต่างๆดงันี�  
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ตวัอยา่งฟอนตบ์างส่วนทีDแสดงภาษาไทยได ้เช่น Sans, Norasi, Garuda,  Loma, Purisa, Freeserif,  TLWG mono 
เป็นตน้ 

5. เสร็จเรียบร้อยใหค้ลิกปุ่ม “ปิด” 
 

3.9 การเพิ(มและการปรับแต่ง Panel 

จากทีDไดแ้นะนาํใหรู้้จกั Panel ไปแลว้ในส่วนของ “หนา้จอการทาํงาน” Panel นี� เราสามารถปรับตกแต่งไดไ้ม่วา่จะเป็น 
ตาํแหน่งของ Panel หรือส่วนต่างๆทีDอยูใ่น Panel 
การย้ายตาํแหน่ง Panel 

1. คลิกขวาทีD Panel เลือกคาํสัDง “คุณสมบติั” 
2. ในแทบ็ “ทัDวไป” ค่ากาํหนดจะระบุตาํแหน่งไวที้D “ขอบล่าง” 
3. ใหเ้ลือกตาํแหน่งทีDตอ้งการประกอบดว้ย ขอบบน/ขอบล่าง/ขอบซา้ย/ขอบขวา 

 
4. คลิกปุ่ม “ปิด” 

การเพิ(ม/ลบ Panel ใหม่ 
1. คลิกขวาทีD Panel และคลิกเลือก “พาเนลใหม่”  
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2. กรณีทีDตอ้งการลบ Panel ออกใหค้ลิกขวาเลือกคาํสัDง “ลบพาเนลนี�” 

 
การเพิ(มออปเจคใน  Panel 
พวกไอคอนเรียกโปรแกรม, ปุ่มปิดเครืDอง, ถงัขยะและอืDนๆทีDอยูบ่น Panel จะเรียกรวมๆวา่ Object Panel ส่วนประกอบ
เหล่านี� เราสามารถเพิDม, ลบ หรือยา้ยไดต้ามตอ้งการหากโปรแกรมทีDคุณตอ้งการเพิDมลงในไอคอนมีอยูใ่นเมนู Applications 
แลว้  
วธีิการนําไอคอนมาใส่ใน Panel 

1. คลิกขวาทีD Panel แลว้เลือกคาํสัDง “เพิDมลงในพาเนล 
2. ระบุรายการทีDตอ้งการ เช่น “ปลา” 

 
3. คลิกปุ่ม “เพิDม” 
4. ผลลพัธ์ทีDได ้

 
หรืออีกวธีิหนึDงทาํไดโ้ดย 
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1. คุณสามารถคลิกคา้งทีDปุ่มเรียกโปรแกรมในเมนูนั�น ๆแลว้นาํมาวางใน Panel ไดท้นัที 

 
2. ตรวจสอบผลลพัธ์จะพบไอค่อนขึ�นอยูใ่น Panel 

ส่วนการยา้ย,ลบ หรือลอ๊คติดกบั Panel สามารถทาํไดโ้ดย 
1. การคลิกขวาทีDไอคอนนั�น ๆ แลว้เลือกทาํตามทีDตอ้งการ 
2. เลือกคาํสัDง “ลบออกจากพาเนล” 
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บทที� 4 การใช้งานไฟล์บนระบบปฏิบัตกิาร Suriyan  

4.1 รู้จกักบัระบบไฟล์และโฟลเดอร์ 

หลงัจากทีDเราติดตั�งกนัเป็นทีDเรียบร้อยแลว้ ก่อนทีDเราจะเปิดเครืDองเพืDอทาํความรู้จกักบัส่วนต่างๆของ Suriyan นั�น สิDงแรกทีD
คุณควรรู้และทาํความเขา้ใจไวก่้อนคือเรืDองของระบบไฟลแ์ละโฟลเดอร์ของ Suriyan ระบบไฟลข์อง Suriyan หรือแมแ้ต่ลิ
นุกซ์ตวัอืDนๆก็ตาม จะไม่เหมือนกบั Windows ทีDเราจะเห็นวา่มี Drive C, Drive D นะครับ ซึDงเป็นเรืDองทีDตอ้งทาํความเขา้ใจ
ไวก่้อน เดี�ยวจะงงเมืDอถึงตอนทีDคุณเริDมใชง้านแลว้ คุณจะเห็นพาธต่างๆของ Suriyan ซึDงผมจะอธิบาย 
คร่าวๆไว ้เฉพาะพาธทีDสาํคญัๆ วา่พาธไหนคืออะไรครับ 

-  / : root path พาธทีDเป็นตน้ราก 
-  /bin : เก็บไบนารีDคาํสัDง ต่างๆของระบบไว ้
-  /boot : เก็บไฟลที์Dจาํเป็นสาํหรับการบูตระบบ 
-  /etc : เก็บการตั�ง ค่าทีDจาํเป็นสาํหรับโปรแกรมต่างๆ 
-  /home : ทีDเก็บ User Profile ต่างๆเหมือนกบั C:\document and settings ของระบบปฏิบติัการ Windows 
- /home/khajorn : ทีDเก็บ Profile ของผูใ้ชชื้Dอ khajorn 
- /home/khajorn/Desktop : ทีDเก็บออปเจคต่างบนหนา้จอของ khajorn 
- /media : อุปกรณ์ต่างๆเรียกใชไ้ดที้DนีD เช่น CD, Floppy 
- /cdrom หรือ /media/cdrom : ไดร์ฟ CD-ROM หรือ DVD 
- /fda0 หรือ/media/fda0 : ไดร์ฟFloppy 
- /sbin : เก็บคาํสัDงสาํคญัของระบบ เช่น ปิดเครืDอง, รีสตาร์ท 
-  /tmp : ทีDเก็บไฟลช์ัDว คราว จะถูกลบเมืDอรีสตาร์ท 
-  /usr : ทีDเก็บไฟลต์่างๆทีDทัDวไปทีDเรียกใชโ้ดยระบบปฏิบติัการ Unix/Linux (Unix System Resource) 

หมายเหตุ 
โฟลเดอร์ทีDมี . จะเป็นการซ่อนการเห็นจากผูใ้ชท้ัDวไป (Hidden file/folder) 
ตาํแหน่งต่างๆทีDแนะนาํสาํหรับผูใ้ชท้ัDวไปตอ้งการใหรู้้จกัเท่านั�นเพืDอจะไดเ้ขา้ใจเปรียบเสมือนเราเขา้ใจในโฟลเดอร์ของ 
c:\Windows บนระบบปฏิบติัการ Windows แต่เราไปตอ้งไม่ยุง่กบัโฟลเดอร์เหล่านี�  
 
ที(หลกั 
เป็นคาํสัDงทีDใชร้ะบุตาํแหน่งการเขา้ใชง้านในแต่ละโฟลเดอร์จะถูกแยกเก็บในผูใ้ชแ้ต่ละบุคคล ซึDงประกอบดว้ย 

- โฟลเดอร์บา้น 
- พื�นโตะ๊ 
- เอกสาร 
- ดนตรี 
- รูปภาพ 
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- วดิีทศัน ์
- Downloads 

 

4.2 การเข้าสู่ระบบไฟล์ และการใช้ตวัเรียกดูแฟ้ม (Nautilus) 

ตวัเรียกดูแฟ้มใน Suriyan จะมีชืDอเรียกวา่ Nautilus ทุกครั� งทีDคุณเปิดโฟลเดอร์บา้น หรือดบัเบิลคลิกทีDโฟลเดอร์ใดๆก็ตาม 
Nautilus จะถูกเรียกขึ�นมาทาํงาน ตวัเรียกดูแฟ้ม นี� มีหนา้ตาไม่แตกต่างจาก File Manager ของ Windows มากนกั การเรียนรู้
จึงไม่ยาก 
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ส่วนต่างๆใน Nautilus 

1. เมนูหลกั 
2. แถบเครืDองมือ 
3. ตาํแหน่ง 
4. ยอ่/ขยาย และมุมมอง 
5. เมนูขา้ง 
6. ไฟลแ์ละโฟลเดอร์ 
7. แถบสถานะ 

เมืDอคลิกเขา้แลว้จะเขา้สู่ตวัเรียกดูแฟ้ม ซึDงจะเขา้สู่ในแต่ละโฟลเดอร์ดงัรูปดา้นบน 
การปรับเปลี(ยนมุมมอง 
คุณสามารถทีDจะปรับเปลีDยนมุมมองตามทีDตอ้งการได ้

 
 ทั�งการซูมระดบัต่างๆ 

1 

2 

3 

4 

5 

6 

7 
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การปรับเปลีDยนมุมมอง 
- มุมมองแบบไอคอน 

 
- มุมมองแบบรายชืDอ 

 
- มุมมองแบบกระชบั 

 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 53 

 

ตารางที( 5  คาํอธิบายตาํแหน่งโฟลเดอร์ที(เรียกใช้ 

หัวข้อ คาํอธิบาย 
โฟลเดอร์บา้น เป็นการเขา้สู่โฟลเดอร์ของผูใ้ช ้เช่นถา้เป็น Khajorn จะเขา้ไปทีDโฟลเดอร์ /home/khajorn 
พื�นโตะ๊ เป็นการเขา้สู่โฟลเดอร์พื�นโตะ๊ของผูใ้ชค้นนั�น เช่น /home/khajorn/เดสกท์๊อป 

 
เอกสาร เป็นพื�นทีDจดัเก็บเอกสารจะอยูใ่นโฟลเดอร์ /home/khajorn/เอกสาร 
ดนตรี เป็นพื�นทีDจดัเก็บไฟลเ์สียง และดนตรีใน /home/khajorn/ดนตรี 
รูปภาพ เป็นพื�นทีDจดัเก็บไฟลรู์ปภาพใน /home/khajorn/รูปภาพ 
วดิีทศัน ์ เป็นพื�นทีDจดัเก็บไฟลว์ดิีโอ /home/khajorn/วดิีทศัน ์
Downloads เป็นพื�นทีDจดัเก็บไฟลที์Dถูกดาวน์โหลดซึDงจะอยูใ่น /home/khajorn/downloads 
คอมพิวเตอร์ เป็นตาํแหน่งเสมือน ทีDรวมอุปกรณ์เก็บขอ้มูลทีDเชืDอมต่อกบัคอมพิวเตอร์ของเราขึ�นมา

แสดง 

 
ไดร์ฟฟลอปปี�  เป็นการเขา้สู่ไดร์ฟฟลอปปี� ดิสก ์โดยตอ้งทาํการเมาทก่์อนใชง้าน 
เครือข่าย เป็นการเขา้สู่ระบบเครือข่ายต่างๆเช่น Windows  
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หัวข้อ คาํอธิบาย 

 
เชืDอมต่อไปยงัเซิร์ฟเวอร์ เป็นคาํสัDงทีDใชติ้ดต่อกบับริการโอนถ่ายไฟลต์่างๆประกอบดว้ย 

- SSH 
- FTP 
- FTP สาธารณะ 
- แหล่งใชร่้วมของวนิโดวส์ 
- WebDav(HTTP) 
- WebDav นิรภยั (HTTPS) 
- ตาํแหน่งกาํหนดเอง 

 
คน้หาแฟ้ม ใชร้ะบุคน้หาไฟล ์และไฟลเ์อกสารต่างๆในตาํแหน่งโฟลเดอร์ทีDตอ้งการ 
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หัวข้อ คาํอธิบาย 

 
 
เทคนิคในการใช้งาน และการปรับเปลี(ยนของตวัเรียกดูแฟ้ม (Nautilus) 
การแสดงแฟ้มซ่อนใหคุ้ณกด Ctrl+H โปรแกรมจะแสดงไฟลแ์ละแฟ้มทีDถูกซ่อนขึ�นมาซึDงส่วนใหญ่จะเป็นไฟลที์Dใชใ้นการ
บนัทึกการตั�ง ค่าส่วนตวั การสร้างแฟ้มซ่อนนั�น เพียงแค่เปลีDยนชืDอไฟลห์รือแฟ้มนั�น ๆ แลว้ใส่ “จุด” นาํหนา้ เช่น โฟลเดอร์
ชืDอ hidden เปลีDยนชืDอเป็น .hidden ไฟลห์รือแฟ้มนั�น ๆ จะถูกซ่อนในทนัทีในส่วนของ “ตาํแหน่ง” (หมายเลข 3) ถา้คุณรู้
ตาํแหน่งทีDแน่นอน เช่น /media/cdrom คุณสามารถพิมพต์าํแหน่งลงไปไดเ้ลย โดยการกด Ctrl+L แถบทีDใชบ้อกตาํแหน่งดว้ย
ปุ่มจะเปลีDยนเป็นแถบยาวๆคลา้ยของ Web Browser เพืDอใหคุ้ณพิมพต์าํแหน่งทีDตอ้งการไดเ้ลย 
เมนูดา้นขา้งคุณสามารถเปลีDยนจากสถานทีDสาํคญั เป็นขอ้มูลของแฟ้มหรือมุมมองแบบรากไมก็้ได ้ดว้ยการคลิกทีDขอ้ความทีD
เขียนวา่ Places แลว้เลือกตวัเลือกทีDตอ้งการ 
เปลี(ยนแบบจอแสดงภาพใน Nautilus 
ตวัเรียกดูแฟ้มของสุริยนัมีวธีิแสดงระบบแฟ้มได ้2 แบบคือเบราเซอร์(Browser) และ ความสมัพนัธ์ (Spatial) 

- แบบเบราเซอร์หนา้ต่างของตวัเรียกดูแฟ้มจะเป็นเบราเซอร์ซึDงสามารถแสดงทีDไหนก็ได ้การเปิดแฟ้มจะทาํให้
หนา้ต่างแสดงเนื�อหาของแฟ้มใหม่ 

-  แบบความสมัพนัธ์ หนา้ต่างของตวัเรียกดูแฟ้มจะเป็นแฟ้มนั�น การเปิดแฟ้มจะเปิดหนา้ต่างใหม่สาํหรับแฟ้มนั�น 
ทุกครั� ง ทีDคุณเปิดแฟ้มนั�น คุณจะพบหนา้ต่างแสดงอยูใ่นทีDเดิมของจอและมีขนาด เท่ากบัครั� งสุดทา้ยทีDคุณใช(้นั�น 
คือเห็นผลสาํหรับชืDอทีDเรียก) แบบ Browser เป็นแบบทีDกาํหนดไวใ้น Suriyan 

วธีิการปรับเปลี(ยนรูปแบบดาํเนินการ 
1. ในตวัเรียกดูแฟ้ม, เลือกเมนู แกไ้ข(Edit) > ปรับแตง่ (Preferences) 
2. คลิกแถบ พฤติกรรม (Behavior) 
3. ไม่เลือกช่อง “เปิดในหนา้ต่างเบราวเ์ซอร์เท่านั�น” 
4. คลิกปุ่ม “ปิด” เพืDอปิดโปรแกรมแลว้เรียกตวัเตียกดูแฟ้มใหม่  
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แสดงไฟล์และแฟ้มที(ซ่อนใน Nautilus 
1. ในตวัเรียกดูแฟ้ม,กดแป้นพิมพ ์Ctrl-H สาํหรับเลือกระหวา่งแสดงหรือไม่แสดงไฟลที์Dซ่อนไว,้หรือเลือก มุมมอง 

(View)-> แสดงแฟ้มสาํรองขอ้มูลและแฟ้มทีDซ่อนไว ้(Show Hidden Files) 
2. เพืDอทีDจะแสดงไฟลห์รือแฟ้มทีDซ่อนไวอ้ยา่งถาวร, เลือกเมนู แกไ้ข(Edit) > ปรับแตง่ (Preferences) 
3. คลิกแถบ มุมมอง(Views) 
4. เลือกในช่องเลือก “แสดงแฟ้มสาํรองขอ้มูลและแฟ้มทีDซ่อนไว”้ 

 
5. คลิกปุ่ม “ปิด” 

การเปิด Location Bar ในตวัเรียกดูแฟ้ม 
Location Bar เป็นบาร์ในตวัเรียกดูแฟ้มของผูใ้ชที้Dคุณสามารถใส่ทีDอยูล่งไป เปิดปิดบาร์โดย ไป(Go)>ตาํแหน่ง(Location...) 
คุณยงัสามารถใชแ้ป้นพิมพท์างลดั Ctrl-L 
เปลี(ยนค่าที(กาํหนดไว้  “เปิดด้วยโปรแกรมอื(น” (Open with) โปรแกรมสําหรับชนิดของไฟล์ 

1. ในตวัเรียกดูแฟ้ม ,คลิกขวาบนไฟลแ์ละเลือกคุณสมบติั(Properties), คลิกปุ่ม “ปิด” 
2. คลิกขวาอีกครั� งคลิกคาํสัDง เปิดดว้ย(Open With) เลือกโปรแกรมทีDคุณอยากใชส้าํหรับไฟลช์นิดนั�นถา้โปรแกรม

ไม่มีในรายการ,ใชปุ่้ม โปรแกรมอืDน… เพืDอเพิDมโปรแกรมเขา้ไปในรายการ 
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4.3 การบริหารจดัการ Storage (USB, Removable, Zip, Unzip, tar, gz) 

ปัจจุบนัอุปกรณ์ Removable Storage เป็นหน่วยจดัเก็บพื�นฐานทีDใชก้นัอยา่งแพร่หลาย และเป็นมาตรฐาน โดยเฉพาะ USB 
flash drive ซึDงในระบบปฏิบติัการ Suriyan สามารถทีDจะติดต่อ และรองรับความสามารถในการ Plug & Play ได ้ซึDงอุปกรณ์
จะอยูใ่นโฟลเดอร์ /media/ชืDอหน่วยจดัเก็บ 
วธีิการใช้งาน Thumb drive 

1. เสียบอุปกรณ์ USB flash drive จะขึ�นเป็นไดร์ฟในพื�นทีD “ทีDหลกั” ดงัรูป 

 
2. คุณสามารถทีDเรียกดบัเบิ�ลคลิกเปิดใชไ้ดท้นัที 

 
4.4 การแตก และการลดขนาดไฟล์ 
ระบบปฏิบติัการสุริยนัจะมีฟังกช์ัDนในการลดขนาด และแตกไฟลที์Dถูกลดขนาดไดใ้นหลากหลายไฟลป์ระเภท เช่น .gz 
(Gzip), .bz (Bzip), .zip (Winzip), และ .rar (Winrar) เป็นตน้ โดยเพียงแค่ดบัเบิ�ลคลิกไฟลที์Dถูกลดขนาดดงักล่าว 
การเปิดไฟล์ที(ลดขนาดที(มอียู่เดมิ 

1. หาไฟลที์Dมีการลดขนาด เช่น .zip  
2. ดบัเบิ�ลคลิกเพืDอเปิดไฟล ์

 
3. เลือกไฟลที์Dตอ้งการ, และคลิกปุ่ม “แตก” 
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4. ระบุตาํแหน่งทีDตอ้งการ, ภายใต ้“แตก” ใหเ้ลือกแฟ้ม, คลิกปุ่ม “แตกออก” 

 
5. คลิกปุ่ม “ปิด” 
6. ตรวจสอบไฟลที์Dแตกออกมา 

การลดขนาดไฟล์ 
1. ใหเ้ลือกไฟลที์Dตอ้งการแลว้คลิกเลือกคาํสัDง “บีบอดั” 
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2. ไฟลที์Dลดขนาดจะเป็น .tar.gz (ค่าโดยทัDวไป) 

 
คุณสามารถทีDเลือกรูปแบบการลดขนาดอืDนๆได ้เช่น .zip, .bz, .jar, อืDนๆ เป็นตน้ 

3. ระบุตาํแหน่ง 
4. คลิกปุ่ม “สร้าง” 
5. ตรวจสอบตาํแหน่งไฟลที์Dสร้าง 

 

4.4 การเปิดไฟล์ใช้งานต่างๆ 

ไฟลต์่างๆจะมีคุณลกัษณะทีDแตกต่างกนัตามโครงสร้างของไฟล ์ซึDงจะถูกนาํเสนอในรูปแบบนามสกลุทีDช่วยใหโ้ปรแกรม

สามารถทีDเขา้ใจ และเรียกใชง้านไดอ้ยา่งถูกตอ้ง ดงันั�นในหวัขอ้นี�จะกล่าวถึงตวัอยา่งนามสกลุไฟลที์Dเรียกใชบ่้อยๆ 
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ตารางที(  6  คาํอธิบายการเปิดใช้ไฟล์งานต่าง ๆ 

นามสกลุไฟล์ คาํอธิบาย 
Pdf โปรแกรมทีDใชเ้ปิดคือ Document Viewers 

วธีิการเปิดเครืDอง 
1. ดบัเบิ�ลคลิกทีDไฟลน์ามสกลุ .pdf เพืDอเรียกเปิดโปรแกรม 
2. หรือคลิกทีDเมนู แฟ้ม > เปิด 
3. ระบุเอกสารทีDตอ้งการเปิดประกอบดว้ย 
- หนงัสือการ์ตูน 
- เอกสาร PDF 
- เอกสาร PostScript 
- Images 
- สไลด ์Impress 
- เอกสาร Djvu 
- เอกสาร DVI 
- Tiff Documents 
- แฟ้มทั�งหมด 

Ppt โปรแกรมทีDใชเ้ปิดคือ Impress ซึD งโดยทัDวไปสามารถเปิดไฟลน์ามสกลุ odp, otp, sxi, sti, ppt, 
pot, sxd 

Doc โปรแกรมทีDใชเ้ปิดคือ Writer ซึDงรองรับไฟลน์ามสกลุต่างๆดงันี�  

 
Xls โปรแกรมทีDใชเ้ปิดคือ Calc ซึDงรองรับไฟลน์ามสกลุต่างๆดงันี�  

 
Wmv โปรแกรมทีDใชเ้ปิดคือ VLC Media payer ซึDงรองรับไฟล ์Audio, Video, และมีเดียอืDนๆ 
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บทที� 5 การบริหารงานเครื�องพมิพ์ 

5.1 ความเข้าใจเกี(ยวกบัเครื(องพมิพ์ 

เครืDองพิมพแ์บ่งเป็น 3 ชนิดใหญ่ๆคือ  
- Impact คือเครืDองพิมพที์Dเป็นหวักระแทก 
- InkJet คือเครืDองพิมพที์Dพน่หมึก และพน่ความร้อนเพืDอใหห้มึกทีDพน่แหง้ 
- LaserJet คือเครืDองพิมพที์Dใชผ้งหมึก และความร้อนเคลือบ 

การเชืDอมต่อเครืDองพิมพส์ามารถติดต่อผา่นพอร์ตต่างๆ 
- LPTn พอร์ตเครืDองพิมพ ์ 
- RS232 พอร์ตสืDอสารแบบซีเรียล 
- USB พอร์ตซีเรียลแบบ Universal Serial Port 
- TCP ติดต่อผา่นเครือข่าย TCP/IP 

 

5.2 การตดิตั%งเครื(องพมิพ์แบบต่างๆ 

คุณสามารถทีDติดตั�งเครืDองพิมพท์ั�งต่อผา่นพอร์ตเชืDอมต่อโดยตรง หรือจะเรียกผา่นแชร์เครืDองพิมพจ์ากเครืDองอืDนๆได ้ซึDงใน
ระบบปฏิบติัการ Suriyan รองรับหลากหลายการเชืDอมต่อ เช่น Local Port, USB Port, Network Port, HP JetDirect, LPQ 
เป็นตน้ 
การตดิตั%งเครื(องพมิพ์กรณีที(เป็น Local Port 

1. เลือกเครืDองพิมพที์Dตอ้งการ และพอร์ตทีDเชืDอมต่อ (ดาํเนินการต่อเชืDอมอุปกรณ์) 
2. คลิกทีD Main Menu > ระบบ > ดูแลระบบ > เครืDองพิมพ ์

 
3. คลิกปุ่ม “ใหม่” 

กรณีทีDต่อพว่งอุปกรณ์ และระบบปฏิบติัการตรวจสอบเจอจะแสดงรายการอุปกรณ์ขึ�นทนัที 
4. เลือกอุปกรณ์ เช่น LPT #1 คือพอร์ต Printer, เสร็จแลว้คลิกปุ่ม “ถดัไป” 
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5. เลือกอุปกรณ์ระบุผูผ้ลิต เช่น HP โดยเราสามารถพิมพร์ายชืDอระบบจะคน้หาให,้ เสร็จแลว้คลิกปุ่ม “ถดัไป” 

ผูก้าํหนดสามารถเลือกอุปกรณ์ได ้3 วธีิ 
- จากฐานขอ้มูลทีDมีอยู ่
- จากไฟล ์PPD 
- จากการดาวน์โหลดไดร์ฟเวอร์อุปกรณ์ 

 
6. ระบุรุ่น และไดรเวอร์ เช่น HP LaserJet 1100 กบั HP LaserJet 1100 hpijs, 3.9.8 [en] (แนะนาํ), เสร็จแลว้คลิกปุ่ม 

“ถดัไป” 
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7. ระบุคาํอธิบายเครืDองพิมพ ์ประกอบดว้ยชืDอเครืDองพิมพ ์รายละเอียด ตาํแหน่ง, คลิกปุ่ม “เริDมใช”้ 

 
8. ระบุทีDจะทดสอบเครืDองพิมพห์รือไม่, ถา้ตอ้งการทดสอบคลิกปุ่ม “ใช่”, คลิกปุ่ม “ตกลง” 
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9. ตรวจสอบพบวา่จะขึ�นรายการเครืDองพิมพใ์น “การตั�งค่าเครืDองพิมพ ์– Localhost” 

 
10. ตรวจสอบสถานะการพิมพเ์อกสาร (งานของฉนั)วา่ไดมี้งานส่งมาพิมพห์รือไม่ 

 
11. ดบัเบิ�ลคลิกทีDเครืDองพิมพเ์พืDอตรวจสอบค่ากาํหนด 
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การตดิตั%งเครื(องพมิพ์กรณีที(เป็น Network Printer  

1. ติดตั�งเครืDองพิมพที์Dตอ้งการ และพอร์ตทีDเชืDอมต่อ 
2. คลิกทีD Main Menu > ระบบ > ดูแลระบบ > เครืDองพิมพ ์
3. คลิกปุ่ม “เพิDม” 
4. คลิกทีD “เครืDองพิมพบ์นเครือข่าย” ผูติ้ดตั�งสามารถระบุไดห้ลากหลายการเชืDอมต่อ 
- AppSocket/HP JetDirect เป็นการติดต่อกบัอุปกรณ์เช่น Jet Direct card ของ HP  
- Internet Printing Protocol  (IPP) เป็นการติดต่อกบัเครืDองพิมพที์Dแชร์ในมาตรฐาน IPP 
- LPD/LPR Host or Printer เป็นการติดต่อกบัเครืDองพิมพที์Dใหบ้ริการแบบ Unix 
- Windows Printer via SAMBA เป็นการติดต่อกบัเครืDองพิมพที์Dใหบ้ริการแชร์ผา่น Windows 

 
5. ในทีDนี� เราจะเลือกเป็นเครืDองพิมพแ์บบ AppSocket/HP JetDirect, ระบุหมายเลขหรือชืDอโฮสต,์ คลิกปุ่ม “ถดัไป” 
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6. ระบุเลือกอุปกรณ์จากฐานขอ้มูล 
7. เลือกอุปกรณ์ระบุผูผ้ลิต เช่น Kyocera โดยเราสามารถพิมพร์ายชืDอระบบจะคน้หาให,้ เสร็จแลว้คลิกปุ่ม “ถดัไป” 

ระบุรุ่น และไดรเวอร์ เช่น KM-4035 ไดรเวอร์ Kyocera KM-4035 Foomatic/Postscript[en] (แนะนาํ), เสร็จแลว้
คลิกปุ่ม “ถดัไป” 

8. ระบุคาํอธิบายเครืDองพิมพ ์ประกอบดว้ยชืDอเครืDองพิมพ ์รายละเอียด ตาํแหน่ง, คลิกปุ่ม “เริDมใช”้ 
9. ระบุทีDจะทดสอบเครืDองพิมพห์รือไม่, ถา้ตอ้งการทดสอบคลิกปุ่ม “ใช่”, คลิกปุ่ม “ตกลง”  
10. ตรวจสอบพบวา่จะขึ�นรายการเครืDองพิมพใ์น “การตั�งค่าเครืDองพิมพ ์– Localhost” 

 
11. ตรวจสอบสถานะการพิมพเ์อกสาร (งานของฉนั)วา่ไดมี้งานส่งมาพิมพห์รือไม่ 
12. ดบัเบิ�ลคลิกเพืDอตรวจสอบค่ากาํหนดต่างๆ 
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การตดิตั%งเครื(องพมิพ์กรณีที(เป็น IPP 
IPP คือ Internet Printing Protocol เป็นมาตรฐานในการส่งงานพิมพผ์า่นขอ้ตกลงของอินเทอร์เน็ต หรือพอร์ต 80/443 ซึDงผู ้
ติดตั�งตอ้งทาํการสร้างแชร์ IPP บนเครืDองแม่ข่ยก่อนทีDดาํเนินการติดตั�ง IPP บนเครืDองลูกข่าย  
ตวัอยา่งเช่นเราทาํการแชร์เครืDองพิมพบ์นระบบปฏิบติัการ Windows ทีDรองรับบริการ Internet Printing Protocol (IPP) 

 
และระบุแชร์ชืDอ HPLJ5 โดยหมายเลข IP คือ 192.168.0.51 

 
ขั%นตอนการตดิตั%งเครื(องพมิพ์ 

1. ติดตั�งเครืDองพิมพที์Dตอ้งการ และพอร์ตทีDเชืDอมต่อ 
2. คลิกทีD Main Menu > ระบบ > ดูแลระบบ > เครืDองพิมพ ์
3. คลิกปุ่ม “เพิDม” 
- คลิกทีD “เครืDองพิมพบ์นเครือข่าย” ผูติ้ดตั�งสามารถระบุไดห้ลากหลายการเชืDอมต่อ ซึDงในทีDนี� เลือก Internet Printing 

Protocol  (IPP)  
4. ระบุหมายเลข IP หรือชืDอโฮสต,์ คลิกปุ่ม “ถดัไป” 
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5. ระบุเลือกอุปกรณ์จากฐานขอ้มูล, เลือกอุปกรณ์ระบุผูผ้ลิต เช่น HP โดยเราสามารถพิมพร์ายชืDอระบบจะคน้หาให,้ 

เสร็จแลว้คลิกปุ่ม “ถดัไป” 
ระบุรุ่น และไดรเวอร์ เช่น LaserJet 5 ไดรเวอร์ HP LaserJet 5 Foomatic/ljet4 [en], เสร็จแลว้คลิกปุ่ม “ถดัไป” 

6. ระบุคาํอธิบายเครืDองพิมพ ์ประกอบดว้ยชืDอเครืDองพิมพ ์รายละเอียด ตาํแหน่ง, คลิกปุ่ม “เริDมใช”้ 
7. ระบุทีDจะทดสอบเครืDองพิมพห์รือไม่, ถา้ตอ้งการทดสอบคลิกปุ่ม “ใช่”, คลิกปุ่ม “ตกลง”  
8. ตรวจสอบพบวา่จะขึ�นรายการเครืDองพิมพใ์น “การตั�งค่าเครืDองพิมพ ์– Localhost” 

 
9. ตรวจสอบสถานะการพิมพเ์อกสาร (งานของฉนั)วา่ไดมี้งานส่งมาพิมพห์รือไม่ 
10. ดบัเบิ�ลคลิกเพืDอตรวจสอบค่ากาํหนดต่างๆ 
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การตดิตั%งเครื(องพมิพ์กรณีที(เป็น Microsoft Windows File/Print Server 
ระบบปฏิบติัการ Suriyan สามารถทีDจะติดต่อกบัเครืDองพิมพใ์นตระกลูของ Windows โดยผา่นมาตรฐาน SAMBA ซึDงเครืDอง
แม่ข่าย Windows ตอ้งแชร์เครืDองพิมพก่์อน 
ขั%นตอนการตดิตั%ง 

1. คลิกทีD Main Menu > ระบบ > ดูแลระบบ > เครืDองพิมพ ์
2. คลิกทีD “เครืDองพิมพบ์นเครือข่าย” ผูติ้ดตั�งสามารถระบุไดห้ลากหลายการเชืDอมต่อ ซึDงในทีDนี� เลือก Windows Printer 

via SAMBA 
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3. คลิกปุ่ม “เรียกดู” 
4. ทาํการเลือกรายการจากชืDอโดเมน, ชืDอเครืDอง 
5. ระบุชืDอ Username, Domain, และรหสัผา่นทีDถูกตอ้ง, คลิกปุ่ม “ตกลง” 

 
6. เลือกเครืDองพิมพ,์ คลิกปุ่ม “ตกลง” 

 
7. ตรวจสอบเครืDองพิมพ ์SMB, คลิกปุ่ม “ถดัไป” 
8. ระบุเลือกอุปกรณ์จากฐานขอ้มูล, เลือกอุปกรณ์ระบุผูผ้ลิต เช่น Brother โดยเราสามารถพิมพร์ายชืDอระบบจะคน้หา

ให,้ เสร็จแลว้คลิกปุ่ม “ถดัไป” 
ระบุรุ่น และไดรเวอร์ เช่น HL-2700CN ไดรเวอร์Brother HL-2700CN Foomatic/Postscript [en] (แนะนาํ), เสร็จ
แลว้คลิกปุ่ม “ถดัไป” 
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9. ระบุคาํอธิบายเครืDองพิมพ ์ประกอบดว้ยชืDอเครืDองพิมพ ์รายละเอียด ตาํแหน่ง, คลิกปุ่ม “เริDมใช”้ 
10. ระบุทีDจะทดสอบเครืDองพิมพห์รือไม่, ถา้ตอ้งการทดสอบคลิกปุ่ม “ใช่”, คลิกปุ่ม “ตกลง”  

 
11. ตรวจสอบพบวา่จะขึ�นรายการเครืDองพิมพใ์น “การตั�งค่าเครืDองพิมพ ์– Localhost” 
12. ตรวจสอบสถานะการพิมพเ์อกสาร (งานของฉนั)วา่ไดมี้งานส่งมาพิมพห์รือไม่ 

กรณีทีDส่งงานจะมีการใหร้ะบุชืDอผูใ้ช ้และรหสัผา่น 
13. ดบัเบิ�ลคลิกเพืDอตรวจสอบค่ากาํหนดต่างๆ 

 
 

5.3 การปรับเปลี(ยนค่ากาํหนดเครื(องพมิพ์ 

จากการติดตั�งเครืDองพิมพเ์ราสามารถทีDจะดบัเบิ�ลคลิกเขา้ไปดูรายละเอียดของค่ากาํหนดต่างในเครืDองพิมพไ์ด ้ซึDง
รายละเอียดทีDระบุมีดงันี�  
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ตารางที( 7  คาํอธิบายการปรับเปลี(ยนค่ากาํหนดของเครื(องพมิพ์ 

หัวข้อ ค่ากาํหนด และคาํอธิบาย 
ตั�งค่า เป็นการระบุค่ากาํหนดของเครืDอง ตาํแหน่ง การเชืDอมต่อ และรุ่น 

เราสามารถทีDจะสัDงใหพิ้มพเ์พืDอทดสอบ หรือลา้งหวัพิมพไ์ด ้

 
นโยบาย เป็นการระบุสถานะ, นโยบายเมืDอพิมพแ์ลว้มีปัญหา หรือการใส่ใบปะหนา้ หรือใบปิดทา้ย 

 
ควบคุมการเขา้ถึง เป็นการระบุสิทธ์ทีDจะอนุญาตใหใ้ชเ้ครืDองพิมพ ์หรือไม่ใหใ้ชเ้ครืDองพิมพนี์�  
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ตวัเลือก
เครืDองพิมพ ์

เป็นการกาํหนดชนิดกระดาษ และวธีิการพิมพ ์รวมถึงความละเอียด ซึDงจะขึ�นอยูก่บัชนิดของ
เครืDองพิมพด์ว้ย 

 
ตวัเลือกงาน เป็นการกาํหนดค่าของงานทีDพิมพ ์เช่นการระบุการจดัเรียง การใส่ขอบบน ล่าง ซา้ยขวา และอืDนๆ 
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ระดบัหมึก/โท
เนอร์ 

เป็นการรายงานสถาะนของเครืDองพิมพ ์

 
 

 

5.4 การบริหารงานพมิพ์ 

เมืDอคุณทาํการติดตั�งเครืDองพิมพแ์ลว้ หลงัจากเปิดแอพพลิเคชัDนและเลือกคาํสัDง “พิมพ”์ จะมีเครืDองพิมพรุ่์นต่างๆใหเ้ลือก 
ซึDงผูใ้ชง้านตอ้งระบุชนิด และประเภทของเครืDองพิมพใ์หต้รงกบัลกัษณะงานทีDตอ้งการ 
กรณีทีDงานส่งไปยงัเครืDองพิมพแ์ลว้ ผูดู้แลเครืDองพิมพ ์หรือผูส้ัDงงานสามารถทีDจะบริหารงานพิมพไ์ดต่้างๆ ซึDงมี 
การกาํหนดค่าเครื(องพมิพ์ปริยาย (Default Printer) 
เป็นการระบุใหเ้มืDอสัDงพิมพแ์ลว้ใหไ้ปเครืDองทีDระบุเครืDองพิมพป์ริยาย 
1. ไปคลิกทีD Main Menu > ระบบ > ปรับแตง่พื�นโตะ๊ > เครืDองพิมพป์ริยาย 
2. เลือกเครืDองพิมพที์Dตอ้งการ, คลิกปุ่ม “ตั�งเป็นเครืDองพิมพป์ริยาย 
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3. ผลทีDไดจ้ะมีเครืDองหมาย “หวัใจ” ระบุวา่เครืDองพิมพน์ั�นเป็นเครืDองพิมพป์ริยาย โดยดูจากหนา้ต่าง “การตั�งค่า

เครืDองพิมพ ์– Localhost 
หรือเราจะกาํหนดโดยผา่นหนา้ตา่ง “การตั�งค่าเครืDองพิมพ ์– Localhost” และระบุเครืDองพิมพ ์เลือกเมนู เครืDองพิมพ ์> 
กาํหนดเป็นค่าปริยาย 

 
การลบ หยุด สั(งพมิพ์ใหม่ในงานที(ส่งพมิพ์ไปแล้ว 

1. ไปคลิกทีD Main Menu > เครืDองมือเครืDองใช ้> จดัการงานพิมพ ์
หรือเรียกจากในหนา้ “การตั�งค่าเครืDองพิมพ ์– Localhost” และเลือกเมนู เครืDองพิมพ ์> ดูคิวงาน ก็ได ้

 
2. คลิกขวางานพิมพที์Dตอ้งการ คุณสามารถทีDจะกาํหนดค่าไดด้งันี�  
- ยกเลิก เป็นการลบงานนั�น 
- หยดุชัDวคราว เป็นการหยดุการพิมพข์องงานนั�นเพืDอใหง้านอืDนพิมพก่์อน 
- ทาํงานต่อ เป็นการสัDงใหง้านทีDหยดุพิมพต์่อ 
- พิมพซ์ํ� า เป็นการสัDงใหพิ้มพซ์ํ� า 
- ยนืยนัตน เป็นการตรวจสอบสิทธิV  
3. เสร็จเรียบร้อย แลว้คลิกปุ่ม Close หรือ X ดา้นบนขวามือ 

 
การเปลี(ยนชื(อเครื(องพมิพ์ 
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1. ในหนา้ “การตั�งค่าเครืDองพิมพ ์– Localhost” และเลือกเมนู เครืDองพิมพ ์> เปลีDยนชืDอ 
2. ใส่ชืDอเครืDองพิมพใ์หม่ และเคาะ Enter 

 
 
ระบบปฏิบติัการ Windows สามารถติดต่อเครืDองพิมพก์บัระบบปฏิบติัการ Suriyan ไดห้ลากหลายวธีิ เช่นผา่น ipp, samba, 
หรือ lpd เป็นตน้ ซึDงตวัอยา่งทีDจะนาํเสนอจะเป็นวธีิติดต่อผา่น Samba 
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ภาคที( 2   เครื(องมือต่างๆ บน Suriyan 
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บทที� 6 โปรแกรมทั�วไป และการติดตั�งแอพพลเิคชั�นเพิ�มเติม 

6.1 โปรแกรมทั(วไปในระบบปฏบิตักิาร Suriyan 

ระบบปฏิบติัการ Suriyan จะมีซอฟตแ์วร์ต่างๆมากมาย ซึDงในทีDนี� เราจะอธิบายรายชืDอซอฟตแ์วร์ทีDติดตั�งมาพร้อมกบั

ระบบปฏิบติัการ Suriyan 

หมวดหมู่กราฟิกส์ 

ตารางที( 8  คาํอธิบายแอพพลเิคชั(นหมวดหมู่กราฟิกส์ 

แอพพลเิคชั(น คาํอธิบาย 
F-Spot: โปรแกรมจดัการรูปถ่าย คุณสามารถทีDเลือกไฟลรู์ปภาพไดจ้ากสองแหล่ง 

- โฟลเดอร์บนเครืDองทีDใช ้
- กลอ้งดิจิตอล 

การเขา้ดูรูปภาพต่างๆ (Browse) 

 
คลิกดา้นซา้ยเพืDอระบุค่า Tags ในรูปภาพทีDเลือก ถา้ตอ้งการแกไ้ขใหเ้ลือกรูปภาพก่อน
และคลิกทีD Edit Image 
การแกไ้ขรูปภาพ 
รูปภาพทีDนาํเขา้จะอยูใ่นโปรแกรม F-Spot ถา้ตอ้งการแกไ้ขใหค้ลิกปุ่ม Edit Image 
แลว้เลือกเอฟเฟกซ์ทีDเกีDยวกบัการปรับเปลีDยนภาพดงัรูป 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 80 

 

แอพพลเิคชั(น คาํอธิบาย 

 
 

GIMP Image Editor เป็นโปรแกรมทีDใชแ้กไ้ขตกแต่งรูปภาพซึDงมีหลกัการทาํงานคลา้ยกบั Adobe 
Photoshop คือมีหลกัการทาํงานเป็น Layer ซึDงในเวอร์ชัDนทีDใหม้ากบั Suriyan คือเวอร์
ชัDน 2.6 

 
โปรแกรมนี�สามารถทีDจะนาํไฟลจ์าก Adobe Photoshop มาตกแต่งได ้

Inkscape Vector Graphics Editor เป็นโปรแกรมทีDแกไ้ขรูปภาพมีหลกัการทาํงานเก็บภาพเป็นรูปแบบเวกเตอร์ ไม่ได้
จดัเก็บเป็นบิตแมบ็เหมือนโปรแกรมอืDนๆ ซึDงมีความสามารถจดัทาํเป็น Layer และมี
เครืDองมือในการปรับตกแต่งภาพทีDเป็นเวกเตอร์ 
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แอพพลเิคชั(น คาํอธิบาย 

 
บนัทึกเป็นนามสกลุ .svg 

Simple Scanner เป็นโปรแกรมทีDใชบ้ริหารจดัการสแกนเนอร์เพืDอนาํเขา้รูปภาพจากอุปกรณ์
สแกนเนอร์ และตกแต่งภาพพื�นฐาน 
ขั�นตอน 

1. ต่ออุปกรณ์สแกนเนอร์เขา้กบัเครืDอง 
2. คลิกปุ่ม “สแกน” (หรือกดคีย ์Ctrl+1) 

ถา้กดคีย ์Ctrl+N เป็นการเริDมสแกนใหม่ 
3. ถา้คลิกปุ่ม “สแกน” อีกครั� งจะสแกนหนา้ทีDสอง 

 
4. คลิกปุ่ม “บนัทึก” ถา้ตอ้งการจดัเก็บโดยทัDวไปจะเป็นไฟล ์.jpg 

ระบุตาํแหน่งทีDเก็บ, คลิกปุ่ม “บนัทึก” 
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แอพพลเิคชั(น คาํอธิบาย 
5. คลิกเมนู เอกสาร > ออก (หรือกดคีย ์Ctrl+Q) 

 

หมวดหมู่เครื(องมอืเครื(องใช้ 

ตารางที(  9  คาํอธิบายแอพพลเิคชั(นหมวดหมู่เครื(องมอืเครื(องใช้ 

แอพพลเิคชั(น คาํอธิบาย 
StarDict โปรแกรมพจนานุกรม ซึDงสามารถแปลจากภาษาองักฤษ เป็นไทย หรือจีนได ้ซึDงคุณ

สามารถเรียกใชง้านไดโ้ดยไม่ตอ้งเสียค่าใชจ่้ายใดๆเพิDมเติม 

 
ในช่องคน้หาใหพิ้มพค์าํศพัทที์Dตอ้งการ และคลิกปุ่ม Find จะแสดงคาํศพัท ์และคาํแปล 
(ถา้มี) 

Tomboy Notes เป็นโปรแกรมสาํหรับใชเ้ป็นสมุดบนัทึกขอ้ความ 
คน้หาแฟ้ม ใชค้น้หาไฟลที์Dสนใจมีความสามารถเหมือน Search ใน Windows 
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แอพพลเิคชั(น คาํอธิบาย 

 
ซึDงคุณตอ้งระบุชืDอไฟล ์และตาํแหน่งทีDคน้หา เมืDอคลิกปุ่ม “หา” จะไดผ้ลลพัธ์ในช่อง “ผล
การคน้หา” 

เครืDองคิดเลข เป็นโปรแกรมเครืDองคิดเลขทีDสามารถกาํหนดมุมมองในหลากหลายแบบตามชนิดการ
คาํนวณแบบต่างๆ 

 
โปรแกรมแกไ้ขขอ้ความ gedit เป็นโปรแกรมสร้าง อ่าน และแกไ้ขขอ้ความ 

 
เครืDองมือวเิคราะห์การใชดิ้สก ์ เป็นเครืDองมือใชว้เิคราะห์ดิสกที์Dใช ้
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แอพพลเิคชั(น คาํอธิบาย 

 
กรณีทีDคลิกเขา้ดูในโฟลเดอร์ทีDตอ้งการจะแสดงรายละเอียดสรุปเทียบเป็น 100% 

 
เครืDองมือสร้างซีดี/ดีวดีี เป็นเบ็กเอนดเ์ขียนซีดี/ดีดวดีี 
จดัการงานพิมพ ์ เป็นการบริหารจดัการเครืDองพิมพ ์ซึDงคุณตอ้งติดตั�งเครืDองพิมพ ์และพิมพง์านส่งมาก่อนจึง

สามารถทีDจะทาํการลบ หรือบริหาร Print Job 
เทอร์มินลั เป็นโปรแกรมทีDใชเ้รียกคาํสัDงทีDเป็น Command line เหมือน MSDOS Prompt 
บนัทึกภาพหนา้จอ เป็นโปรแกรมบนัทึกภาพนิDงบนจอ เพืDอเก็บผลทีDไดจ้ากหนา้จอ 

วธีิการเรียกใช ้
1. ใหไ้ปทีD Main Menu > เครืDองมือเครืDองใช ้> บนัทึกภาพหนา้จอ 
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แอพพลเิคชั(น คาํอธิบาย 

 
2. คุณสามารถทีDจะเลือกวธีิการบนัทึก และใส่เอฟเฟกตใ์นรูปภาพได ้

ค่าระบุการบนัทึกหนา้จอจะมี 
- จบัภาพพื�นโตะ๊ทั�งหมด เป็นการบนัทึกทั�งหมดของหนา้จอ 
- จบัภาพหนา้ต่างปัจจุบนั เป็นการบนัทึกในขณะทีDหนา้ต่างใดใชง้านอยู ่
- Select area to grab เป็นการบนัทึกตามขอบเขตทีDผูบ้นัทึกระบุ 

ซึDงถา้มีการกาํหนด “จบัภาพหลงัจากรอคอยเป็นเวลา” ระบุวนิาที ซึDงเมืDอจบัภาพ
จะรอเวลา 

3. ถา้ตอ้งการบนัทึกใหค้ลิกปุ่ม “บนัทึกภาพหนา้จอ” 
4. เมืDอบนัทึกใหร้ะบุชืDอไฟล ์และตาํแหน่งทีDเก็บ คลิกปุ่ม บนัทึก 

โดยทัDวไปจะอยูบ่น Desktop และนามกสุลเป็น .png 
ผงัอกัขระ เป็นโปรแกรมทีDกาํหนดตารางอกัขระของภาษาต่างๆ ซึDงเราสามารถคลิก และตรวจสอบ

ตาํแหน่งของโคด้อา้งอิงรหสัมาตรฐานต่างๆได ้
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แอพพลเิคชั(น คาํอธิบาย 

 
หมวดหมู่สํานักงาน 

ตารางที( 10  คาํอธิบายแอพพลเิคชั(นหมวดหมู่สํานกังาน 

แอพพลเิคชั(น คาํอธิบาย 
OpenOffice.org 3.2 Base เป็นโปรแกรมจดัการฐานขอ้มูล 
OpenOffice.org 3.2 Calc เป็นโปรแกรมจดัการตารางคาํนวณ หลกัการทาํงานเหมือนกบั Microsoft 

Excel และสามารถทีDนาํไฟล ์Microsoft Excel มาเปิดใชง้านไดด้ว้ย 
OpenOffice.org  3.2 Drawing เป็นโปรแกรมในชุด OpenOffice.org  ซึDงมีหลกัการทาํงานคลา้ยๆกบั 

Adobe Photoshop แต่จะไม่สามารถทีDจะเปิดไฟลข์อง Adobe ไดไ้ม่
เหมือนกบั Gimp ซึDงภาพทีDวาดจะถูกจดัเก็บในไฟลน์ามสกลุ .odg 

OpenOffice.org 3.2 Impress เป็นโปรแกรมนาํเสนอผลงานในรูปแบบสไลด ์หลกัการทาํงานเหมือนกบั 
Microsoft PowerPoint และยงัสามารถทีDเปิดไฟลน์ามสกลุ .ppt ของ 
Microsoft ไดด้ว้ย 

OpenOffice.org 3.2 Math เป็นโปรแกรมทีDใชใ้นการเขียนสมการคณิตศาสตร์ 
OpenOffice.org 3.2 Writer เป็นโปรแกรมทีDใชแ้กไ้ขไฟลเ์อกสารเหมือน Microsoft Word ซึDงโปรแกรม

สามารถทีDเปิดไฟล ์Microsoft Word ทีDเป็น .doc ได ้
  
ตวับริหารการจดัการเครืDองพิมพ ์
OpenOffice.org 3.2 

 

พจนานุกรม เป็นพจนานุกรมทีDสามารถแปลจากภาษาองักฤษใหเ้ป็นภาษาไทย หรือ
ภาษาอืDนๆ 

เมลและปฏิทินของ Evolution เป็นโปรแกรมทีDใชติ้ดต่อจดหมายอิเลก็ทรอนิกส์ และเป็น Groupware ทีDจะ
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แอพพลเิคชั(น คาํอธิบาย 
ทาํนดัหมาย กาํหนดรายการงาน และอืDนๆไดด้ว้ย 

หมวดหมู่เสียง และวดิโีอ 

ตารางที(  11  คาํอธิบายแอพพลเิคชั(นหมวดหมู่เสียง และวดีโีอ 

แอพพลเิคชั(น คาํอธิบาย 
VLC media player เป็นโปรแกรมสาํหรับดูหนงั ฟังเพลง โดยผูฟั้งสามารถทีDจะเลือกแหล่งจากไดเรคทอรี, ดิสค,์ 

เครือข่าย, หรือจากแผน่ได ้

 
เครืDองอดัเสียง เป็นโปรแกรมบนัทึกเสียง คลา้ย Recorder บน Windows ซึDงเสียงทีDบนัทึกกาํหนดไดห้ลายแบบ 

 
โปรแกรมเขียนแผน่ 
Brasero 

เป็นโปรแกรมสาํหรับเขียนแผน่เพลง, ขอ้มูล, ภาพยนตร์, หรือสาํเนาแผน่สู่แผน่, หรือเขียนเก็บ
ไวเ้ป็นอิมเมจ หลกัการทาํงานเหมือนกบัโปรแกรม Nero หรือ Roxio บน Windows 
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แอพพลเิคชั(น คาํอธิบาย 

 
 

โปรแกรมตดัต่อ
ภาพยนตร์ Pitivi 

เป็นโปรแกรมทีDใชต้ดัต่อแกไ้ขภาพยนตร์ 

โปรแกรมเล่นเพลง 
Rhythmbox 

เป็นโปรแกรมฟังเพลงคลา้ยกบัโปรแกรม Windows Media Player  

 
โปรแกรมเล่นภาพยนตร์ เป็นโปรแกรมสาํหรับดูหนงัเล่นไดจ้ากไฟล ์MP3, หรือจากแผน่หนงั 
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แอพพลเิคชั(น คาํอธิบาย 

 
 

หมวดหมู่อนิเทอร์เน็ต 
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ตารางที(  12 คาํอธิบายแอพพลเิคชั(นหมวดหมู่อนิเตอร์เน็ต 

แอพพลเิคชั(น คาํอธิบาย 
Firefox Web 
Browser 

เป็นโปรแกรม Web Browser ทีDมีผูนิ้ยมใชจ้าํนวนมาก ซึDงมีรูปแบบการเรียกเวบ็เหมือน Web 
Browser ทัDวไป  

 
Mozilla 
Thunderbird 
Mail/News 

เป็นโปรแกรมสาํหรับรับส่งจดหมาย อ่าน Newsgroup ซึDงรองรับ 
- Email Account เป็นการดึงจดหมายจากระบบ POP3/IMAP4 
- RSS News & Blogs เป็นการดึงผา่นมาตรฐาน RSS และ Blog 
- Unix Mailspool (Movemail) เป็นการดึงจดหมายจาก mailspool ใน Unix แบบเดิม 
- Gmail เป็นการดึงจดหมายจาก Gmail 
- Newsgroup account เป็นระบบดึงข่าวสารแบบดั�งเดิม 
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แอพพลเิคชั(น คาํอธิบาย 
Terminal Server 
Client 

เป็นโปรกรมทีDใชค้วบคุมเครืDองในเครือข่ายระยะไกลบนระบบปฏิบติัการ Windows ตั�งแต่เวอร์ชัDน 
2000 ขึ�นไป 

 
Transmission 
โปรแกรม 
BitTorrent 

เป็นโปรแกรมทีDใชก้าร เชืDอมต่อระหวา่งเครืDองคอมพิวเตอร์เขา้ดว้ยกนั เพืDอการแลกเปลีDยนขอ้มูล
ระหวา่งกนัหรือการ Share File ภายในกลุ่ม Network  ในลกัษณะคลา้ยๆกบัใยแมงมุมหรือ Peer to 
Peer ในรูปแบบหนึDง 

เครืDองมือแสดงพื�น
โตะ๊เครืDองอืDน 

เป็นโปแกรมทีDใชแ้บ่งปัน GNOME Desktop หลายผูใ้ชร่้วมกนั  

ลูกข่ายขอ้ความ
ทนัใจ Empathy 

เป็นโปรแกรมสาํหรับใชก้บั MSN  

ลูกข่ายโซเซียล
Gwibber  

เป็นโปรแกรมสาํหรับอพัโหลดขอ้มูล และสร้างสงัคมในการติดต่อใน Internet ซึDงมีรายการใหเ้ลือก 
ดงัรูป 
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แอพพลเิคชั(น คาํอธิบาย 

 
ซึDงถา้ตอ้งการติดต่อในสงัคมอินเทอร์เน็ตใหเ้ลือกสร้าง Account ในเวบ็ทีDตอ้งการเช่น Twitter 
ตวัอยา่งการติดต่อ Twitter 

1. คลิกทีD Twitter 
2. ใส่ Username, และ Password, คลิกเช็คบ็อกซ์ Receive Messages, และ Send Messages, 

คลิกปุ่ม “ตกลง” 
3. ในหนา้จอจะขึ�นรายการ Your Account และในแถบดา้นซา้ยจะมี Twitter และชืDอ 

Account ปรากฎอยู ่
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หลงัจากทีDเราไดท้ราบถึงโปรแกรมทีD Suriyan มีมาใหแ้ลว้ เรายงัพบอีกวา่เราสามารถทีDจะติดตั�งโปรแกรมเพิDมเติมไดอี้ก
มากมายทั�งโปรแกรมสาํหรับผูใ้ชง้าน ผูดู้แลระบบ ผูพ้ฒันาระบบ ซึDงเครืDองมือหลงัจากนี�ไปคือการติดตั�งซอฟตแ์วร์เพิDมดว้ย 
ศูนยซ์อฟตแ์วร์ Ubuntu (Software Center)
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6.2 การตดิตั%ง โปรแกรมเพิ(มเตมิบน Suriyan ด้วยศูนย์ซอฟต์แวร์ Ubuntu (Software Center) 

นอกเหนือจากโปรแกรมทีDไดแ้นะนาํมาแลว้นั�น เรายงัสามารถติดตั�งโปรแกรมเพิDมเติมลงไปไดอี้กดว้ย ซึDงการติดตั�ง 
โปรแกรมเพิDมเติมบน Suriyan นั�น ง่ายมากๆ เพราะคุณไม่ตอ้งไปหาดาวน์โหลดโปรแกรมมาจากเวบ็ไซตไ์หนเลย เพียงแค่
คุณเปิดโปรแกรมศูนย์ซอฟต์แวร์ Ubuntu เลือกโปรแกรมทีDตอ้งการ แลว้กดติดตั�ง เพียงเท่านี�โปรแกรมทีDคุณตอ้งการก็จะถูก
นาํมาเสริฟไวต้รงหนา้ของคุณทนัที 
วธีิการเรียกใช้งาน 

1. คลิกทีD Main Menu > ศูนยซ์อฟตแ์วร์ Ubuntu 

 

2. คลิกทีD Installed Software จะพบรายการทีDติดตั�งแลว้ดงัรูป 
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3. คลิกทีD Get Free Software, เลือกในรายการ Science, ทีD Achilles Lif Simulator, คลิกปุ่ม “โหลด” 

 

4. คลิกปุ่ม “Install” เพืDอติดตั�งซอฟตแ์วร์ 

 

5. ใส่รหสัผา่นเพืDอตรวจสอบตวัตน, คลิก Authenticate, รอจนติดตั�งเสร็จ 

 

6.3 การเพิ(มเตมิซอฟต์แวร์ด้วย Synaptic 

โปรแกรม Synaptic เป็นโปรแกรมทีDเรียกติดตั�งโดยมองซอฟตแ์วร์เป็นแพกเกจ โดยซอฟตแ์วร์หนึDงๆจะมีหลายชุดของแพก

เกจรวมกนัเมืDอเราเรียกติดตั�งดว้ยซอฟตแ์วร์ Synaptic จะแจง้แพกเกจทีDจาํเป็นในการติดตั�ง และสถานะทีDติดตั�ง นอกจากนี�

โปรแกรมนี�ยงัแบ่งแยกชนิดของแพกเกจใหผู้เ้ลือกติดตั�งทราบวา่เป็น Universe, Multiverse, Restricted เป็นตน้ แต่กรณีทีD

คุณสนใจเพียงการติดตั�งซอฟตแ์วร์เท่านั�นการใช ้ศูนยซ์อฟตแ์วร์ Ubuntu จะมีความสะดวกและง่ายกวา่ 
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การเรียกใช้ Synaptic 

1. ใหไ้ปทีD เมนู Main Menu > ระบบ > ดูแลระบบ > เครืDองมือจดัการแพกเกจ Synaptic 
2. ใส่รหสัผา่นของผูมี้สิทธิV , คลิกปุ่ม Authenticate 

 
พบวา่ใน Status ดา้นล่างจะบอกใหท้ราบถึงแพกเกจทั�งหมด และแพกเกจทีDติดตั�ง  

3. ใหเ้ลือก “แหล่งทีDมา” ดา้นบนจะเปลีDยนเป็นเวบ็ทีDเก็บรายการซอฟตแ์วร์ เช่นเลือก archive.getdeb.net/multiverse 
ก็จะมีรายการขึ�นมาใหเ้ลือกดา้นซา้ย 

4. ดบัเบิ�ลคลิกทีD Freemind, พบวา่จะระบุซอฟตแ์วร์ทีDตอ้งติดตั�งเพิDม 
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5. คลิกทีDปุ่ม “กระทาํ” พบวา่จะมีขอ้ความแจง้ใหท้ราบถึงสถานะต่างๆในกรอบ “สรุป” 

 
6. คลิกปุ่ม “เริDมใช”้, ปล่อยใหโ้ปรแกรมทาํการดาวน์โหลด 
7.  คลิกปุ่ม “ปิด” เมืDอเสร็จสิ�น 
8. ตรวจสอบโดยคลิกทีD Main Menu > สาํนกังาน > FreeMind 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 98 

 

 
 
ซอฟตแ์วร์ทีDมีในรายการของ Synaptic โดยมากเป็น Ubuntu ซึDงสามารถทีDจะใชง้านกบั Suriyan ได ้แต่ถา้ตอ้งการดูรายการ
ของ Suriyan โดยตรงก็สามารถคลิกทีD Suriyan.in.th/main ไดด้งัรูปทีDแสดง 

 
ซึDงส่วนมากคือการเพิDม Font และ Theme  
 

 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 99 

 

6.4 การตรวจสอบสถานะซอฟต์แวร์ที(ตดิตั%งใน Synaptic 

1. เปิด เครืDองมือจดัการแพกเกจ Synaptic 
2. คลิกทีDปุ่ม “สถานะ” จะมีรายการแสดงต่างๆแยกตามสถานะ 

 
3. ซึDงประกอบดว้ย 
- แสดงทั�งหมด 
- Installed (manual) 
- ติดตั�งแลว้ 
- ติดตั�งแลว้ (ปรับรุ่นขึ�นไดอี้ก) 
- ถูกติดตั�งไปแลว้ (local หรือลา้สมยั) 
- ไม่ไดติ้ดตั�ง 
- ไม่ไดถู้กติดตั�ง (residual config) 

 

6.5 การค้นหาซอฟต์แวร์ด้วย Synaptic 

การคน้หามีแบบคน้หารวดเร็วคือคุณพิมพใ์นช่อง “คน้หารวดเร็ว” ก็จะพบรายการซอฟตแ์วร์ทีDตอ้งการ 

 
การค้นหาปกต ิ

1. ใหค้ลิกปุ่ม “คน้หา”  



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 100 

 

 
2. ระบุชืDอทีDตอ้งการคน้หา และระบุคน้หาใน 
3. คลิกปุ่ม “คน้หา” 

 
4. จะแสดงขอ้มูลผลการคน้หาทีDระบุ 
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6.6 การปรับปรุง และเพิ(มเตมิซอฟต์แวร์ 

นอกเหนือจากเครืDองมือ Synaptic แลว้ยงัมีการปรับปรุงรายการซอฟตแ์วร์ไดจ้าก “แหล่งทีDมา”  

 
การเพิ(ม Repository 
การติดตั�ง โปรแกรมเพิDมเติมผา่นระบบจดัการแพค็เกจของ Suriyan นั�น จะขึ�นอยูก่บัแหล่งจดัเก็บซอฟตแ์วร์หรือ Repository 
ทีDจะเป็นตวับอกวา่มีโปรแกรมอะไรบา้งทีDเราจะติดตั�ง ไดผ้า่นระบบจดัการแพค็เกจ ซึDง Repository ในค่าตั�ง ตน้ทีD Suriyan 
ตั�ง ไวจ้ะตั�ง ไปทีD Repository ทีDมีเฉพาะซอฟตแ์วร์โอเพนซอร์สและส่วนของไดร์เวอร์ฮาร์ดแวร์ต่างๆเท่านั�น แต่เราก็
สามารถเพิDม Repository ใหชี้�ไปทีDทีDมีซอฟตแ์วร์ทีDไม่ใช่โอเพนซอร์สไดด้ว้ย ซึDง Repository ทีDเราจะเพิDมเขา้มานี�แมจ้ะมี
ซอฟตแ์วร์ทีDไม่ใช่โอเพนซอร์สรวมอยู ่แต่ก็เป็นโปรแกรมทีDถูกตอ้งตามลิขสิทธิV ทั�งสิ�นครับ ซึDงการทาํแบบนี�จะทาํใหมี้
ซอฟตแ์วร์ใหเ้ราเลือกไดห้ลายหลายมากยิDงขึ�นครับวธีิการทาํงานของระบบจดัการแพค็เกจคือ ระบบจะดูวา่ Repository ทีDเรา
ตั�งไวชี้�ไปทีDไหน ซึDงระบบก็จะวิDงไปอพัเดตรายชืDอซอฟตแ์วร์ทีDนัDน (บนเซิร์ฟเวอร์ตามทีDระบุไวใ้น Repository) และเราจะ
สามารถติดตั�ง ซอฟตแ์วร์ไดต้ามรายชืDอซอฟตแ์วร์ทีDไดท้าํการอพัเดตการเพิDมเติม Repository นั�น 
อยูที่Dบางช่องเท่านั�น ซึDงแต่ละช่องนั�น มีความหมายดงันี�  
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- ซอฟตแ์วร์เปิดเผยทีDสนบัสนุนโดย Canonical (main) หมายถึง Repository ทีDเก็บซอฟตแ์วร์โอเพนซอร์สไว ้ซึDง
ดูแลโดยทีมพฒันา Ubuntu เอง 

- ชุมชนเป็นผูดู้แลซอฟตแ์วร์เปิดเผย (Universe) หมายถึง Repository ทีDเก็บซอฟตแ์วร์ทีDเป็นโอเพนซอร์สไว ้ดูแล
โดยนกัพฒันาอิสระ 

- ไดรเวอร์ทีDมีกรรมสิทธ์สาํหรับอุปกรณ์ หมายถึง Repository ทีDเก็บซอฟตแ์วร์ทีDอาจติดเรืDองของสิทธิบตัร หรือ
ลิขสิทธิV ไวด้ว้ย 

- ซอฟตแ์วร์นี� มีลิขสิทธิV หรือขอ้กฎหมายจาํกดัอยู ่(multiverse) หมายถึง Repository ทีDเก็บไดร์ฟเวอร์ตา่งๆจากผูผ้ลิต
ฮาร์ดแวร์เอาไว ้

- ตน้ฉบบัโปรแกรม (Source code) หมายถึง ระบบจะทาํการรวมซอร์สโคด้จาก Repository ต่างๆ ไวใ้นรายชืDอ
ซอฟตแ์วร์ดว้ยเมืDอคุณทาํการอพัเดต 

- ดาวน์โหลดจาก หมายถึง เซิร์ฟเวอร์ทีDจะทาํการอพัเดตรายการซอฟตแ์วร์ ซึDงถา้เป็น Thailand ก็แน่นอนวา่จะเร็ว
กวา่ต่างประเทศ 
เมืDอคุณเขา้ใจแลว้วา่รายการไหนคืออะไรคุณก็สามารถเลือกไดต้ามสะดวกเลยครับ แต่ถา้คุณไม่เขา้ใจเลยสกันิด
และยงังงๆอยูก็่ไม่เป็นไรครับ ลบไปจากหวัไดเ้ลย และคลิกเลือกใหห้มดไปเลยยกเวน้ “ตน้ฉบบัโปรแกรม 
(Source code) เพราะเราคงไม่ไดใ้ช ้Source code ของโปรแกรมในการใชง้านทัDว ๆไปอยูแ่ลว้ 

6.7 ขั%นตอนการทดลองตดิตั%ง โปรแกรม 

หลงัจากปรับแต่ง Repository แลว้ เรามาลองติดตั�ง โปรแกรมกนัครับ 
1.  ใหคุ้ณคลิกทีDเมนู Main Menu > ระบบ > ดูแลระบบ > แหล่งของซอฟตแ์วร์ 
2. ใส่รหสัผา่นของผูมี้สิทธิV , คลิกปุ่ม “ตกลง” 
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3. ไปทีDแทบ็ “ซอฟตแ์วร์อืDนๆ” เราสามารถทีDจะคลิกปุ่ม “เพิDม” เพืDอเพิDมเติมรายการซอฟตแ์วร์ได ้หรือคลิกเช็คบ็อกซ์
เพืDอเพิDมในรายการทีDมีอยูแ่ลว้, หรือคลิกปุ่ม “เพิDม ซีดีรอม” คือโหลดจากแผน่ 

4. ไปทีDแทบ็ “ปรับปรุง” เป็นการระบุค่าใหร้ะบบ Ubuntu ทาํการปรับปรุงโดยอตัโนมติัในส่วนประกอบ 4 ส่วนคือ 
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 การปรับปรุงดา้นความปลอดภยัทีDสาํคญั 
(karmic-security) 

- การปรับปรุงทีDแนะนาํ (karmic-updates) 
- ปรับปรุงก่อนเผยแพร่ (karmic-proposed) 
- ปรับปรุงทีDไม่มีการสนบัสนุน (karmic-backports) 

กาํหนดค่าระยะเวลาในการปรับปรุง  
5. คลิกแท็บ “การยนืยนัของจริง” เพืDอระบุค่า Signing key 
6. คลิกแท็บ “สถิติ” คลิกเช็คบ็อกซ์ “ส่งขอ้มูลสถิติ” เพืDอแจง้ใหเ้จา้ของเวบ็ทราบ 
7. คลิกปุ่ม “ปิด” 
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บทที� 7 การท่องอนิเทอร์เน็ตกบั Suriyan 

7.1 เชื(อมต่อกบัอนิเทอร์เน็ต 

ถา้จะเชืDอมต่อกบัอินเทอร์เน็ต,กรุณาทาํดงันี� : 
การกาํหนดค่าตดิตั%งเครือข่าย 

1. ไปทีD Main Menu > ระบบ > ปรับแต่งพื�นโตะ๊ > การเชืDอมต่อเครือขา่ย 

 
ถา้คุณมีโมเด็มหรือใชก้ารสืDอสารแบบ ADSL, กรุณาคลิกทีD DSL ตรวจสอบวา่มีรายการ ADSL หรือไม่ถา้ไม่มีให้
คลิกปุ่ม “เพิDม”  แต่ตอ้งมีการติดตั�งไดร์ฟเวอร์ใหเ้รียบร้อยก่อน 

 
2. ในแทบ็ Wired ใหต้รวจสอบรายการการเชืDอมต่อ ดงัรูปดา้นบน 
3. คลิกปุ่ม Edit เพืDอทาํการปรับเปลีDยนค่า 
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4. คลิกทีDแทบ็ IPv4 Settings, ตรวจสอบวา่ไดเ้ลือก Method: เป็น Automatic(DHCP) หรือไม่ 

กรณีทีDตอ้งการระบุ Manual ใหเ้ลือก Manual, และใส่ค่าหมายเลข IP, Subnet Mask, และ DNS เอง 
5. คลิกปุ่ม “Apply”, ใส่รหสัผา่นของผูดู้แล, และคลิกปุ่ม “Authenticate” 

การตรวจสอบเครือข่ายว่าทาํงานได้หรือไม่ 
1. ไปคลิกเลือก Main menu > ระบบ > ดูแลระบบ > ตรวจสอบเครือข่าย 
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2. ทีDแทบ็ “อุปกรณ์” ในรายการ “อุปกรณ์เครือข่าย” ตรวจสอบเลือก “อินเทอร์เฟซแบบอีเทอร์เน็ต (eth1) 
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7.2 การใช้งานอนิเทอร์เน็ตพื%นฐาน 
โปรแกรม Web Browser หรือทีDเรียกกนัติดปากวา่โปรแกรมท่องอินเทอร์เน็ตนั�น จะเป็นโปรแกรม Firefox ซึDงวธีิการใชง้าน
นั�น เหมือนกบั Firefox ทีDเป็นเวอร์ชัDน ของ Windows อยูแ่ลว้นอกเหนือจากโปรแกรม Firefox ในระบบปฏิบติัการ Suriyan 
ยงัมีโปรแกรม Chromium Web Browser และเบราเซอร์อีกหลายค่ายดว้ยกนั 

 
ส่วนประกอบของ Mozilla Firefox 

1. Title bar เป็นทีDแสดงหวัขอ้ของเวบ็ 
2. Menu bar เป็นทีDเก็บคาํสัDงต่างในรูปแบบ Pull down menu 
3. Tool bar เป็นทีDเก็บคาํสัDงทีDเรียกใชบ่้อยๆ 
4. Location Bar เป็นทีDใส่ URL ของเวบ็ทีDตอ้งการ 
5. Web Page area เป็นทีDแสดงเวบ็เพจ 
6. Status bar เป็นทีDแสดงสถานะของเวบ็ 

วธีิเรียกใช้โปรแกรม Firefox  
1. ไปทีD Main Menu > อินเทอร์เน็ต >  Firefox Web Browser 
2. ในช่อง Address ใหใ้ส่ URL ทีDตอ้งการเช่น www.google.co.th 

1 

2 

3 

4 

5 

6 
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3. ในช่องคน้หาของ Google พิมพข์อ้ความทีDตอ้งการ เช่น “Suriyan” และคลิกปุ่ม “คน้หาดว้ย Google” 
4. คลิกลิงคที์Dตอ้งการ 

การใช้งานทั(วไปใน Firefox 
1. ในช่อง Address ใส่วา่ Google.co.th เคาะ Enter เพืDอเขา้เวบ็ Google 
2. ในช่อง Address ใส่วา่ Suriyan.in.th เคาะ Enter เพืDอเขา้ดูเวบ็ไซต ์

 

3. คลิกปุ่ม Back  เพืDอยอ้นกลบัไปในเวบ็ Google 

4. คลิกปุ่ม Forward เพืDอเขา้ไปสู่เวบ็ล่าสุด 

5. คลิกปุ่ม Reload  เพืDอโหลดเวบ็ใหม่ 

6. กรณีทีDเวบ็ชา้ใหค้ลิกปุ่ม Stop  เพืDอหยดุการโหลด 

7. ตอ้งการกลบัไปทีDหนา้แรก  ใหค้ลิกปุ่ม Home 
8. กรณีทีDตอ้งการกาํหนดค่า Home Directory ใหไ้ปทีDเมนู แกไ้ข > ปรับแต่ง 
9. คลิกทีDหนา้หลกั ในช่องหนา้แรก ใหใ้ส่เวบ็ทีDตอ้งการ 
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10. คลิกปุ่ม “ปิด” 
11. ทดสอบโดยคลิกปุ่ม Home จะไดห้นา้แรกตามทีDระบุ 

การเกบ็ลงิค์ไว้ใน Favorite เพื(อเรียกใช้ครั%งหน้า 
1. เขา้เวบ็ไซตที์Dตอ้งการ 
2. ไปคลิกเมนู ทีDคัDนหนา้เวบ็ > คลิกคัDนหนา้เวบ็นี�  

 
3. ระบุชืDอทีDตอ้งการ, เลือกตาํแหน่งโฟลเดอร์ทีDเก็บ 
4. คลิกปุ่ม “เสร็จ” 

ทดสอบเวบ็ที(คั(นหน้า 
1. เปิดเวบ็อืDนๆ 
2. คลิก ทีDคัDนหนา้เวบ็ > Recently Bookmarked > ชืDอทีDระบุจดัเก็บ 

การเปิดเวบ็เพจในแทบ็ใหม่ 
1. เปิด FireFox 
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2. คลิกเครืDองหมาย + เพืDอเปิดแท็บใหม่ 
3. พิมพ ์URL ทีDตอ้งการ 

 
4. คลิกปุ่ม X เพืDอปิดแทบ็ 

 
การพมิพ์หน้าเวบ็ 

1. คลิกทีDเมนู แฟ้ม > พิมพ ์ 
2. ระบุเครืDองพิมพที์Dตอ้งการ, คลิกปุ่ม “พิมพ”์ 

 

7.2 การตดิตั%ง และการปรับค่าตดิตั%ง Plugin ใน FireFox 

คุณสามารถทีDเพิDมความสามารถของ Firefox ไดโ้ดยการดาวน์โหลด และติดตั�ง Plugin ต่างๆเพิDม ทั�งจากเครืDองมือ ศูนย์
ซอฟตแ์วร์ Ubuntu หรือจากเครืDองมือจดัการแพกเกจ Synaptic 
Java plugin for Mozilla Firefox 
เมืDอเขา้ในเวบ็ไซตบ์างแห่งจะตอ้งใช ้Java Plugin ดงันั�นเราตอ้งติดตั�งแพกเกจ sun-java6-plugin สาํหรับเครืDอง i386 หรือ  
j2re-1.4-mozilla-plugin สาํหรับเครืDอง 64 บิตทีD multiverse repository 

1. เปิด “ศูนยซ์อฟตแ์วร์ Ubuntu” 
2. ในช่องคน้หา, พิมพว์า่ “sun-java6-plugin” 
3. ดบัเบิ�ลคลิกทีD “sun-java6-plugin”, คลิกปุ่ม “โหลด”  
4. คลิกปุ่ม “Install”  
5. รอดาวน์โหลดจนขึ�นหนา้จอ กาํลงัตั�งค่า sun-java6-jre 
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6. คลิกเช็คบอ็กซ์ Do you agree with the DLJ license terms?, คลิกปุ่ม “ถดัไป” 
7. รอติดตั�งแลว้คลิกปุ่ม “ปิด” 
8. ตรวจสอบโดยไปทีD Main menu > อินเทอร์เน็ต > Sun Java 6 Web Start 

 

7.3 การใช้โปรแกรม E-mail 

โปรแกรมทีD Suriyan ใชคื้อ Evolution ซึDงเป็นเครืDองมือทีDในการติดต่อสืDอสาร E-mail, เก็บบญัชีรายชืDอ, บญัชีงาน, และการ
นดัหมาย ซึDงโปรแกรมยงัรองรับการติดต่อ Newsreader ทีDใชร่้วมกบั Gnome panel clock โดยการคลิกเพียงครั� งเดียว 
นอกเหนือจาก Evolution ใน Suriyan ยงัรองรับโปรแกรม Mozilla Thunderbird ซึDงจะตอ้งทาํการติดตั�งแพคเกจเพิDมก่อน 
 
การเรียกโปรแกรม Evolution และการตดิตั%ง 

1. คลิกเลือก Main Menu > อินเทอร์เน็ต > Mail Evolution 
2. ในหนา้ “ยนิดีตอ้นรับ”, คลิกปุ่ม “ถดัไป” 
3. ในหนา้ “ฟื� นคืนโดยใชข้อ้มูลสาํรอง” , คลิกปุ่ม “ถดัไป” 
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4. ในหนา้ “ขอ้มูลบุคคล” ใส่ชืDอ และ e-mail ทีDตอบกลบั, คลิกปุ่ม “ถดัไป” 

 
5. ในหนา้ “การรับอีเมล” ใหร้ะบุ Server type เป็น POP (หรือค่าทีDระบุ) , คลิกปุ่ม “ถดัไป” 
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6. ในหนา้ “ตวัเลือกการรับเมล” ใหร้ะบุตามค่าโดยทัDวไป, คลิกปุ่ม “ถดัไป” 

 
7. ในหนา้ “การส่งเมล” ระบุ Server Type เป็น SMTP ทีDเครืDองแม่ข่ายใหร้ะบุตามทีDกาํหนด, คลิกปุ่ม “ถดัไป” 
8. ในหนา้ “การจดัการบญัชีผูใ้ช”้, ระบุชืDอทีDตอ้งการ , คลิกปุ่ม “ถดัไป” 
9. ในหนา้ “เสร็จแลว้” , คลิกปุ่ม “เริDมใช”้ 
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การใช้งาน Evolution 

1. คลิกปุ่ม “สร้างใหม่” 
2. ระบุชืDอในช่อง “ถึง” และใส่เรืDองทีDตอ้งการในช่อง “เรืDอง”, พิมพข์อ้ความทีDทดสอบในช่องดา้นล่าง 

 
3. คลิกปุ่ม “ส่ง” 
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การรับ และอ่านจดหมาย 
1. เปิดโปรแกรม Evolution  
2. คลิกปุ่ม “รับ/ส่ง” 

 
3. ในช่องรหสัผา่นใหร้ะบุ, คลิกปุม “ตกลง” 

หมายเหตุ คุณตอ้งมีรายชืDอ POP3/IMAP4 ก่อน 
4. คลิกทีD “จดหมายเขา้”, คลิกจดหมายทีDตอ้งการเพืDออ่าน, หรือดบัเบิ�ลคลิกเพืDอเปิดขึ�นมาอ่าน 
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การส่งจดหมายแบบมอีอปชั(น 
1. คลิกปุ่ม “สร้างใหม่” 
2. ระบุชืDอในช่อง “ถึง” และใส่เรืDองทีDตอ้งการในช่อง “เรืDอง”, พิมพข์อ้ความทีDทดสอบในช่องดา้นล่าง 

กรณีทีDใหแ้นบลายเซ็น ใหค้ลิกเลือก “สร้างโดยอตัโนมติั” 

ขอ้ความทีDส่งสามารถทีDระบุเป็น ขอ้ความเปล่า หรือ HTML ได ้
3. คลิกปุ่ม “Add Attachment”, ระบุชืDอไฟลที์Dตอ้งการ 
4. คลิกปุ่ม “แนบ” 
5. คลิกปุ่ม “ส่ง” 
6. คลิกปุ่ม “รับ/ส่ง”  

 
7. พบวา่มีออปชัDนไฟลแ์นบดว้ย 

กรณีทีDตอ้งการเขา้รหสัสามารถทีDระบุระบบรักษาความปลอดภยัในการรับส่งไดด้งัรูป 
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การตอบกลบัจดหมาย 
1. ดบัเบิ�ลคลิกเปิดจดหมายทีDตอ้งการ 1 ฉบบั 

 
2. คลิก “ตอบกลบั”, เพืDอระบุกลบัมาทีDผูส่้ง และพิมพข์อ้ความตอบโต ้

กรณีทีDคลิก “ตอบกลบัทั�งหมด” จะจ่าหนา้ซองถึงทุกคน และสญัลกัษณ์จะแจง้วา่มีการตอบกลบัทั�งหมด 
กรณีทีDคลิก “ส่งต่อ” ผูส่้งตอ้งระบุจ่าหนา้ซองถึงบุคคลทีDตอ้งการใหม่ และสญัลกัษณ์จะแจง้ใหท้ราบวา่มีการส่งต่อ 

 
3. คลิกปุ่ม “ส่ง” 
4. คลิกปุ่ม “รับ/ส่ง” 
5. พบวา่จดหมายทีDตอบกลบัจะมีรูปสญัลกัษณ์ปรากฎวา่ไดต้อบกลบัแลว้, และในจดหมายทีDส่งจะมี Subject ขึ�นวา่ 

Re: 
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ตวัอยา่งการส่ง และตอบกลบัแบบต่างๆ 

 
 

การใช้งานปฎทินิ 
1. คลิกทีD “ปฏิทิน” 

 
2. เลือกระยะเวลาทีDตอ้งการ, พิมพข์อ้ความเพืDอนดัหมาย 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 121 

 

 
กรณีทีDเลือกเป็นวนัอืDนใหร้ะบุวนัทีDก่อน แลว้เลือกช่วงเวลา 

 
3. กรณีทีDตอ้งการนดัเป็นวนัใหค้ลิกทีDใตว้นัทีD และพิมพชื์Dอเหตุการณ์ 

 
4. กรณีทีDตอ้งการเลืDอนเวลาใหด้บัเบิ�ลคลิกเขา้ในเหตุการณ์ และทาํการปรับเปลีDยนวนัเวลาทีDตอ้งการ 
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5. ค่าทีDปรับเปลีDยนจะมี ปฏิทิน, สรุปหวัขอ้, สถานทีD, เวลา, คาํอธิบาย, การแนบไฟล ์
6. เสร็จเรียบร้อยคลิกปุ่ม “บนัทึก” 

 
วนัทีDมีนดัจะแสดงเป็นสีเขม้ 

 
การกาํหนดแจ้งเตอืนนัดหมาย 
โดยทัDวไปนดัหมายทีDระบุจะเป็นเพียงบนัทึกกิจกรรมตามาเวลาทีDระบุ ซึDงถา้คุณตอ้งการทีDจะใหมี้การแจง้เตือนล่วงหนา้ให้
ไปกาํหนดคุณสมบติัของนดัหมายนั�นเพิDมเติมวา่ใหมี้การเตือน 
ขั%นตอนกาํหนดแจ้งเตอืน 

1. ดบัเบิ�ลคลิกนดัหมายทีDตอ้งการแจง้เตือน 
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2. คลิกปุ่มกาํหนดการแจง้เตือน 

 
3. ระบุเวลาในการแจง้เตือนล่วงหนา้ และคลิกปุ่ม “ปิด” 

ค่าทีDระบุมี 15 นาที, 1 ชัDวโมง, 1 วนั, หรือปรับแต่งเวลา 
4. พบวา่นดัหมายจะมีรูประฆงัคว ํDาแสดงดงัรูป 

 
 
การกาํหนดนดัหมายที(เกดิขึ%นซํ%าๆ 
การนดัหมายทัDวไปจะเกิดขึ�นตามวนั เวลาทีDระบุเพียงครั� งเดียว แต่ในความเป็นจริงการนดัหมายหลายครั� งจะเป็นรอบทีD
แน่นอนตายตวั  
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ขั%นตอนการระบุนัดหมายซํ%า 
1. ดบัเบิ�ลคลิกนดัหมายทีDตอ้งการทาํซํ� า หรือสร้างนดัหมายใหม่โดยคลิกปุ่ม “สร้างใหม่” 
2. ใส่รายละเอียดในช่อง สรุป, สถานทีD, เวลา, และคาํอธิบาย 

 

3. คลิกปุ่ม “ทาํใหเ้ป็นเหตุการณ์เวยีนซํ� า”  
4. ระบุรอบเวลาทีDตอ้งการ ซึDงจะมีตวัอยา่งแสดงใหเ้ห็นดา้นล่าง 

 
ค่ากาํหนดการเวยีนซํ� าประกอบดว้ย 

- จาํนวนหน่วยเวลา 
- หน่วยของเวลา 
- ลาํดบัของรอบกาํหนดซํ� า เช่นสปัดาห์ทีD 1 ของเดือน 
- วนัในสปัดาห์ 
- จาํนวนทีDตอ้งการใหเ้กิดซํ� า For/until/forever ถา้ For ระบุขอ้มูลดา้นหลงัเป็นจาํนวน กรณีทีDเป็น until ใหร้ะบุวนัทีD 

สุดทา้ย forever จะเป็นลาํดบัทีDเกิดขึ�นตลอดเวลา 
- จาํนวนทีDตอ้งการใหเ้กิด ใชก้าํหนดสาํหรับเงืDอนไข for  
5. คลิกปุ่ม “ปิด” 
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6. คลิกปุ่ม “บนัทึก”  
ตวัอยา่งนดัหมายทีDเกิดขึ�นซํ� าจะมีรูปลูกศรบนล่าง 

 
 
การกาํหนดนดัหมายเป็นเหตุการณ์ 
เหตุการณ์คือเวลาทีDเกิดขึ�นในทั�งวนั ไม่เหมือนนดัหมายทีDตอ้งระบุเวลา เช่น วนัเกิด วนัหยดุสาํคญั เป็นตน้ 
การสร้างเหตุการณ์ 

1. ใหค้ลิกเมาส์ใตว้นัทีDในพื�นทีDกาํหนดนดัหมาย 
2. พิมพข์อ้ความทีDตอ้งการ 

 

 
3. ดบัเบิ�ลคลิกทีDเหตุการณ์เพืDอกาํหนดคุณสมบติั  

ซึDงเราสามารถกาํหนดเหตุการณ์นี� ใหเ้กิดขึ�นซํ� าไดเ้หมือนกบันดัหมาย และระบุเวลาเป็นรอบวนั ดงัรูป 

 
4. ปรับเปลีDยนค่าทีDตอ้งการ, และคลิกปุ่ม “บนัทึก” 
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การเปลี(ยนมุมมองปฏิทนิ 

 
ใน Toolbar เราสามารถทีDจะระบุดูเหตุการณ์ทีละเหตุการณ์จากก่อน วนันี�  หรือหลงัได ้
การปรับเปลีDยนมุมมองสามารถระบุไดเ้ป็น 
มุมมอง หน้าตา 
วนั  

 
สปัดาห์ทาํงาน 
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สปัดาห์ 

 
เดือน 

 
รายการ 
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การประยุกต์ใช้ปฏิทนิกบัภารกจิ และบนัทกึช่วยจาํ 
ในการบนัทึกกิจกรรมนอกจากนดัหมายแลว้ในหลายครั� งจะเป็นงานทีDตอ้งดาํเนินการซึDงจะมีทั�งเป็นภาระกิจ และเป็นบนัทึก
ช่วยจาํเพืDอเตือนใหด้าํเนินการเท่านั�น 
การใชป้ฏิทินกบัภารกิจ 

1. เปิดโปรแกรม Evolution 
2. กรอบดา้นขวามือทีDภารกิจ, คลิก “คลิกเพืDอเพิDมภารกิจ” 

 
3. พิมพภ์ารกิจทีDตอ้งการ 
4. ดบัเบิ�ลคลิกเพืDอเขา้ใส่รายละเอียด 

 
5. ระบุวนัเริDมตน้, วนักาํหนดเสร็จ, และคาํอธิบาย, กรณีทีDมีไฟลแ์นบใหค้ลิก Add Attachment… ดว้ย 
6. คลิกปุ่ม “บนัทึก” เมืDอเสร็จสิ�น 
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การอพัเดตสถานะของภาระกจิ 
1. ดบัเบิ�ลคลิกภาระกิจทีDตอ้งการ 

 
2. ระบุสถานะของงานประกอบดว้ย 

 
ตารางที(  13 คาํอธิบายสถานะของภารกจิ 

ค่ากาํหนด คาํอธิบาย 

สถานภาพ  

สถานะ ประกอบดว้ย In progress, Completed, Canceled 
เปอร์เซ็นตง์านทีDเสร็จ ระบุเป็นงานเทียบอตัราส่วน 100% 
ระดบัความสาํคญั ระบุความสาํคญั High, Medium, Low 
วนัทีDทาํเสร็จ ระบุวนั เวลาทีDทาํสาํเร็จ 

เบ็ดเตลด็  

เวบ็เพจ ระบุลิงคที์Dดาํเนินการ 
3. ระบุเสร็จเรียบร้อยคลิกปุ่ม “ปิด” 

 
4. เมืDอวางเมาส์ไวที้DงานจะทราบรายละเอียดทีDดาํเนินการ 
5. การกาํหนดความสาํเร็จของงานสามารถระบุไดโ้ดยการคลิกเครืDองหมาย “ถูก” หนา้ภารกิจ 
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6. ซึDงเมืDอดบัเบิ�ลคลิกเขา้ไป, และคลิกปุ่ม  แสดงสถานะพบวา่สาํเร็จ (Completed) แลว้ 
7. คลิกทีD “ภาระกิจ” เพืDอเรียกหนา้ดาํเนินการ 

 
8. ถา้มีการระบุหมวด เราสามารถทีDคลิก “แสดง” เลือกหมวดทีDตอ้งการได ้ 

เช่นภาระกิจทีDสาํเร็จ คัDงคา้ง หรือทีDกาํลงัทาํอยู ่
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9. การเรียงเราสามารถทีDระบุการเรียงของภารกิจไดโ้ดยคลิกขวาทีD “สรุป” 
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10. เลือกคาํสัDง เรียงตาม > ระบุรายการทีDตอ้งการดงัรูป 
11. ถา้ตอ้งการเลือกเพิDมคอลมัน์ ใหค้ลิกขวาทีD “สรุป” > “เพิDมคอลมัน”์ 

 
12. ลาก “หมวด” ไปไวข้า้งๆ “สรุป”, คลิกปุ่ม “ปิด” ดงัรูป 

 
การกาํหนดหมวดหมู่ของภารกจิ 

1. เปิด Evolution, คลิกเขา้ใน “ภารกิจ” 
2. คลิกเพืDอสร้างภารกิจใหม่ 
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3. คลิกเมนู มุมมอง > หมวด 
จะปรากฎหนา้จอแสดงหมวดขึ�น 

4. ใส่หวัขอ้ และรายละเอียดทีDตอ้งการ, คลิกปุ่มบนัทึกหนา้ต่างปัจจุบนั และปิดภารกิจทีDกาํหนด 
 
 
การมอบหมายภารกจิ 

1. เปิด Evolution, คลิกเขา้ใน “ภารกิจ” 
2. เลือกรายการภารกิจทีDตอ้งการ, คลิกขวาเลือก “มอบหมายภารกิจ” 

 
3. ระบุรายละเอียด, ทีDสาํคญัใหเ้พิDมผูเ้ขา้ประชุม 
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4. คลิกปุ่ม “บนัทึก” 
5. คลิกปุ่ม “ส่ง”, คลิกปุ่ม “ส่ง” อีกครั� งถา้มีขอ้ความแจง้ 
เราสามารถทีDจะส่งออกเป็น E-mail ในรูปแบบ iCalendar ไดโ้ดยการคลิกขวาเลือก “ส่งต่อเป็น iCalendar” และระบุ
เป้าหมาย e-mail ทีDตอ้งการ 
 

การใช้บันทกึช่วยจาํ 
1. คลิกทีD “คลิกเพืDอเพิDมบนัทึกช่วยจาํ” ภายใตบ้นัทึกช่วยจาํ 

 
2. พิมพข์อ้ความทีDตอ้งการ, แลว้เคาะ Enter 

 
3. คลิกทีD “บนัทึกช่วยจาํ” ดา้นขวาเพืDอเรียกหนา้ดาํเนินการ  
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4. ดา้นขวาจะมี “หมวด” พิมพห์มวดทีDตอ้งการลงไป 

 
5. คลิกทีD “หมวด” เพืDอใหร้ะบบจดัเรียงตามตวัอกัษรของหมวด, หรือคลิก “สรุป” เพืDอใหร้ะบบจดัเรียงตามหวัขอ้ 

เราสามารถทีDจะส่ง “บนัทึก” เป็น iCalendar ไดโ้ดยระบุคลิกขวาเลือก “ส่งต่อเป็น iCalendar”, และระบุ e-mail 
ผูรั้บ 

 
การสร้างบญัชีรายชื(อผู้รับ (Contact) 
เป็นการสร้างบญัชีรายละเอียดทีDติดต่อของผูที้Dเราเรียกใชอ้ยูเ่ป็นประจาํ 

1. เปิด Evolution, คลิกทีD “ทีDอยูติ่ดตอ่” 
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2. คลิกปุ่ม “สร้างใหม่” 
3. คลิกปุ่ม “ยอมตลอดไป” 
4. ป้อนรายละเอียดต่างๆ 
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5. คลิกปุ่ม “ตกลง” 

 
6. คลิกทีD “ส่วนบุคคล” ดูรายการทีDใส่ 
7. คลิกทีDบญัชีรายชืDอจะพบรายละเอียดของขอ้มูล 
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8. คลิก “ส่งต่อทีDอยูติ่ดต่อ”ระบบจะสร้างเป็น vCard, และให ้e-mail ทีDตอ้งการ, คลิกปุ่ม “ส่ง” 

 
ถา้คลิกทีD “ส่งขอ้ความไปทีDอยูส่่งต่อ” จะเป็นการนาํ e-mail ของบุคคลนั�นส่งใหด้งัรูป 
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การรับส่งข้อความทนัใจด้วยโปรแกรม Empathy  
โปรแกรมรับส่งขอ้ความทนัใจ หรือ Instant Message ทีDมีมาใหใ้นระบบปฏิบติัการสุริยนัคือโปรแกรม Empathy ซึDงสามารถ
ทรองรับการติดต่อกบัระบบขอ้ความทนัใจหลายระบบ เช่น MSN, Yahoo, ICQ, และ IRC เป็นตน้ ซึDงการใชง้านจะ
เหมือนกบัซอฟตแ์วร์ Instant Message อืDนๆทีDเป็นทีDนิยมใชบ้นทอ้งตลาด 
การสนทนาโดยใช้ Empathy กบั MSN 

1. หนา้จอ “รายชืDอผูติ้ดต่อ” 
สถานะของผูใ้ชง้าน MSN โดยทัDวไปจะเป็นสถานะ “อยู”่ ซึDงเราสามารถทีDปรับเปลีDยนสถานะต่างๆไดด้งันี�  

- อยู ่   เป็นการแจง้ใหทุ้กคนทราบวา่เราอยูที่Dหนา้จอคอมพิวเตอร์ และเปิดใช ้MSN  
- ขอ้ความกาํหนดเอง  เหมือน “อยู”่ แต่เราเปลีDยนคาํพดูตามทีDตอ้งการ 
- ไม่วา่ง   เป็นการแจง้วา่ตอนนี�กาํลงัวุน่ หรือไม่วา่ง 
- ขอ้ความกาํหนดเอง  เหมือน “ไม่วา่ง” แต่เราเปลีDยนคาํพดูตามทีDตอ้งการ 
- ไม่อยู ่   เป็นการแจง้วา่ตอนนี�ไม่อยูที่Dหนา้เครืDอง 
- ขอ้ความกาํหนดเอง  เหมือน “ไม่อยู”่ แต่เราเปลีDยนคาํพดูตามทีDตอ้งการ 
- ซ่อนตวั   ผูใ้ชอ้ยูที่Dหนา้เครืDองแต่ไม่ปรากฎต่อคู่สนทนา 
- ออฟไลน์   แจง้สถานะวา่ตอนนี�ไม่ไดใ้ชง้าน MSN 

 
เมืDอมีผูใ้ชเ้ขา้มาใหม่จะปรากฎรายชืDอเพิDม 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 141 

 

2. ดบัเบิ�ลคลิกรายชืDอเพืDอเขา้สู่การสนทนา 
เป็นการพิมพข์อ้ความตอบโต ้

 
3. พิมพข์อ้ความทีDตอ้งการ และเคาะ Enter 

 
4. ตอ้งการออกจากหนา้จอการสนทนา, ใหค้ลิกปุ่ม Close  

 
การขอรับการสนทนา 

1. ถา้สญัลกัษณ์วงกลม กระพริบแสดงวา่มีขอ้ความติดต่อถึงเรา 
2. ดบัเบิ�ลคลิกเพืDอเขา้ไปอ่าน และติดต่อสืDอสาร 

 
 

การสนทนาใหม่ 
1. คลิกทีDเมนู สนทนา > การสนทนาใหม่ 
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2. ใส่ชืDอผูส้นทนา  
3. คลิกเมนู มุมมอง > แสดงตวัอยา่งวดิีทศัน ์

 

4. ฝัDงผูรั้บใหค้ลิก “Accept” 

 
5. หลงัจากนั�นก็สนทนาทั�งภาพ และเสียง 

 
การเปลี(ยนบุคคลที(สนทนา 

1. คลิกเมนู แกไ้ข > บญัชี 
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2. ในช่อง “ชืDอเขา้ระบบ” ใหใ้ส่ชืDอใหม่ รวมถึงรหสัผา่นทีDถูกตอ้ง, คลิกปุ่ม “เริDมใช”้ 
3. คลิกปุ่ม “ปิด” 
  

การเพิ(มรายชื(อการสนทนา 
การสนทนาเกิดขึ�นทั�งฝ่ายเรา และผูติ้ดต่อ ซึDงเราอาจจะเป็นผูร้้องขอติดต่อไป หรือบุคคลอืDนร้องขอติดต่อกบัเรา 

1. คลิกเมนู สนทนา > เพิDมผูติ้ดต่อ 
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2. เลือกรายละเอียดดงันี�  
- บญัชี   บญัชี MSN ใหม่ 
- ชืDอประจาํตวั  E-mail ทีDอยูใ่นเครือข่าย MSN 
- นามแฝง   ใส่ขอ้ความสืDอสารใหผู้ติ้ดต่อเขา้ใจ 
- กลุ่ม   ใส่ชืDอกลุ่มทีDตอ้งการ หรือเลือกกลุ่มทีDมีอยูเ่ดิม ถา้เพิDมกลุ่มใหพิ้มพชื์Dอใหม่ และคลิก

ปุ่ม “เพิDมกลุ่ม” 
3. คลิกปุ่ม “เพิDม” 

 
4. ดบัเบิ�ลคลิกชืDอทีDตอ้งการติดต่อ 

 
 
การ Chat ด้วย Empathy 

1. เปิดโปรแกรม ลูกข่ายขอ้ความทนัใจ Empathy 
2. คลิกเมนู แกไ้ข > บญัชี 
3. คลิกปุ่ม “เพิDม” 
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4. ในหวัขอ้ “สร้างบญัชี” เลือก #IRC, คลิกปุ่ม “สร้าง” 
5. กาํหนดค่าต่างๆดงันี�  

 

- เครือข่าย   2600net เราสามารถทีDปรับเปลีDยน และเพิDมเติมไดโ้ดยคลิก  
- ชืDอเรียก  ระบุชืDอผูติ้ดต่อ 
- รหสัผา่น  รหสัผา่นทีDเขา้ใช ้
- ชืDอจริง  ใส่ชืDอทีDตอ้งการ 
- ขอ้ความขณะออก ขอ้ความทีDตอ้งการ 
6. คลิกปุ่ม “เชืDอมต่อ”, และคลิกปุ่ม “ปิด” 

 
ตวัอย่างการเชื(อมต่อ Empathy กบั ICQ 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 146 
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บทที� 8 การใช้งานโปรแกรมเกี�ยวกบัรูปภาพ 

กราฟฟิก & วาดรูป 
Suriyan มีโปรแกรมกราฟิกและวาดภาพชั�นนาํมาใหพ้ร้อมใชง้านทั�ง Gthumb, Gimp, Inscape และชุด OpenOffice.Draw 
โปรแกรมดูรูปภาพ (Image Viewer) 

โปรแกรมดูภาพใน Suriyan คือ Eye of GNOME ซึDงมีฟีเจอร์เหมือนโปรแกรมดูภาพทัDวไปทีDใชง้านไดไ้ม่ยาก นอกจากนี�

โปรแกรมยงัสามารถทีDจะเชืDอมตอ่ไปยงั F-spot View เพืDอปรับความมืด สวา่ง และค่าต่างๆเกีDยวกบัสี, ตดัภาพใหเ้หลือเฉพาะ

ส่วนทีDตอ้งการ, หรือทาํการ แปลงภาพไปเป็นไฟลภ์าพสกลุอืDน 

การเรียกโปรแกรมนั�นทาํไดโ้ดย 
1. ไปเปิดจากรูปภาพโดยตรง > คลิกขวาเลือก เปิดดว้ยแสดงรูป 

 
 

2. คลิกปุ่ม “ถดัไป” เพืDอดูรูปต่อไป 

3. คลิกปุ่ม “ก่อนหนา้” เพืDอดูรูปก่อน 

4. ตอ้งการซูมใหค้ลิกเครืDองหมาย  

 

+  คือการซูมเขา้ไป 

- คือการซูมออกมา 

1 คือการดูขนาดจริง 

[ ]   คือการดูขนาดพอดีโปรแกรม 
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5. คลิกปุ่มหมุนรูป ซึDงมี 2 แบบคือหมุนไปดา้นซา้ย 90 องศา หรือดา้นขวา 90 องศา  
ตวัอยา่งเป็นการคลิกปุ่มหมุนไปดา้นขวา 90 องศา 

 

6. กรณีทีDตอ้งการแกไ้ขรูปภาพใหค้ลิกปุ่ม “แกไ้ขรูปภาพ” ซึDงจะเป็นการเรียกโปรแกรม F-Spot View 
เราสามารถใส่เอฟเฟกซ์ทีDตอ้งการโดยใชปุ่้มดา้นขวา 

 

7. เมืDอกาํหนดค่าไดต้ามทีDตอ้งการใหค้ลิกเมนู ภาพถ่าย > บนัทึก  
เป็นการจดัเก็บไวใ้นไฟลเ์ดิม 
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การเปิดไฟล์รูปภาพ (Image Editor) 

8.1 โปรแกรม The GIMP (Gnu Image Manipulation Program) 

โปรแกรมสาํหรับตดัต่อและตกแต่งภาพนั�น Suriyan เลือกเอาโปรแกรม GIMP เขา้มารวมไวเ้ป็นโปรแกรมหลกัทีDใชส้าํหรับ
ตกแต่งภาพซึDงมีความสามารถไม่แพโ้ปรแกรมตกแต่งภาพชั�นนาํในทอ้งตลาดเลย ทั�ง การทาํงานแบบเลเยอร์ ฟิลเทอร์ต่างๆ
ทีDมีใหเ้ลือกใช ้แถมยงัรองรับไฟลห์ลากหลายรูปแบบทีDเป็นทีDนิยม ไม่เวน้แมแ้ต่ไฟล ์.psd ของโปรแกรม Photoshop ก็ตาม  
ส่วนประกอบหน้าจอของโปรแกรม Gimp 

 
1. กล่องเครืDองมือ เป็นทีDเก็บเครืDองมือในการบริหารจดัการรูปภาพ 
2. เมนู เป็นทีDเก็บชุดคาํสัDงต่างๆ 
3. พื�นทีDทาํงาน  

กรณีที(ต้องการเรียกชั%นงาน และส่วนประกอบของชั%นงาน 
ถา้โปรแกรมไม่มีส่วนประกอบชั�นงาน คุณสามารถทีDจะเรียกขึ�นมาไดเ้องจากเมนู Windows ดงันี�  

1. คลิกทีDเมนู Windows > Dockable Dialogs > ชั�นงาน 

1 

2 

3 
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2. ส่วนประกอบของชั�นงาน 

 

a 

b 

c 
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a. เป็นการกาํหนดค่าใหก้ล่องโตต้อบจะถูกเรียกขึ�นอตัโนมติั ซึDงคลิกหนึDงครั� งเป็นการเรียกใช ้(สีเทาเขม้) 
คลิกอีกครั� งจะเป็นการยกเลิก 

b. เป็นการระบุค่า ชั�นงาน (Layers), แชนเนล (Channels), พาธ (Paths), ประวติั (History) 
ซึDงเมืDอเลือกแทบ็ทีDระบุรายละเอียดคุณสมบติัดา้นล่างจะเปลีDยน เช่นถา้เป็นชั�นงานจะแสดงเป็นลาํดบัชั�น
ทีDมีอยูใ่นภาพทีDกาํลงัดาํเนินการ 

 
c. เป็นหวัขอ้ทีDระบุ หวัแปรง (Brushes), แบบลาย (Patterns), ไล่สี (Gradients)  

ซึDงเมืDอเลือกแทบ็ทีDระบุรายละเอียดคุณสมบติัดา้นล่างจะเปลีDยน เช่นถา้เลือกเป็น Brushes จะแสดงเป็น
ชนิดของหวัแปรง ขนาด ระยะเป็นตน้ 

 
 

วธีิการเรียกโปรแกรม และการใช้งานโปรแกรม GIMP 
1. ไปคลิกทีD Main Menu > กราฟิกส์ > GIMP Image Editor 
2. คลิกทีDเมนู แฟ้ม > เปิด หรือกดคีย ์Ctrl+O 
3. ระบุตาํแหน่งไฟลที์Dตอ้งการ, คลิกปุ่ม “เปิด” 
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4. เราสามารถทีDจะซูมรูปภาพโดยระบุทีDเครืDองมือซูม 

 
5. เปลีDยนรูปแบบสเกลใหเ้ป็น “นิ�ว” 
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6. ไมบ้รรทดัจะเปลีDยนตามไปดว้ยดงัรูป 
 

 

การใส่เอฟเฟกซ์ในภาพ 

1. เมืDอเปิดภาพแลว้ สิDงแรกทีDคุณควรรู้คือการปรับเปลีDยนเอฟเฟกซ์ของภาพ 
2. คลิก ฟิลเตอร์ > มวั > Motion Blur 

 
3. คลิกปุ่ม “OK” 
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ก่อน     หลงั 

4. ถา้ตอ้งการนาํกลบัใหค้ลิก แกไ้ข > นาํกลบั Motion blur 
คุณสามารถทีDตกแต่งภาพดว้ยเทคนิคอืDนๆไดม้ากมาย 
 
 
 
 
ตวัอย่างภาพ 

ฟิลเตอร์ ตวัอย่างรูปภาพ 
ภาพ Mosaic 
บิดเบี�ยว > Mosaic 

 
ภาพเก่า 
Decor > Old photo 

 
ภาพคลืDน 
บิดเบี�ยว > Waves 
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ภาพ Photocopy 
Artistic > Photocopy 

 
ภาพ Photocopy และ Old 
Photo 

 
5. คุณสามารถทีDใส่ฟิลเตอร์ หลายรูปแบบในภาพๆหนึDง 
6. คลิกปุ่ม X เพืDอปิดรูปภาพทีDไม่ตอ้งการ, คลิกปุ่ม “Don’t Save” 

กรณีทีDตอ้งการบนัทึกจดัเก็บใหม่, ใหค้ลิกปุ่ม “บนัทึก”, ระบุตาํแหน่ง และชืDอไฟล,์ คลิกปุ่ม “บนัทึก” นามสกลุจะ
ไดเ้ป็น xcf 

 
 
เรียนรู้กบัการปรับขนาดภาพ 

1. เปิดไฟลรู์ปภาพทีDตอ้งการ ซึDงรูปภาพจะอยูใ่นชั�นทีD 1  

 
2. คลิกทีD ภาพ > ปรับสดัส่วนภาพ 

จะปรากฎหนา้จอ Scale Image 
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โดยทัDวไปขนาดความกวา้ง และความสูงจะถูกลอ็คไว ้ถา้ระบุขนาดตามทีDตอ้งการเช่น 1000 ทีDความกวา้ง, ทีDความ
สูงก็จะลดไปดว้ย 

 
กรณีทีDตอ้งการปลดลอ็คใหค้ลิกทีDรูปห่วงโซ่ เมืDอระบุขนาดทีDความกวา้ง จะไม่มีผลต่อความสูง 

3. คลิกปุ่ม “Scale” เพืDอปรับขนาด 
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การสร้างชั%นงานใหม่ (New Layer) 

1. คลิกทีD ชั�นงาน > ชั�นงานใหม่ 

 
2. เมืDอขึ�นไดอะลอ็กซ์บอกซ์ “ชั�นงานใหม่”, ใหร้ะบุชืDอเช่น “Foreground” 
3. ในกรอบรูปแบบชั�นงานใหม่ ในทีDนี� ระบุ “ขาว” เพืDอทดสอบ 
4. คลิกปุ่ม “ตกลง” 

 
พบวา่รูปภาพจะหายไปเนืDองจากลาํดบัชั�นงานใหม่ทบั ตรวจสอบจาก Status Bar 

5. คลิกทีD ชั�นงาน, คลิกขวาเลือกคาํสัDง ฟิลเตอร์ > แสงและเงา > Gradient Flare… 
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6. ในแทบ็ Selector เลือกค่าโดยทัDวไป, คลิกปุ่ม “OK” 
7. คลิกเลือก Windows > Dockable Dialogue > “ชั�นงาน” หรือกดคีย ์Ctrl+L 
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ซึDงถา้เราคลิกทีDรูป “ตา” ใหน้าํออกชั�นนั�นจะไม่แสดง  ซึDงเราอาจจะทาํใหช้ั�นดา้นบนเป็น โปร่งใสก็ได ้

 
8. ถา้คลิกทีDรูป “โซ่” เพืDอลอ็คการแสดง 

การบริหารจดัการชั%นงาน ค่าที(ระบุ 
การสร้างชั�นใหม่ 
ระบุชืDอ และค่ากาํหนดเป็น 

- สีพื�นหนา้ 
- สีพื�นหลงั 
- สีขวา 
- โปร่งใส 

1. คลิกทีDเมนู ชั�นงาน > ชั�นงานใหม่ 
2. ระบุค่ากาํหนดของชั�น, คลิก OK 

 

การปรับเปลีDยนสี หรือภาพ  
สามารถกาํหนดสีเป็นสีพื�นหนา้ พื�นหลงั หรือ
แบบลาย 

ใหค้ลิกขวาเลือก แกไ้ข > เติมดว้ยแบบลาย, พบวา่จะขึ�นรูปภาพ
ทบัแทน 

การสลบัลาํดบัชั�น 
- สามารถทีDระบุสลบัเลืDอนขึ�น/ลง ทีละ

ชั�น 
- ระบุไปชั�นบนสุด หรือชั�นล่างสุด 

ใหค้ลิกขวาเลือก ชั�นงาน > ลาํดบั > Reverse layer Order 
หรือ 
ชั�นงาน > ลาํดบั > สลบัชั�นงานขึ�น/ลง (ขึ�นอยูก่บัเลือกลาํดบัชั�น
บน หรือล่าง) 

ค่ากาํหนดคุณสมบติัชั�น ดบัเบิ�ลคลิกเพืDอปรับเปลีDยน 
การรวมชั�นงาน คลิกเมนู ชั�นงาน > รวมกบัชั�นล่าง 
การลบลาํดบัชั�น 
เป็นการนาํชั�นทีDเลือกออก 

ใหค้ลิกขวาเลือก ชั�นงาน > ลบชั�นงาน 

การแสดงชั�นงาน 
เพืDอสะดวกในการแสดงผล และการปรับแต่ง 

คลิกเลือก Windows > Dockable Dialogue > “ชั�นงาน” หรือกด
คีย ์Ctrl+L 

การเลอืกรูปภาพ และการสร้างชั%นงานใหม่ 

1. เปิดไฟลรู์ปภาพทีDตอ้งการใหม่ 
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2. คลิกเมนู ชั�นงาน > ชั�นงานใหม่ ระบุชืDอเช่น “Foreground” 
3. เลือกค่ากาํหนดเป็น “ขาว” และคลิกปุ่ม “OK” 

กรณีทีDไม่มีการแสดงหนา้ต่างชั�นงานใหค้ลิกทีDเมนู Windows > Dockable Dialogues > ชั�นงาน 
4. เลือกชั�นงานใหม่ทีDไดส้ร้างขึ�น 
5. เมนู เลือก > All หรือกดคียบ์อร์ด “Ctrl+A”  
6. คลิกเลือก แกไ้ข > ตดั หรือกดคีย ์“Ctrl+X” 
7. เลือกชั�นงานทีDตอ้งการ และกดคีย ์“Ctrl + V” เพืDอดาํเนินการปะภาพ 

ระบบจะแจง้วา่ค่าทีDปะ เป็นชั�นงานลอยตวั 

 
8. คลิกเมนู ชั�นงาน > ชั�นงานใหม่ คา่ขอ้มูลทีDปะจะอยูใ่นชั�นงานใหม่ 

 
การเลอืกออปเจค และการตดัปะ 

1. เปิดไฟลรู์ปภาพทีDตอ้งการ 
แนะนาํใหเ้ลือกไฟลที์Dมีโทนสีออปเจค กบัพื�นต่างๆ 
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2. ยกเลิกการเลือกเดิมกดคีย ์Shift+Ctrl+A 

3. คลิกเครืDองหมาย  
4. ปรับค่า Threshold ซึDงในทีDนี� ระบุทีD 10 (ตอ้งดูรูปทีDนาํเขา้มาเป็นหลกั) 

 
5. คลิกเลือกพื�นทีDทีDตอ้งการ 
6. กดคีย ์Ctrl+X เพืDอทาํการตดั 

7. เปลีDยนเครืDองมือเป็น Rectangle  และกดคีย ์Ctrl+X เพืDอตดัใหเ้ป็น Background 
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8. ดาํเนินการจนไดรู้ปภาพทีDตอ้งการ 
9. ยกเลิกการเลือกใหก้ดคีย ์Shift+Ctrl+A 
10. เลือกยางลบ และเลือกหวัแปรงขนาดใหญ่ดงัรูป 

 
 

11. คลิกเลือกการซูมเขา้ 200% เพืDอตกแต่งภาพ 
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12. ทาํการลบพื�นทีDรอบ 
13. ทาํการซูมออกเหลือ 50% เพืDอตรวจสอบ 
14. คลิกเมนู แฟ้ม > บนัทึก  
15. ระบุชืDอไฟล ์และตาํแหน่งทีDจดัเก็บ, คลิกปุ่ม “บนัทึก” 

16. เลือก Fuzzy Selection Tool บนพื�นทีDขาว  
17. กดคีย ์Ctrl+I เพืDอทาํการเลือกแบบ Invert 
18. กดคีย ์Ctrl+X เพืDอตดัรูปภาพออก 
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19. คลิก แฟ้ม > เปิด  
20. เลือกตาํแหน่ง และไฟลรู์ปภาพ, คลิกปุ่ม “เปิด” 
21. กดคีย ์Ctrl+V เพืDอนาํรูปภาพทีDตดัมาปะ 

 
22. คลิกเมนู ชั�นงาน > ชั�นงานใหม่ 
23. คลิกเมนู แฟ้ม > Save As 
24. ระบุตาํแหน่ง และชืDอไฟลที์Dตอ้งการ, คลิกปุ่ม “บนัทึก”  

กรณีทีDระบุเป็นไฟล ์.jpg ตอ้งคลิกปุ่ม Export 

 
คลิกปุ่ม Save 

 
การใส่คาํบรรยายในภาพ 

1. เปิดไฟลจ์ากบนปฏิบติัการทีDผา่นมา 
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2. คลิกปุ่ม Text Tool , เลือกพื�นทีDตอ้งการลากจนไดข้นาด 

 
3. คลิกเลือกขนาดจาก 18 เป็น 120 และคลิกสีจากดาํเป็นสีนํ� าเงิน 
4. พิมพข์อ้ความทีDตอ้งการเช่น ชืDอ, คลิกปุ่ม “ปิด” 

 
ผลทีDไดรั้บจะประกอบดว้ยชั�นงาน 3 ชั�น คือ 

- ชั�นทีD 1 คือขอ้ความ 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 167 

 

- ชั�นงานทีD 2 ชั�นงานทีDปะ 
- ชั�นงานทีD 3 คือ Background 
5. คลิกเมนู แฟ้ม > Save As  
6. ระบุชืDอไฟล ์และตาํแหน่งทีDตอ้งการ, คลิกปุ่ม “บนัทึก” 

กรณีทีDเป็น .jpg ตอ้งคลิกปุ่ม “Export”, คลิกปุ่ม “Save” 
 
การใช้เครื(องมอือื(นๆใน Gimp 

โปรแกรม Gimp จะมี Toolbox ทีDเก็บคาํสัDงใชง้านต่างๆ 

 
ตารางที( 14  คาํอธิบายกลุ่มเครื(องมอืต่าง ๆ ในโปรแกรม Gimp 

เครื(องมอื คาํอธิบาย 

 Selection Tools   กลุ่มเครื(องมอืในการเลอืกพื%นที( 
 Rectangle Selection   การเลือกพื�นทีDสีDเหลีDยม 
 Ellipse Selection   การเลือกพื�นทีDวงกลม วงรี 
 Free Selection (Lasso)   การเลือกพื�นทีDอิสระ ระบุเอง 
 Fuzzy selection (Magic wand)   การเลือกโดยใหร้ะบบพิจารณาจากค่า Threshold 
 Select By Color   การเลือกโดยพิจารณาจากสี 
 Intelligent Scissors   การเลือกโดยใชก้รรไกรตดัพื�นทีDทีDระบุ 
 Foreground Select   การเลือกพิจารณาจากสี Foreground 

 Other   เครื(องมอือื(นๆ 
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เครื(องมอื คาํอธิบาย 
 Paths   การระบุ 
 Color Picker   การเลือกสีทีDตอ้งการจากรูปภาพ 
 Zoom   การซูมเขา้ 
 Measure   การวดัระยะทาง Shift+M 
 Text   การพิมพข์อ้ความ 

 Transform Tools   การแปลงรูปภาพซึ(งผู้ใช้ต้องระบุเลอืกพื%นที(ก่อน 
 Move   การยา้ยตาํแหน่งทีDเลือก 

 Align  
 การเลืDอนตาํแหน่งชั�นงาน ใหขึ้�นบน ลงล่าง ไปลาํดบั
แรก หรือไปลาํดบัสุดทา้ย 

 Crop   การตดัรูป 
 Rotate   การหมุนรูป 
 Scale   การปรับขนาดของรูป 
 Shear   การปรับความเยื�องของภาพ 
 Perspective   การปรับมุมมอง Perspective 
 Flip   การกลบัภาพ 

 Brush Tools   กลุ่มเครื(องมอืในการระบายสี 

 Painting Tools (Pencil, Paintbrush, Airbrush)  
เครืDองมือในการเขียนเป็นดินสอ, แปรงทาสี หรือทีDพน่
สี 

 Bucket Fill   ถงัสีทีDใชเ้ทสีลงพื�นทีDจาํนวนมาก 
 Blend   การระบุไล่เฉดสี 
 Pencil   การเขียนดว้ยปากกา 
 Paintbrush   การทาสีดว้ยแปรงทาสี 
 Eraser   ยางลบทีDใชล้บภาพทีDเลือก 
 Airbrush Tool   การทาสีดว้ยเทคนิคการพน่สี (Airbrush) 
 Ink   การใชป้ากกา 
Clone   การโคลนพื�นทีDตน้ฉบบัไปยงัพื�นทีDปลายทาง 
Heal   การปรับโทนสี 

Perspective Clone  
 การโคลนพื�นทีDสีตน้ฉบบัไปยงัปลายทางในรูปแบบ 
Perspective 

Blur/Sharpen   การปรับสีใหเ้บลอ หรือใหช้ดั 

Smudge  
 การเกลีDยสี โดยการถูกเพืDอเฉลีDยผสมสี ไม่เหมือนกบั 
Blur/Sharpen ทีDเนน้ใหค้วามเขม้ของสีนอ้ยลง 
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เครื(องมอื คาํอธิบาย 
Dodge or Burn   ทาํใหสี้เขม้ขึ�น 

ขอ้มูลในใช ้GIMP Image Editor สามารถหาอ่านเพิDมเติมไดจ้าก GIMP homepage 
 
 

8.2 การใช้ OpenOffice: Drawing 

โปรแกรม Drawing เป็นโปรแกรมในชุด OpenOffice ซึDงติดตั�งมาใหก้บัระบบปฏิบติัการ Suriyan รูปแบบการใชง้านคลา้ย
โปรแกรม Adobe PageMaker 
วธีิการเรียกใช้ 

1. คลิกเมนู Main Menu > กราฟิกส์ > OpenOffice.org Drawing 

 
2. ใส่ขอ้ความในเอกสาร โดยคลิกทีDปุ่ม “ขอ้ความ” (Text)  

 
3. แลว้เลือกบริเวณทีDตอ้งการใส่ขอ้ความ, คลิกปรับขนาด Font และการจดักระดาษ เช่น Center 

 
4. คลิกทีDปุ่ม “รูปร่างพื�นฐาน” เลือก สีDเหลีDยมผืนผา้ขอบมน 
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5. ลากเลือกบริเวณทีDตอ้งการ 

 
6. คลิกขวาทีDออปเจค, และคลิก Arrange > Send  Backward 

 
7. คลิกเมนู File > Save 
8. ระบุชืDอไฟล ์และคลิกปุ่ม “Save” 

จะไดไ้ฟลน์ามสกลุ .odg 
 

การเปิดไฟล์ภาพนิ(ง 
1. คลิกเมนู File > Open 
2. ระบุตาํแหน่ง และหาไฟลรู์ปภาพ เช่น .jpg 
3. คลิกปุ่ม “Open” 
4. คลิกปุ่ม “Open Copy” 

ถา้คลิกปุ่ม “Open Readonly” เป็นการเปิดไฟลใ์หอ่้านอยา่งเดียว 
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5. คลิกปุ่ม “ขอ้ความ” เลือกตาํแหน่ง และพิมพข์อ้ความทีDตอ้งการ 

 
6. เลือกทีD “Fontwork Gallery” 

 
7. เลือกรูปแบบทีDตอ้งการ, คลิกปุ่ม “OK” 
8. คลิกทีD Fontwork และเลืDอนไปยงัตาํแหน่งทีDตอ้งการ 
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9. ดบัเบิ�ลคลิกทีD Fontwork และพิมพข์อ้ความทีDตอ้งการ 

 
10. คลิกบริเวณอืDนเพืDอรับรองค่าทีDพิมพ ์

11. คลิกทีDปุ่ม “Gallery”  
12. คลิกทีD “Backgrounds”, เลือกรูปแบบทีDตอ้งการ 
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13. ลากมาวางไวใ้นรูป “เคา้ร่าง” 
14. คลิกเมนู Insert > Slide 

จะไดเ้อกสารหนา้ทีDสอง 

15. คลิกทีD “From File”, ระบุตาํแหน่ง และชืDอไฟล,์ คลิกปุ่ม “Open” 
จะไดรู้ปภาพปรากฎขึ�น 
รูปภาพทีDแทรกนอกจากเป็นภาพนิDง สามารถทีDใส่เป็นเสียง หรือวดีิโอไดด้ว้ย 

16. คลิกทีD “Callouts”  
17. ลากบริเวณทีDตอ้งการ  

ใหส้งัเกต สญัลกัษณ์ตอ้งเป็น I beam  
18. การเลืDอนตาํแหน่งใหค้ลิกปุ่มลูกศรดา้นซา้ย จะเป็นรูปมือ แลว้ลากเลืDอนยงัตาํแหน่งทีDตอ้งการ 

 
19. ดบัเบิ�ลคลิกทีD “Call Out” และพิมพข์อ้ความลงไป 
20. คลิกเมนู File > Save 
21. ระบุตาํแหน่ง และชืDอไฟลที์Dตอ้งการ, คลิกปุ่ม “Save” 

ไฟลที์Dไดเ้ป็นนามสกลุ .odg 
22. คลิกเมนู File > Close 
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การปรับรูปภาพที(จดัเตรียม 
1. เปิดโปรแกรม OpenOffice.org Draw 
2. คลิกเมนู File > Open 
3. ระบุตาํแหน่ง และเลือกไฟลที์Dตอ้งการ, คลิกปุ่ม “Open” 

 
4. คลิกแถบ Zoom ดา้นซา้ยล่างเลืDอนขนาดทีDตอ้งการ  

ปัจจุบนัเป็น 43% ถา้เลือกดา้นขวาจะขนาดใหญ่ขึ�น ถา้เลืDอนดา้นซา้ยจะเลก็ลง 

 
5. คลิกทีDรูป, และคลิกปุ่ม “ลูกเล่น” เลือกรูปแบบ “พลิก” 

 
6. คลิกกรอบสีDเหลีDยมดา้นซา้ยลากผา่นแนวเสน้กลาง (คลิกเมาส์ซา้ยคา้งไว)้ รูปจะสลบัซา้ยขวาให ้

ซึDงถา้ไม่คลิกทีDลูกเล่นใหมี้แนวเสน้กลางก่อน การลากจะเป็นการลดขนาดรูปภาพ 
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7. คลิกทีDรูปภาพทีDตอ้งการจดัตาํแหน่ง, เลือกรูปจดัตาํแหน่งตรงกลาง 

 
8. คลิกรูป “ดาว” เลือก “ดาว 4 แฉก” 

 
9. ลากเลือกตาํแหน่งทีDตอ้งการ 
10. คลิกเมาส์ขวาทีDรูปดาว, เลือก “Edit Style” 
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11. คลิกทีDแทบ็ พื�นทีD, เลือกรูปแบบทีDตอ้งการ, คลิกปุ่ม “ตกลง” 
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12. คลิกทีDแทบ็ “Text Animation” 
13. ทีDลูกเล่น เลือกวา่ “Blink”, คลิกปุ่ม “OK” 

 
เราสามารถทีDปรับเปลีDยนค่ารายละเอียดนอกจาก การเลือก “Edit Style” ยงัสามารถเลือกค่าปรับเปลีDยนไดจ้าก 
Toolbar 
ในภาพจะพบวา่มีอยู ่3 ออปเจค ซึDงใน OpenOffice.org Draw จะมองเป็น 3 ชั�น 

14. คลิกปุ่ม “Navigator” 

 

 
เราสามารถทีDคลิกปุ่มดูหนา้ถดัไป หรือหนา้สุดทา้ย หรือยอ้นไปดูก่อนหนา้ในไฟลที์Dเปิดใชง้านอยู ่ถา้เลิกใชค้ลิก
ปุ่ม “X” 

15. คลิกปุ่ม “บนัทึก” 

16. คลิกปุ่ม “ส่งออกโดยตรงเป็น pdf” , ระบุตาํแหน่ง และชืDอไฟล,์ คลิกปุ่ม “บนัทึก” 
รูปภาพทีDไดจ้ะเป็นไฟล ์.pdf 

17. คลิกเมนู แฟ้ม > ปิด 
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บทที� 9 การใช้งานซอฟต์แวร์เพื�อความบันเทงิ 

9.1 การใช้ซอฟต์แวร์ในการดูภาพยนตร์ (Movie Player) 

โปรแกรมวดีโีอ 
โปรแกรมดูหนงัใน Suriyan จะมีชืDอวา่ Totem ครับ ใชส้าํหรับเล่นไฟลภ์าพยนตต์่างๆรวมถึง CD และ DVD ดว้ย  
วธีิการเรียกโปรแกรมสามารถเรียกได้โดย 

1. ไปทีD Main Menu > เสียงและวดีิโอ > โปรแกรมเล่นภาพยนตร์  (Movie Player)  
โดยในเบื�องตน้หลงัจากทีDติดตั�ง Suriyan เสร็จแลว้ โปรแกรมจะไม่สามารถเล่นไฟลบ์างประเภทได ้เนืDองจากการ
เขา้รหสัของไฟลบ์างประเภทนั�น ติดสิทธิบตัร ฉะนั�น Suriyan จึงไม่ไดร้วมตวัถอดรหสัมาใหจึ้งไม่สามารถชม
ภาพยนตร์ไดท้นัที จาํเป็นตอ้งติดตั�ง แพค็เกจบางอยา่งเพิDม  

2. คลิกทีDเมนู ภาพยนตร์ > เล่นแผน่ ‘ชืDอแผน่’ 
กรณีทีDดูเป็นไฟล ์.mpg ใหค้ลิกเมนู ภาพยนตร์ > เปิด > ระบุตาํแหน่งทีDเก็บไฟล ์> คลิกปุ่ม “เพิDม” 

 

3. คลิกปุ่ม Play   

4. ถา้ตอ้งการทีDจะหยดุชัDวขณะใหค้ลิกปุ่ม Pause  
5. เลืDอนแถบเวลาถา้ตอ้งการดูในเฟรมทีDตอ้งการ 
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โปรแกรม Brasero 
เป็นโปรแกรมเขียนแผน่ CD/DVD ทีDติดตั�งมาพร้อมกบัระบบปฏิบติัการ Suriyan  
การเรียกใช้ และโครงการสร้างแผ่นเพลง 

1. เลือก Main Menu > เสียงและวดีิโอ > โปแกรมเขียนแผน่ Brasero 

 
2. คลิกปุ่ม “โครงการแผน่เพลง” 
3. คลิกปุ่ม “+”  
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4. คลิกปุ่ม “เขียนแผน่…” 
5. เลือกความเร็วในทีDนี� คือ “ความเร็วสูงสุด” 

กรณีทีDเป็น DVD ก็จะเปลีDยนไปตามชนิด 

 
6. คลิกปุ่ม “เขียนแผน่” 
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7. คลิกปุ่ม “ปิด” 

ถา้ตอ้งการเขียนอีกแผน่ใหค้ลิกปุ่ม “เขียนอีกแผน่” 
หรือถา้ตอ้งการออกแบบปกใหค้ลิกปุ่ม “สร้างปก” ในทีDนี� จะสร้างปกใส่กล่อง และพิมพอ์อกทางเครืDองพิมพ ์

 
8.  เพืDอปิดโปรแกรม 

 
โครงการสร้างแผ่นข้อมูล 

1. เปิดโปรแกรม Brasero 
2. คลิกปุ่ม “โครงการสร้างแผน่ขอ้มูล” 
3. คลิกเครืDองหมาย “+” เพืDอเขียนแผน่ 
4. ระบุชืDอ และตาํแหน่งทีDเก็บไฟล ์ 
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5. คลิกเครืDองหมาย “+”  
6. เลือกตาํแหน่ง และระบุไฟลที์Dตอ้งการ, คลิกปุ่ม “เพิDม” 

ใส่แผน่ CD/DVD 
7. คลิกปุ่ม “เขียนแผน่” ถา้ตอ้งการเขียน 

กรณีทีDเลือกเป็นไฟลอิ์มเมจจะไดน้ามสกลุ .iso 
8. กาํหนดความเร็ว และออปชัDนในการเขียน 

 
9. คลิกปุ่ม “เขียนแผน่” 

รอโปรแกรมเขียนแผน่ทีDระบุ 
10. คลิกปุ่ม “ปิด” เมืDอเสร็จเรียบร้อย 

 
โครงการแผ่นภาพยนตร์ 

1. คลิกทีDเมนู โครงการ > โครงการแผน่ภาพยนตร์โครงการใหม่ 
2. คลิกปุ่ม “ละทิ�งโครงการ” 
3. คลิกเครืDองหมาย “+”  
4. ระบุตาํแหน่ง และเลือกไฟล,์ คลิกปุ่ม “เพิDม” 
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5. คลิกทีDปุ่ม “เขียนแผน่…” 

กรณีทีDเลือกเป็นไฟลอิ์มเมจจะไดน้ามสกลุ .iso 
 
การทาํสําเนาแผ่น 

1. คลิกทีDปุ่ม “ทาํสาํเนาแผน่” 

 
2. ใส่แผน่ตน้ฉบบัจะขึ�นรายการทีDปรากฎ และเลือกแผน่ปลายทางทีDตอ้งการเขียน, คลิกปุ่ม “ทาํสาํเนา” 

กรณีทีDเลือกเป็นไฟลอิ์มเมจจะไดน้ามสกลุ .toc ซึDงเราสามารถคลิกปุ่ม “คุณสมบติั” เพืDอทาํการระบุชืDอไฟล ์
 

3. รอระบบทาํการสร้างอิมเมจ เสร็จแลว้ใส่แผน่ใหม่ลงไป 
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4. คลิกปุ่ม “ปิด” เพืDอเสร็จสิ�น 
ถา้ตอ้งการเขียนอีกแผน่ใหค้ลิกปุ่ม “เขียนอีกแผน่” 

 
การเขียนอมิเมจ 
เป็นการทีDผูเ้ขียนแผน่ตอ้งเตรียมไฟลน์ามสกลุ .iso หรือ .toc 

1. คลิกปุ่ม “เขียนอิมเมจ” 
2. คลิกทีD “Click here to select a disc_image” ระบุเลือกไฟลที์Dตอ้งการ, คลิกปุ่ม “เปิด” 

ไฟลที์Dรองรับคือ .iso, .toc 

 
3. คลิกปุ่ม “เขียนแผน่” 
4. คลิกปุ่ม “ปิด” 
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บทที� 10 การใช้งานซอฟต์แวร์ชุด Open Office 

การใช้งานชุด Open Office 
ระบบปฏิบติัการ Suriyan จะใหชุ้ด OpenOffice.org ซึDงเป็นโครงการทีDประสบความสาํเร็จอยา่งสูงทัDวโลก ซึDงในชุด
โปรแกรมนี�จะมีเครืDองมือทีDมีความสามารถสูง และครอบคลุมงานต่างๆในการดาํเนินการอยา่งครบถว้น ซึDงเหมือนกบัชุด 
Microsoft Office แต่ทีDสาํคญัคือชุดโปรแกรมต่างๆทีDติดตั�งไม่มีค่าใชจ่้าย มีทั�งบนระบบปฏิบติัการ Linux/Unix และบน
ระบบปฏิบติัการ Windows คุณอ่านรายละเอียดเพิDมเติมเกีDยวกบั OpenOffice.org, ไดจ้ากเวบ็ไซต ์OpenOffice.org  
ในส่วนนี�จะบรรยายรายละเอียดเกีDยวกบัโปรแกรมสาํหรับสาํนกังาน 
โปรแกรมสํานักงาน (GNOME Office) 
ฟีเจอร์ของชุด Office จะมีความสามารถทีDตรงกบัธุรกิจซึDงโปรแกรมชุดสาํนกังาน GNOME Office ประกอบดว้ยโปรแกรม: 

- โปรแกรมเขียนขอ้ความ( word processor) (Abiword) 
- โปรแกรมตารางคาํนวณ (spreadsheet) (Gnumeric) 
- โปรแกรมจดัการฐานขอ้มูล(database management) (GNOME-DB) 
- โปรแกรมสร้างไดอะแกรม (Dia) 
- โปรแกรมดา้นกราฟฟิก (Inkscape และ The GIMP) 
- โปรแกรมจดัการโครงการ( project management)(Planner) 

โปรแกรมเหล่านี�สามารถแยกกนัติดตั�งได ้
การเรียกใชโ้ปรแกรม OpenOffice.org ใหคุ้ณไปทีD Main Menu > สาํนกังานคุณจะเห็นโปรแกรมคาํสัDง เพืDอเรียกโปรแกรม 
OpenOffice.org ต่างๆ 
 

10.1 การสร้างรายงานอย่างง่ายด้วย OpenOffice.org Word Processor 

โปรแกรม OpenOffice Word Processor หรือ OpenOffice Writer เป็นโปรแกรมสร้าง และแกไ้ขเอกสารมีหลกัการทาํงาน
และคาํสัDงต่างๆเหมือนกบั Microsoft Word ซึDงโปรแกรมนี�สามารถทีDจะเปิดไฟลใ์นนามสกลุ .doc ได ้100 เปอร์เซ็นต ์
วธีิการเรียกใช้โปรแกรม OpenOffice Word Processor 
คลิกเมนู Main Menu > สาํนกังาน > OpenOffice Word Processor  
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1. แถบหวัเรืDอง (Title bar) เป็นทีDแสดงหวัเรืDองของเอกสาร เช่นชืDอเอกสาร 
2. แถบชุดคาํสัDงเมนู (Menu bar) เป็นทีDเก็บรวบรวมคาํสัDงในรูปแบบ Pull down menu 
3. แถบชุดคาํสัDง (Tool bar) เป็นทีDเก็บคาํสัDงเพืDอเรียกใชไ้ดโ้ดยสะดวก เราสามารถเพิDมเติมแถบเครืDองมือได ้
4. แถบไมบ้รรทดั (Ruler bar) เป็นทีDระบุตาํแหน่งของเคอร์เซอร์ และใชใ้ส่ Indent, tab ในการจดัเอกสาร 
5. แถบสถานะ (Status bar) เป็นทีDแสดงสถานะของเอกสาร 

เริ(มต้นการพมิพ์งานในเอกสาร 
1. พิมพข์อ้ความทีDตอ้งการลงในพื�นทีDสีขาว ดงัตวัอยา่ง 

1 

2 

3 

4 

4 

5 
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2. คลิกเมนู แฟ้ม > บนัทึก(File>Save) 
3. ระบุตาํแหน่ง และชืDอไฟลที์Dตอ้งการ, คลิกปุ่ม “บนัทึก” (Save) 

ไฟลน์ามสกลุ .odt 

 
4. เลือกขอ้ความ “ตรงกลาง” คลิกปุ่ม “ตรงกลาง”  

เลือกขอ้ความ “ชิดขวา” คลิกปุ่ม “ชิดขวา” 
เลือกขอ้ความ “ปรับชิดซา้ยขวา” คลิกปุ่ม “จดัชิดขอบ” โปรแกรมจะจดัชิดขอบซา้ยขวา แต่ขอ้ความตอ้งเกิน
บรรทดั 

 
5. การปรับรูปแบบก็ดาํเนินการเช่นเดียวกนั 

 
ผลทีDไดด้งัรูปดา้นล่าง 
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6. คลิกเลือกพื�นทีDทั�งหมด, คลิกปุ่ม “รายการลาํดบั” (Numbering) 

 
7. ถา้คลิกปุ่ม “รายการ”  (Bullets) จะไดด้งันี�  
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8. คลิกปุ่ม “เพิDมระยะเยื�อง”  (Increase Indent) ขอ้ความจะเลืDอนไปดา้นขวา 

 

 
ถา้คลิกปุ่ม “ลดระยะเยื�อง” (Decrease Indent)  จะไปดา้นซา้ย 

9. คลิกเมนู แฟ้ม > บนัทึก (File>Save), คลิกปุ่ม “บนัทึก” (Save) 
10. คลิกเมนู แฟ้ม > ปิด (File>Close) 

 
 
 
การใช้งานพารากราฟ 

1. เปิดโปรแกรม OpenOffice.org Writer 
2. พิมพข์อ้ความใดๆเกินบรรทดั 

พบวา่ระบบจะขึ�นบรรทดัใหม่ให ้หากกรณีทีDขอ้ความมีการเวน้วรรคโปรแกรมจะทาํการปัดใหขึ้�นบรรทดัใหม่ 
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ซึDงถา้ตอ้งการใหชิ้ดซา้ยขวาใหค้ลิกปุ่ม “จดัชิดขอบ”  
3. เมืDอเคาะ Enter โปรแกรมจะถือวา่เป็นการขึ�นพารากราฟใหม่ 
4. ทาํการทริปเปอร์คลิกทีDพารากราฟ เพืDอเลือกพารากราฟทั�งหมด 

5. ในใชรู้ปแบบทนัทีเลือก “เนื�อความ”  
6. คลิกปุ่ม “จดัชิดขอบ” 

 
7. คลิกเมาส์ขวาเลือกคาํสัDง “ยอ่หนา้” (Paragraph) 
8. ในแทบ็ “ระยะเยื�องและระยะห่าง” (Indent & Spacing) 
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กาํหนดค่าติดตั�งต่างๆ ซึDงจะมีผลต่อ Indent (ตวัเยื�อง) 

 
 

a. ค่าตวัเยื�องบรรทดัแรก 
b. ค่าตวัเยื�องบรรทดัอืDนๆ 
c. ค่าตวัเยื�องดา้นขวา 
d. ค่าแท็บเมืDอตอ้งการเลืDอนขอ้ความเขา้ไป 

 
 

ตารางที( 15 คาํอธิบายค่ากาํหนดระยะเยื%อง และระยะห่าง 

ค่ากาํหนดระยะเยื%อง และระยะห่าง คาํอธิบาย 
ระยะเยื�อง  
ก่อนขอ้ความ เป็นการกาํหนดเยื�องดา้นซา้ยของพารากราฟ 
หลงัขอ้ความ เป็นการกาํหนดเยื�องดา้นขวาของพารากราฟ 
บรรทดัแรก เป็นการกาํหนดเยื�องเฉพาะบรรทดัแรก 

a b 

c 

d 
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ค่ากาํหนดระยะเยื%อง และระยะห่าง คาํอธิบาย 
อตัโนมติั กาํหนดเป็นเช็คบ็อกซ์ใหท้าํงานอตัโนมติั 
ระยะห่าง  
เหนือยอ่หนา้ เป็นความกวา้งระหวา่งพารากราฟ หรือขอ้ความดา้นบน 
ใตย้อ่หนา้ เป็นความกวา้งระหวา่งพารากราฟ หรือขอ้ความดา้นล่าง 
ระยะห่างบรรทดั ระบุเลือกความห่างเป็นบรรทดัเดียว หรือมากกวา่ หรือจะเป็นการ

กาํหนดตามสดัส่วน 
ลงทะเบียน-จริง ใหร้ะบุวา่ใชง้านหรือไม่ 

9. คลิกปุ่ม “ตกลง” เพืDอยอมรับค่ากาํหนด 
ค่าแท็บทีDระบุเป็นการกาํหนดตาํแหน่งเมืDอมีการกดคีย ์Tab ประกอบดว้ย 

 

 แท็บซา้ย  แท็บขวา  แท็บจุดทศนิยม แท็บกลาง 
เมืDอคลิกค่าชนิดแท็บ และคลิกทีDแถบไมบ้รรทดัจะปรากฎชนิดแท็บขึ�น และค่าแท็บค่าโดยทัDวไปทีDเป็นกึDงกลางจะหายไป 

• แท็บซา้ยค่าทีDพิมพจ์ะเลืDอนไปดา้นซา้ย 

• แท็บขวาค่าทีDพิมพจ์ะเลืDอนไปทางขวา 

• แท็บจุดทศนิยมค่าทีDพิมพจ์ะเลืDอนตรงจุดทศนิยมเป็นเกณฑ ์

• แท็บกลางค่าพิมพจ์ะจดัซา้ยขวา 
การใส่ตารางในเอกสาร 
โปรแกรมในการพฒันาเอกสารจาํเป็นทีDตอ้งมีการใส่ตาราง และรูปภาพ ซึDงในทีDนี�จะกล่าวถึงวธีิการใส่ตารางในเอกสาร 

1. เปิดโปรแกรม OpenOffice.org Writer 
2. คลิกเลือกทีDบรรทดัสุดทา้ย และเคาะ Enter 

3. คลิกคาํสัDง “ตาราง”  
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4. ระบุชืDอตารางทีDตอ้งการ, ขนาดของตารางประกอบดว้ย คอลมัน์ และแถว 

กรณีทีDตารางมีการพิมพห์ลายหนา้ใหเ้ลือก “ส่วนหวั” เพืDอระบการพิมพซ์ํ� าหรือไม่ 
5. คลิกปุ่ม “ตกลง” 
6. พิมพข์อ้ความในช่องตารางทีDตอ้งการ 
7. กดคีย ์Tab เพืDอขึ�นแถวใหม่ 

 
 
การใส่รูปภาพในเอกสาร 

1. ไปทีDบรรทดัสุดทา้ย, เคาะ Enter 

2. คลิกคาํสัDง “คลงัภาพ”  
3. คลิกทีD “ธีมใหม่…” 
4. พิมพชื์DอทีDตอ้งการ เช่น Myimage 
5. คลิกทีDแทบ็ “แฟ้ม” ระบุตาํแหน่งไฟลที์Dตอ้งการ, คลิกปุ่ม “ตกลง” 
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6. ระบุไฟลที์Dตอ้งการ, คลิกปุ่ม “เพิDม” (Add) 
7. คลิกปุ่ม “ตกลง” (Ok) 
8. คลิกขวารูปภาพทีDตอ้งการ และเรียกคาํสัDง “คดัลอก” รูปภาพจะแสดงทีDเอกสาร 
9. คลิกปุ่ม “คลงัรูปภาพ” เพืDอนาํธีมออก 

กรณีทีDตอ้งการแทรกรูปภาพโดยตรงไม่ผา่นธีม ใหค้ลิกทีDเมนู แทรก > รูปภาพ > จากแฟ้ม > และระบุชืDอไฟล ์
 
การตกแต่งเอกสาร 
คุณสามารถทีDจะตกแต่งเอกสารใหเ้กิดความสวยงามไดโ้ดยการใส่สี ปรับตกแต่งตารางหรือขอ้ความทีDสนใจ รวมถึงการใส่
ลิงคเ์ขา้ไปยงัอินเทอร์เน็ตได ้

1. เปิดไฟลที์Dจดัเตรียมไวใ้ห ้  

 
2. ทีDส่วนหวัใหเ้ลือก  
- ขนาดฟอนต ์20 
- ตวัหนา 
- จดักึDงกลาง 
- ใส่สีนํ� าเงิน 
3. พารากราฟทีDหนึDงใหค้ลิกขวา เลือกยอ่หนา้  
- ระบุบรรทดัแรก เยื�อง 1 นิ�ว 
- เหนือยอ่หนา้ .1 นิ�ว 
- ใตย้อ่หนา้ .08 นิ�ว 
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- ระยะห่างบรรทดั บรรทดัเดีDยว 
คลิกปุ่ม “ตกลง” 

4. เลือกรายการทีDตอ้งการใส่เลขหนา้, คลิกปุ่ม  “รายการลาํดบัเปิด/ปิด” (Numbering On/Off) 

 
5. พบวา่ทีD แถบไมบ้รรทดั Indent จะเปลีDยน  

ซึDงกรณีทีD Indent หรือตวัเยื�องไม่ตรงปรับใหส้วยงาม 

6. เลือกขอ้ความทีDตอ้งการทาํ Hyperlink  
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7. พิมพลิ์งค ์URL ทีDตอ้งการ, คลิกปุ่ม “ปิด. (Close) 
ค่าทีDกาํหนดนี�จะต่างจากการพิมพ ์http://www.suriyan.in.th ตรงทีDจะไม่ปรากฎ URL ขึ�นจะมีผลเมืDอคุณทาํการ
คลิก 

8. เลือกหวัตาราง 

 
จะขึ�นแถบเครืDองมือในการบริหารตาราง 

9. เลือกสีพื�นหลงั  และสีของขอบตารางทีDตอ้งการ  

 
10. จดัตกแต่งเอกสารทีDเหลือใหส้วยงาม, คลิกเมนู แฟ้ม, บนัทึก (File>Save) 

 
การจดัทาํเอกสารหลายหน้าเบื%องต้น 
เอกสารจาํนวนมากนอกจากจะจดัเตรียมขอ้ความแลว้อาจจะตอ้งมีการใส่หวักระดาษ ทา้ยกระดาษเช่นเลขหนา้ ชืDอเอกสาร
เป็นตน้ เราสามารถทีDจะใช ้OpenOffice.org Writer ในการจดัทาํ 
ขั%นตอนการจดัทาํเอกสารหลายหน้า 

1. เปิดเอกสารทีDจดัเตรียมไวใ้ห ้(หรือเอกสารทีDมีมากกวา่ 1 หนา้) 
2. คลิกเมนู แทรก > หวักระดาษ > ค่าปริยาย (Insert>Header>Default) 
3. ใส่ชืDอเอกสารทีDตอ้งการ  

 
4. คลิกทีDกลางเอกสาร พบวา่เมืDอกดคียเ์ลืDอนหนา้ขึ�น และลงในทุกหนา้จะมีหวักระดาษทีDระบุ 
5. คลิกเมนู แทรก > ทา้ยกระดาษ > ค่าปริยาย (Insert>Footer>Default) 
6. คลิกเมนู มุมมอง > แถบเครืDองมือ > แทรก (View>Toolbars>Insert) 

 

7. คลิกปุ่ม “แทรกเขตขอ้มูล”  
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8. คลิกทีD “เลขหนา้”(Page Number)  พิมพ ์/ และคลิก แทรก>เขตขอ้มูล > นบัหนา้  (Insert>Fields>Page Count) จะ
ไดผ้ลลพัธ์ดงัรูป 

 
 

การปรับค่าหวักระดาษ/ทา้ยกระดาษ 
1. คลิกขวาในขณะทีDอยูใ่น หวักระดาษหรือทา้ยกระดาษ, คลิกคาํสัDง “หนา้” (Page) 
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2. คลิกแท็บทีDตอ้งการเช่น ส่วนหวั (Header) 

 
3. ปรับค่าทีDตอ้งการ,คลิกปุ่ม “OK” 

 
 
การขึ%นหน้าใหม่ 
โดยทัDวไปเอกสารจะขึ�นหนา้ใหม่เมืDอจบหนา้ แต่ถา้คุณตอ้งการทีDจะบงัคบัขึ�นหนา้ใหม่ก็สามารถทาํไดด้งันี�  

1. เลือกตาํแหน่งทีDตอ้งการขึ�นหนา้ใหม่ 
2. คลิกเมนู แทรก > แทรกตวัแบ่งเอง (Insert>Insert Break) 
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3. เลือก แบ่งหนา้ (Page break), คลิกปุ่ม “ตกลง” (OK) 
 
การจดัเกบ็เอกสารในรูปแบบ PDF 
เราสามารถป้องกนัเอกสารของเราในการแกไ้ข หรือปรับเปลีDยนไดโ้ดยการจดัเก็บเอกสารเป็นรูปแบบ PDF ดงันี�  

1. เปิดเอกสารทีDตอ้งการ 
2. คลิกเมนู แฟ้ม > ส่งออกเป็น PDF (File>Export PDF) 

 
กาํหนดค่าส่งออกทีDตอ้งการ เช่นกาํหนดหนา้ทีDจะพิมพ,์ ถา้แปลงรูปภาพเป็น jpg, หรือกาํหนดค่าออปชัDนใน
เอกสารส่งออกดว้ย 

3. คลิกปุ่ม “Export” และคลิกปุ่ม “บนัทึก” (Save) 
การพมิพ์เอกสาร 

1. เปิดเอกสารทีDตอ้งการ 
2. คลิกเมนู แฟ้ม > พิมพ ์(File>Print) 
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3. ระบุเลือกเครืDองพิมพที์Dตอ้งการ 

ถา้ตอ้งการกาํหนดคุณสมบติัเครืDองพิมพ ์เช่นชนิดการพิมพ ์กระดาษใหค้ลิกปุ่ม “คุณสมบติั” (Properties) 
4. ระบุหนา้ทีDตอ้งการ และจาํนวนสาํเนา, คลิกปุ่ม “ตกลง” (OK) 
5. นาํงานพิมพม์าตรวจสอบ 
6. คลิกเมนู แฟ้ม > ออก (File>Close) 

กรณีทีDมีการแกไ้ขใหค้ลิกปุ่ม “บนัทึก” (Save) 
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10.2 โปรแกรมตารางคาํนวณ OpenOffice.org  Spreadsheet 

เป็นโปรแกรมทีDบริหารจดัการเซลลใ์นตารางคาํนวณมีหลกัการทาํงานเหมือน Microsoft Excel  
วธีิการเรียกใช้งาน 
คลิกเมนู Main Menu > สาํนกังาน > OpenOffice.org Spreadsheet 

 
1. แถบหวัเรืDอง (Title bar) เป็นทีDแสดงหวัเรืDองของตารางคาํนวณ เช่นชืDอตารางคาํนวณ 
2. แถบชุดคาํสัDงเมนู (Menu bar) เป็นทีDเก็บรวบรวมคาํสัDงในรูปแบบ Pull down menu 
3. แถบชุดคาํสัDง (Tool bar) เป็นทีDเก็บคาํสัDงเพืDอเรียกใชไ้ดโ้ดยสะดวก เราสามารถเพิDมเติมแถบเครืDองมือได ้
4. พื�นทีDแผน่งาน (Name box) เป็นทีDระบุตาํแหน่งอา้งถึงเซลล ์
5. แถบสูตร (Formula bar) เป็นทีDใส่สูตร หรือขอ้ความในเซลล ์
6. หวัคอลมัน์ (Column bar) เป็นทีDระบุตาํแหน่งคอลมัน ์แสดงเป็นอกัษรภาษาองักฤษ 
7. หวัแถว (Row bar) เป็นทีDระบุตาํแหน่งแถบแสดงเป็นเลข 
8. แท็บชีต (Sheet tab) เป็นทีDระบุแผน่งาน 
9. แถบเลืDอน (Scroll bar) เป็นทีDเลืDอนดูตาํแหน่งของชีต 
10. แถบสถานะ (Status bar) เป็นทีDแสดงสถานะของตารางคาํนวณ 

 

1 
2 

3 

5 4 

6 

7 

8 9 

10 
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เริ(มใช้งานตารางคาํนวณอย่างง่าย 
1. เปิดโปรแกรม OpenOffice.org Calc 

 
2. เลือกช่อง A1 พบวา่ “พื�นทีDแผน่งาน” ขึ�นวา่ A1  
3. พิมพข์อ้ความทีDตอ้งการลง เช่น A และเคาะ Enter เป็นการใส่ขอ้มูลในเซลล ์

เซลลคื์อพื�นทีDสีDเหลีDยมเลก็ทีDรองรับการใส่ขอ้มูล หรือสูตร 
4. ใส่ขอ้มูลตามรูปดา้นล่าง 

 
5. ใส่สูตรโดยพิมพ ์=B1+B2 และเคาะ Enter 

 
6. ผลทีDไดจ้ะเป็นผลรวมของทั�งสองเซลล ์
7. คลิกเมนู แฟ้ม > บนัทึก (File>Save) 
8. ระบุชืDอไฟล ์และคลิกปุ่ม “บนัทึก” (Save) 

นามสกลุทีDบนัทึกเป็น ods 
 
การใส่สูตรคาํนวณ 
ใส่ขอ้มูลดงัภาพ 
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เราสามารถทีDจะใส่สูตรคาํนวณผลรวม ค่าเฉลีDย และค่าสูงสุด/ตํDาสุด ไดด้งันี�  

1. คลิกทีDพื�นทีDแผน่งาน B9 
2. พิมพว์า่ =AVERAGE(B2:B8) และเคาะ Enter 
3. คลิกทีDพื�นทีDแผน่งาน B10 
4. พิมพว์า่ =Max(B2:B8) และเคาะ Enter 
5. คลิกทีDพื�นทีDแผน่งาน B11 
6. พิมพว์า่ =Min(B2:B8) และเคาะ Enter 
7. คลิกทีDพื�นทีDแผน่งาน B12 
8. พิมพว์า่ =Sum(B2:B8) และเคาะ Enter 

ผลลพัธ์ทีDไดคื้อ 

 
9. คลิกเลือกแถบ B9 ถึง B12 (คลิกเมาส์ซา้ยคา้งไว)้ จะเห็นปุ่มสีDเหลีDยมเลก็ (Handling) 
10. คลิกลากปุ่มสีDเหลีDยมเลก็ๆไปดา้นขวาถึงคอลมัน์ D  

ผลลพัธ์ทีDไดเ้ป็นการก๊อปปี� สูตร 
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11. คลิกเมนู แฟ้ม > บนัทึก (File>Save) 
12. ระบุชืDอไฟล ์และคลิกปุ่ม “บนัทึก” (Save) 

 
การแทรก/ลบแถว และคอลมัน์ 

1. คลิกทีDแถว 9 เป็นการเลือกแถวทั�งหมด, คลิกขวาเลือก “แทรกแถว” (Insert Rows) 

 
กรณีทีDเลือกสองแถวจะเป็นการแทรกสองแถว 

2. ใส่ขอ้มูลใหม่ลงไป 

 
3. พบวา่สูตรจะยงัไม่คาํนวณใหม่ให ้เนืDองจากค่าสูตรกาํหนดดาํเนินการระหวา่งแถวทีD 2 ถึงแถวทีD 8 
4. กดคีย ์Ctrl+F หรือเมนู แกไ้ข > แทนทีD (Find & Replace) 
5. พิมพว์า่ B8 ในช่อง สิDงทีDตอ้งการคน้หา และใส่ B9 ในช่องแทนทีDดว้ย 

คลิกปุ่ม “ตวัเลือกเพิDมเติม”, ตรวจสอบวา่ คน้หาใน ระบุไวที้D “สูตร” หรือไม่ ถา้ใชใ้หค้ลิกปุ่ม “แทนทีDทั�งหมด” 
ระวงัอยา่เลือก “ค่า” จะมีปัญหา 
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6. คลิกปุ่ม “ปิด” 
7. คลิกเลือกแถว 6 และคลิกขวา, เลือกคาํสัDง ลบแถว (Delete Rows) 
8. พบวา่สูตรจะเปลีDยนไป เมืDอคลิกไปทีD B9 พบวา่ค่าสูตรจะเป็น =AVERAGE(B2:B8)  

ซึDงสูตรจะปรับเปลีDยนใหโ้ดยอตัโนมติั 
9. คลิกเมนู แฟ้ม > บนัทึก (File>Save) 
10. ระบุชืDอไฟล ์และคลิกปุ่ม “บนัทึก” (Save) 

 
การตกแต่งตาราง 

1. เปิดตวัอยา่งงานเดิม 
2. คลิกเมาส์ลากตั�งแต่ A1 ถึง D12 
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3. คลิกปุ่ม “เสน้ขอบ”  
4. เลือกรูปแบบขวาล่างสุด 

 
ตารางจะถูกตีกรอบ 

5. เลือกช่อง A1 ถึง D1 

 
6. คลิกปุ่ม “ตวัหนา”, เปลีDยนขนาดฟอนตเ์ป็น “12” 
7. คลิกเลือกปุ่ม “Select All”  

 
8. ดบัเบิ�ลคลิกตรงเสน้แบ่งระหวา่งคอลมัน์ A และ B  

โปรแกรมจะจดัใหพ้อดีกบัความกวา้งขอ้ความทีDยาวทีDสุด 

 
9. กรณีทีDตอ้งการใหค้อลมัน์มีพื�นทีDเหลือตอ้งคลิกทีDเสน้แบ่งระหวา่งคอลมัน์เพืDอจดัขนาด 
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10. คลิกเลือกระหวา่ง A1 ถึง D1 อีกครั� ง 

11. คลิกปุ่ม “จดัตาํแหน่งกึDงกลางตามแนวนอน”  

12. คลิกปุ่ม “สีพื�นหลงั” เลือกสีทีDตอ้งการ 
13. ปรับขนาดของคอลมัน์ใหส้วยงาม โดยคลิกเมาส์ระหวา่งคอลมัน์ และลากเลืDอนจดัขนาดความกวา้ง 

 
14. เลือกพื�นทีD A9 ถึง D13 คลิกปุ่ม “สีพื�นหลงั” (Background Color)  เลือกสีใหส้วยงาม 
15. คลิกขวาแลว้เรียกคาํสัDง “รูปแบบช่อง” (Borders) 
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16. คลิกทีDรูปแบบ ขนาดเสน้ 2.50 pt, ในช่องสี เลือกเป็นสีนํ� าเงิน, คลิกปุ่ม “ตกลง” (OK) 

 
17. คลิกเมนู แฟ้ม > บนัทึก (File>Save) 
18. ระบุชืDอไฟล ์และตาํแหน่ง, คลิกปุ่ม “บนัทึก” (Save) 

 
การสร้างชาร์ต 

1. คลิกเลือกพื�นทีDเซลล ์A1 ถึง D8 

2. คลิกปุ่ม “แผนภูมิ”  



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 209 

 

 
3. เลือกกาํหนดการสร้างแผนภูมิ 4 ขั�นตอน 
- Chart Type 
- Data Range 
- Data Series 
- Chart Elements 
4. ระบุค่า Chart Type, ใหเ้ลือกเป็น Column,  เช็คบ็อกซ์ 3D, Shape ระบุเป็น Box 
5. คลิกปุ่ม  “ถดัไป” 
6. ระบุค่า Data Range ตามทีDระบุ, คลิกปุ่ม “ถดัไป” 
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7. ระบุค่า Data Series, คลิกทีD “เงินเดือน”, คลิกปุ่ม “Remove” 
และคลิก “นํ� าหนกั”, คลิกปุ่ม “Remove” 

8. คลิกปุ่ม “ถดัไป” 

 
9. ระบุค่า Chart Elements, คลิกปุ่ม “เสร็จสิ�น” 
10. คลิกเลือก “แผนภูมิทีDสร้างขึ�น”, คลิกขวา เลือกคาํสัDง “ตดั” 

 
11. คลิก “แผน่งาน2” 
12. คลิกขวาเลือก “วาง” 
13. ปรับเลืDอนขนาดของแผนภูมิ 

 
 
การปรับเปลี(ยนค่าคุณสมบัตขิองแผนภูม ิ
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1. คลิกขวาแผนภูมิ, เลือกคาํสัDง “Data Range” 

 
2. กาํหนดค่า Data Range และ Data Series, แกไ้ขเสร็จใหค้ลิกปุ่ม “ตกลง” 
3. คลิกขวาทีDแผนภูมิ, เลือก “ชนิดแผนภูมิ” (Chart Type) 

 
4. เลือกรูปแบบทีDตอ้งการ, คลิกปุ่ม “ตกลง” (OK) 

 
 
 
 
 
การบริหารข้อมูล 
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1. คลิกเลือกคอลมัน์ A2 ถึง D8 
2. คลิกเมนู ขอ้มูล > เรียงลาํดบั (Data>Sort) 

 
3. ในหนา้ “เรียงเกณฑ”์, คลิก “อาย”ุ เลือกจากนอ้ยไปหามาก (Ascending) 
4. ในหวัขอ้ “ต่อจากนั�นโดย”, คลิก “เงินเดือน” เลือกจากนอ้ยไปหามาก (Ascending) 
5. คลิกปุ่ม “ตกลง” 

 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 213 

 

6. ในคอลมัน์ C เลือก, และคลิกปุ่ม “เงินตรา”  

 
7. คลิกเมนู แฟ้ม > บนัทึก (File>Save) 
8. คลิกปุ่ม “บนัทึก” (Save) 

 
การพมิพ์ตารางงาน 

1. เปิดไฟล ์OpenOffice.org Calc ใดๆ 
2. คลิกเมนู “แฟ้ม” > “พิมพ”์ (File>Print) 
3. คลิกปุ่ม “คุณสมบติั” (Properties) 

 
กาํหนดค่ากระดาษตามชนิดเครืDองพิมพ,์ คลิกปุ่ม “ตกลง” 

4. คลิกปุ่ม “ตวัเลือก” (Options) 
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5. กาํหนดค่าทีDตอ้งการ, คลิกปุ่ม “ตกลง” 
6. คลิกปุ่ม “ตกลง” ถา้ตอ้งการพิมพง์าน 

กรณีที(ดูก่อนพมิพ์ 
1. เปิดไฟลง์าน OpenOffice.org calc 
2. คลิกเมนู “แฟ้ม” > “ตวัอยา่งหนา้กระดาษ” (File>Page Preview) 

 
เราสามารถดูตวัอยา่งก่อนการพิมพไ์ด ้

3. คลิกปุ่ม “หนา้” (Page) 
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4. คลิกแท็บ “หวักระดาษ” (Header), คลิกปุ่ม “แกไ้ข” (Edit) 

 
เราสามารถทีDกาํหนด “หวักระดาษกาํหนดเอง” (Custom Header) 

- แบบตวัอกัษร 
- ชืDอแฟ้ม 
- ชืDอแผน่งาน 
- หนา้ปัจจุบนั 
- หนา้สรุป 
- วนัทีD 
- เวลา 
5. พื�นทีDตรงกลาง ใหใ้ส่ขอ้ความทีDตอ้งการ, คลิกปุ่ม “ตกลง” 
6. คลิกทีDแทบ็ “ทา้ยกระดาษ” (Footer), คลิกปุ่ม “แกไ้ข” (Edit) 
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7. ใส่รายละเอียดทีDตอ้งการ, คลิกปุ่ม “ตกลง” 
8. คลิกทีDแทบ็ “แผน่งาน” (Sheet) ตรวจสอบค่าทีDพิมพ ์

 
9. คลิกปุ่ม “ตกลง” เพืDอไปดูหนา้ตวัอยา่ง 
10. คลิกปุ่ม “ปิดตวัอยา่ง” (Close Preview) 

กรณีทีDตอ้งการพิมพใ์หค้ลิกปุ่ม “พิมพ”์  
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การส่งงานออกเป็น PDF 
1. คลิกเมนู “แฟ้ม” > “ส่งออกเป็น PDF”  (File>Export PDF) 

 
2. กาํหนดค่า และออปชัDนต่างๆทีDตอ้งการ เลือกรูปแบบเป็น PDF คลิกปุ่ม “Export” 
3. ระบุชืDอไฟล ์และคลิกปุ่ม “บนัทึก” (Save) 
4. คลิกเมนู “แฟ้ม” > “ออก” (File>Close) 

กรณีทีDไม่ไดบ้นัทึกใหเ้ลือก “บนัทึก” (Save) 
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10.3 โปรแกรมนําเสนอผลงาน OpenOffice.org Presentation 

เป็นโปรแกรมทีDจดัทาํสไลดเ์พืDอใชน้าํเสนอผลงาน มีหลกัการทาํงานเหมือน Microsoft PowerPoint 
วธีิการเรียกใช้ OpenOffice.org Presentation 

1. เลือก Main Menu > สาํนกังาน > OpenOffice.org Presentation 
2. ในหนา้จอแรกจะขึ�น “นาํร่องการนาํเสนออตัโนมติั”, เลือก “การนาํเสนอวา่งเปล่า”, คลิกปุ่ม “ถดัไป” 

 
3. เลือกลกัษณะหนา้ทีDตอ้งการ, คลิกปุ่ม “ถดัไป” 
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4. กาํหนดการเปลีDยนหนา้ลูกเล่น, คลิกปุ่ม “สร้าง” 

 

5. หนา้จอของ OpenOffice.org Presentation หรือ Impress 
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คาํอธิบายหน้าจอ OpenOffice.org Impress 

 
1. Title bar เป็นทีDแสดงหวัขอ้โปรแกรม Impress เช่นชืDอไฟล ์
2. Menu bar เป็นทีDเก็บคาํสัDงต่างในรูปแบบ Pull down menu 
3. Tool bar เป็นทีDเก็บคาํสัDงทีDเรียกใชบ่้อยๆ 
4. Slides bar เป็นทีDแสดงสไลดที์Dสร้าง 
5. ตวัเรียงลาํดบัภาพนิDง เป็นรูปแบบในการดาํเนินการเกีDยวกบัสไลด ์ซึDงจะเป็นภาพเดียว หรือภาพชุด 
6. Tasks bar เป็นทีDเก็บรูปแบบงานของการนาํเสนอประกอบดว้ย Master Pages, Layouts, Table Design, 

ภาพเคลืDอนไหวกาํหนดเอง, การเปลีDยนภาพนิDง 
7. Status bar เป็นทีDแสดงสถานะของไฟลที์Dนาํเสนอ 

 
การสร้างสไลด์นําเสนออย่างง่าย 

1. เมืDอไดส้ไลดเ์ปล่าแลว้, ทีD Tasks และคลิก Centered Text 

1 
2 

3 

4 
5 

6 

7 
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2. คลิกทีDสไลดต์รง “คลิกเพืDอเพิDมขอ้ความ” (Click to add text), ใหคุ้ณพิมพข์อ้ความทีDตอ้งการลงในพื�นทีDสไลด ์
3. คลิกปุ่ม “ภาพนิDง”  

 
คลิกทีDเมนู แทรก > ภาพนิDง (Insert>Slide) 
พบวา่ค่าสไลดใ์หม่จะนาํมาจากสไลดเ์ดิม 

4. ทีD Tasks ใน Layouts, คลิกทีD “ชืDอ, ขอ้ความ” (Title,Text) 

 
5. คลิกตรง “คลิกเพืDอเพิDมชืDอเรืDอง” (Click to add title) พิมพข์อ้ความทีDตอ้งการ 
6. คลิกทีD “คลิกเพืDอเพิDมเคา้โครง” (Click to add an outline) พิมพข์อ้ความทีDตอ้งการ 

ตวัอยา่งผลงาน 
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7. คลิกปุ่ม “ภาพนิDง”  
8. ทีD Tasks ใน Layouts, คลิกทีD “ชืDอ, คลิปอาร์ต, ขอ้ความ”  (Title, Clipart, Text) 

 
9. คลิกตรง “คลิกเพืDอเพิDมชืDอเรืDอง” (Click to add title)  พิมพข์อ้ความทีDตอ้งการ 
10. คลิกตรง “คลิกสองครั� งเพืDอเพิDมรูป” (Double-Click to add graphics), เขา้ไปโฟลเดอร์ และระบุรูปภาพ, คลิกปุ่ม 

“เปิด 
11. คลิกทีD “คลิกเพืDอเพิDมเคา้โครง” (Click to add an outline)  พิมพข์อ้ความทีDตอ้งการ 

ตวัอยา่งผลงาน 

 
12. คลิกปุ่ม “ภาพนิDง” 
13. ทีD Tasks ใน Layouts, คลิกทีD “ชืDอ, ตารางคาํนวณ” (Title, Spreadsheet) 
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14. คลิกตรง “คลิกเพืDอเพิDมชืDอเรืDอง” (Click to add title)  พิมพข์อ้ความทีDตอ้งการ 
15. คลิกทีD “คลิกสองครั� งเพืDอเพิDมตารางคาํนวณ” (Double-Click to add a Spreadsheet), ใส่ขอ้มูลในตาราง 

 
คลิกปรับเปลีDยนขนาด และรูปแบบทีDตอ้งการ 
ผลลพัธ์ทีDได ้

 
16. คลิกปุ่ม “ภาพนิDง” 
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17. ทีD Tasks ใน Layouts, คลิกทีD “ชืDอ, แผนภูมิ” (Title, Chart) 

 
18. คลิกตรง “คลิกเพืDอเพิDมชืDอเรืDอง” (Click to add title) พิมพข์อ้ความทีDตอ้งการ 
19. คลิกทีD “คลิกสองครั� งเพืDอเพิDมแผนภูมิ” (Double-Click to add a chart), เพืDอเขา้ในแผนภูมิ 
20. คลิกขวาทีDแผนภูมิ, เลือก “ขอ้มูลแผนภูมิ” (Chart Data Table) 

คลิกเพิDมแถวโดยใชปุ่้มแรก  ใหไ้ด ้6 รายการ 
คลิกคอลมันที์Dตอ้งการลบคลิกปุ่ม “ลบคอลมัน์” ใหไ้ดห้นึDงรายการ 

21. ใส่ขอ้มูลทีDตอ้งการผลดงัภาพดา้นล่าง, คลิกปุ่ม “X”  

 
22. คลิกปุ่ม “ภาพนิDง” 
23. ทีD Tasks ใน Layouts, คลิกทีD “ชืDอเรืDองเท่านั�น” (Title Only) 

 
24. คลิกตรง “คลิกเพืDอเพิDมชืDอเรืDอง”  (Click to add  title)พิมพข์อ้ความทีDตอ้งการ 
25. คลิกปุ่ม “ตาราง”, เลือกขนาดทีDตอ้งการ 
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26. ใส่ขอ้มูลในช่องตาราง 

 
27. การบนัทึกผลงาน, คลิกเมนู แฟ้ม > บนัทึก (File>Save) 
28. ระบุชืDอไฟล ์และตาํแหน่งทีDจดัเก็บ, คลิกปุ่ม “บนัทึก” (Save) 

นามสกลุไฟลคื์อ .odp 
 
การนําเสนอภาพนิ(ง  

1. เปิดไฟลง์านทีDตอ้งการ 

2. คลิกเมนู การนาํเสนอภาพนิDง > นาํเสนอภาพนิDง หรือกดคีย ์F5 
ถา้กาํลงัดาํเนินการในภาพนิDงใดภาพทีDแสดงจะถูกนาํเสนอ 

3. กดคีย ์Home เพืDอไปหนา้แรก 
4. กดคีย ์Page Down หรือคียลู์กศรขวา เพืDอไปหนา้ถดัไป 
5. กดคีย ์End เพืDอไปหนา้สุดทา้ย 
6. กดคีย ์Page Up หรือคียลู์กศรขวาเพืDอไปหนา้ก่อน 
7. กดคีย ์Esc เพืDอออกจากโหมดนาํเสนอ 

พบวา่สไลดปั์จจุบนัไม่ไดใ้ส่ลูกเล่นใดๆ ซึDงจะกล่าวในต่อไป 
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มุมมองต่างๆ  

 
นอกเหนือจากการเรียกจากแทบ็เหล่านี�แลว้เราสามารถเรียกคาํสัDงในการปรับเปลีDยนไดจ้ากเมนู “มุมมอง” (View) 
 
ตารางที(  16 คาํอธิบายมุมมองต่างของโปรแกรม OpenOffice.org Impress 

มุมมอง ตวัอย่าง คาํอธิบาย 
ปกติ 

 

เป็นรูปแบบปกติทีDใชใ้นการจดัทาํสไลด ์

เคา้โครง 

 

เป็นรูปแบบทีDสร้างรายการเนื�อหาจากการทาํ Outline ซึDง
จะสามารถก๊อปปี�  และวางเพืDอจดัทาํสไลดจ์าํนวนมากได้
รวดเร็ว 

หมายเหต ุ

 

รูปแบบทีDใหใ้ส่คาํอธิบายใตภ้าพเพืDอช่วยในการบรรยาย 

เอกสารประกอบ
คาํบรรยาย 

 

รูปแบบการพิมพอ์อกมาเป็นเอกสารอบรม (Handout) ซึDง
รองรับไดสู้งสุด 6 สไลดต์่อหนา้ 
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มุมมอง ตวัอย่าง คาํอธิบาย 
ตวัเรียงลาํดบั
ภาพนิDง 

 

รูปแบบทีDใชใ้นการจดัลาํดบั หรือดูภาพสไลดโ์ดยรวม 

 
การปรับแต่งสไลด์อย่างง่าย 

1. เปิดไฟลง์านทีDตอ้งการ 
2. ทีDกรอบ Tasks คลิกทีDแทบ็ Master Pages 
3. ทีD Available for use เลือกรูปแบบ Water 

 
พบวา่สไลดถู์กนาํเสนอในรูปแบบทีDเลือกคือ Water 

4. คลิกเมนู มุมมอง > เคา้โครงหลกั > แม่แบบภาพนิDง  (View>Master>Slide Master) 
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5. คลิกเลือก “คลิกเพืDอแกไ้ขรูปแบบขอ้ความชืDอเรืDอง” (Click to edit the title test format), คลิก “สีแบบอกัษร” 

 
6. คลิกเลือกสีทีDตอ้งการ 
7. คลิก “ปิดมุมมองเคา้โครงหลกั” (Close Master View) 
8. คลิกเลือกขอ้ความทีDตอ้งการ, คลิก “สีแบบอกัษร” ทีDตอ้งการ 

กรณีการกาํหนดนี�ต่างจาก แม่แบบภาพนิDงคือจะมีผลเฉพาะสไลดที์Dเลือกเท่านั�น 
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9. คลิกเลือกขอ้ความทีDตอ้งการ, คลิกเลือก “ขนาดอกัษร” ระบุขนาดทีDตอ้งการ, คลิก “ตวัหนา” เพืDอกาํหนดรูปแบบทีD
ตอ้งการ 

 
10. เลือกขอ้ความทีDตอ้งการ, เลือกปุ่ม “ไฮเพอร์ลิงก”์  
11. พิมพ ์URL ทีDตอ้งการ, คลิกปุ่ม “ใชง้านทนัที”, และคลิกปุ่ม “ปิด” 

 
ปรับแต่งสไลด์ที(เกบ็ตาราง 

1. เปิดงานทีDตอ้งการ, เลือกหนา้ทีDมีตารางอยู ่

 
2. ไปทีD Tasks และคลิกเลือก Table Design, เลือกสี และรูปแบบทีDตอ้งการ 
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3. เลือกขอ้ความหวัตาราง  
จะปรากฎเครืDองมือการออกแบบตาราง 

4. ปรับขนาด และสีทีDตอ้งการ 

 
5. คลิกปุ่ม “บนัทึก” (Save) 

 
 
การทาํภาพเคลื(อนไหวกาํหนดเอง 

1. เปิดไฟลที์Dตอ้งการ 
2. คลิกทีD “ตวัเรียงลาํดบัภาพนิDง” (Slide Sorter) 
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3. เลือกภาพทีD 1, ในแถบ Tasks ใหเ้ลือก “การเปลีDยนภาพนิDง” (Slide Transition) 
4. คลิกเลือก “คลีDขึ�น” (Wipe Up) 

พบวา่โปรแกรมจะนาํเสนอภาพตวัอยา่ง และไอค่อนจะขึ�นใตส้ไลด ์ 

 
5. คลิกปุ่ม “ใชก้บัภาพนิDงทั�งหมด” (Apply to All Slides) 

ถา้ตอ้งการแสดงรูปแบบนาํเสนออืDนๆก็สามารถดาํเนินการไดโ้ดยเลือกสไลดที์Dตอ้งการ และเลือกรูปแบบ 

6. กดคีย ์F5 หรือคลิกปุ่ม “นาํเสนอภาพนิDง”  
7. คลิกปุ่มเมาส์เพืDอทดสอบ, และกดคีย ์Esc เพืDอออก 
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ถา้เราตอ้งการทีDกาํหนดเป็นเวลาก็สามารถทาํไดโ้ดยเลือกทีD “โดยอตัโนมติัหลงัจาก” ระยะเวลาเป็นวนิาที 
นอกการการแสดงภาพแลว้เราสามารถกาํหนดอตัราความเร็ว, และเสียงทีDแสดง 

 
การใส่ Header และ Footer 

1. เปิดไฟลที์Dตอ้งการ 
เลือกรูปแบบนาํเสนอ “ปกติ” (Normal) 

2. คลิกเมนู แทรก > เลขหนา้ (Insert>Page Number) 

 
3. คลิกเช็คบอ็กซ์ “text Slide number” 
4. คลิกปุ่ม “Apply to All” 

พบวา่ดา้นขวาล่างจะแสดงตวัอยา่งใหท้ราบ 
กรณีทีDไม่ตอ้งการใหแ้สดงสไลดแ์รกใหค้ลิกเช็คบ็อกซ์ “Do not show on first slide” 

5. คลิกเมนู แทรก > เลขหนา้  (Insert>Page Number) 
6. คลิกทีDแทบ็ Notes and Handouts 
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7. คลิกเลือกเช็คบ็อกซ์ text Page number 
8. คลิกปุ่ม “Apply to All” 
9. คลิกเมนู แฟ้ม > บนัทึก (File>Save) 

 
การพมิพ์เอกสาร 

1. เปิดไฟลส์ไลดที์Dตอ้งการ 
2. คลิกเมนู แฟ้ม > พิมพ ์(File>Print) 
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3. โดยทัDวไปเอกสารจะพิมพใ์นรูปแบบ Slides ถา้ตอ้งการคลิกปุ่ม “ตกลง” 

ตารางที( 17 คาํอธิบายค่ากาํหนดคุณสมบตัขิองเครื(องพมิพ์ 

ค่ากาํหนด คาํอธิบาย 
เครืDองพิมพ ์– คุณสมบติั เป็นการกาํหนดรูปแบบการพิมพที์Dตอ้งการ 
Print Content – Content 

 
ค่าทีDกาํหนดมี Slide, Handouts, Notes, และ Outline 
กรณีทีDเป็น Handouts ใหร้ะบุลาํดบั และจาํนวนสไลดด์ว้ย 

ช่วงการพิมพ ์ โดยทัDวไปจะเป็นการพิมพท์ั�งหมด ถา้ตอ้งการระบุสไลดใ์หร้ะบุเป็นช่วงสไลด์
ทีDตอ้งการ 

สาํเนา เป็นการระบุจาํนวนสาํเนาทีDสัDงพิมพ ์
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ค่ากาํหนด คาํอธิบาย 
ตวัเลือก 

 
- ระบุคุณภาพ 
- พิมพ ์
- ตวัเลือกหนา้ 

4. คลิกปุ่ม “ตกลง” 
5. คลิกปุ่ม “ตกลง” 
6. คลิกเมนู แฟ้ม > ปิด (File>Close) 
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ภาคผนวก 
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ภาคผนวก ก. เคลด็ลบั และเทคนิคการบริหารงานสุริยนั 

ก.1 คาํสั�งการดูแลพื�นฐาน 

เป็นชุดเครืDองมือทีDใชใ้นการบริหารระบบปฏิบติัการ Suriyan เช่นการบริหารเขียนซีดีรอม, การบริหารงานดิสก,์ อุปกรณ์
ฮาร์ดแวร์, เครืDองพิมพ,์ ผูใ้ช ้และอืDนๆ ซึDงรายละเอียดแสดงดงัตารางดา้นล่าง 

 
ตารางที(  18  คาํอธิบายชุดเครื(องมอืที(ใช้ในการบริหาร 

ค่ากาํหนด คาํอธิบาย 
APTonCD เป็นโปรแกรมทีDช่วยในการสร้าง Repository บน CD 
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ค่ากาํหนด คาํอธิบาย 

 
Disk Utility เป็นเครืDองมือทีDใชต้รวจสอบ และบริหารงานดิสก ์โดยระบบไฟลที์Dรองรับบน Suriyan คือ 

ext2 ext3 และ ext4 รวมถึงระบบไฟล ์FAT 

  
GParted เป็นโปรแกรมทีDบริหารงานพาร์ติชัDนบนดิสก ์เหมือนโปรแกรม Fdisk บน Linux หรือ 

Windows 
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ค่ากาํหนด คาํอธิบาย 

 
Hardware Drivers เป็นเครืDองมือแสดงรายการอุปกรณ์ฮาร์ดแวร์ทีDติดตั�งบนเครืDอง 
Login Screen เป็นค่ากาํหนดลอ็คหนา้จอสาํหรับผูใ้ชที้Dกาํลงัใชง้านอยู ่

 
System Testing เป็นคาํสัDงทีDใชต้รวจสอบระบบวา่ทาํงานไดป้กติหรือไม่ 
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ค่ากาํหนด คาํอธิบาย 

 
รายการทีDระบุทดสอบประกอบดว้ยรายการดงัรูปดา้นล่าง 

 
เครืDองพิมพ ์ เป็นเครืDองมือบริหารเครืDองพิมพท์ั�งติดตั�ง และตรวจสอบค่าในการพิมพ ์
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ค่ากาํหนด คาํอธิบาย 

 
เครืDองมือจดัการแพกเกจ 
Synaptic 
 

เป็นเครืDองมือทีDช่วยในการติดตั�งซอฟตแ์วร์เหมือน Add or Remove Program ใน
ระบบปฏิบติัการ Windows 

 
ค่ากาํหนดติดตั�ง และเลือกหมวดหมู่ซอฟตแ์วร์ในการติดตั�ง 
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ค่ากาํหนด คาํอธิบาย 

 
ตรวจสอบเครือข่าย เป็นเครืDองมือในการกาํหนดค่าเครือข่าย และตรวจสอบสถานะของเครือข่าย ซึDงรายละเอียด

ประกอบดว้ย 
- ค่ากาํหนดอุปกรณ์ 
- คาํสัDง Ping 
- คาํสัDง Netstat 
- คาํสัDง Traceroute 
- คาํสัDงตรวจสอบพอร์ต 
- ชืDอเครืDอง 
- คาํสัDง Finger 
- คาํสัDง Whois 
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ค่ากาํหนด คาํอธิบาย 

 
ติดตามทรัพยากรระบบ เป็นคาํสัDงทีDใชต้รวจสอบทรัพยากรทีDใชป้ระกอบดว้ย 

- ค่าตรวจสอบระบบ 
- ค่าโพรเซส 
- ทรัพยากร 
- ระบบแฟ้ม 

 
โปรแกรมจดัการการปรับ
รุ่น 

เป็นโปรแกรมทีDตรวจสอบรุ่นของระบบปฏิบติัการ เช่นตวัอยา่งนี�แสดงวา่ระบบปฏิบติัการทีD
ใชเ้ป็นรุ่นใหม่ล่าสุด 
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ค่ากาํหนด คาํอธิบาย 

 
โปรแกรมอ่านแฟ้มปูม เป็นระบบเก็บลอ็กต่างๆทีDบนัทึกกิจกรรมดาํเนินการ 

 
ผูใ้ชแ้ละกลุ่มผูใ้ช ้ ใชบ้ริหารบญัชีรายชืDอ และกลุ่มรายชืDอ ซึDงดีฟอลทจ์ะมีชืDอทีDกาํหนดในการติดตั�ง และ root 



การใชง้านระบบปฏิบติัการ Suriyan 

 

หนา้ทีD 247 

 

ค่ากาํหนด คาํอธิบาย 

 
เวลา และวนัทีD เป็นค่ากาํหนดติดตั�งเวลาประกอบดว้ย 

- เขตเวลา 
- วธีิตั�งค่า 
- เวลา 
- วนัทีD 

 
สนบัสนุนภาษา เป็นค่ากาํหนดภาษาทีDแสดงในเมนู และหนา้จอลอ็คอิน 
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ค่ากาํหนด คาํอธิบาย 

 
แหล่งของซอฟตแ์วร์ ระบบปฏิบติัการ Suriyan นั�นพฒันาต่อมาจากระบบปฏิบติัการ Ubuntu ซึDงพฒันาจากบริษทั 

Canonical 

 
 

ก.2 เคลด็ลบัการรีเซตรหัสผ่าน root  

เราพบวา่มีหลายเหตผุลทีDเราจาํเป็นทีDตอ้งรีเซตรหสัผา่น 

- เครืDองคอมพิวเตอร์นี�ไดจ้ากบุคคลอืDนซึDงไดติ้ดตั�งระบบปฏิบติัการสุริยนัไว ้แต่ไม่ไดใ้หร้หสัผา่นกบัเรา 

- เราไดติ้ดตั�งระบบปฏิบติัการสุริยนัแลว้ไม่ไดใ้ส่ใจรหสัผา่นระหวา่งติดตั�ง 
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- เรามีรหสัผา่นมากจนจาํไม่ไดว้า่ระบบใดใชร้หสัผา่นอะไร 

ในหวัขอ้นี� เราจะช่วยใหคุ้ณรู้จกัการรีเซตรหสัผา่นเพืDอแกไ้ขปัญหาในการเขา้ใชร้ะบบปฏิบติั 

1. ใหรี้บูตเครืDองเขา้สู่ Recovery mode 

ซึDงถา้เราติดตั�งระบบปฏิบติัการสุริยนัเพียงระบบปฏิบติัการเดียวใหก้ดคีย ์Shift ระหวา่งบูตเขา้สู่เมนู Boot แต่ถา้

มีระบบปฏิบติัการมากกวา่หนึDงเช่น Windows, Mac OS ใหเ้ลือกบูตระบบก่อนเมืDอปรากฎเมนู Boot แลว้ใหก้ด

คีย ์Shift 

 

กรณีทีDเป็นเวอร์ชัDนก่อนปี 2009 จะใชคี้ย ์Esc 

2. เลือกเมนู Ubuntu, with Linux 2.6.32-21-generice (recovery mode) รอสกัพกั  
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3. เลือกเมนู root Drop to root shelf prompt ซึDงขั�นตอนหลงัจากนี�ไปตอ้งระวงัใหม้ากเนืDองคุณไดสิ้ทธิV  Root 

แลว้ 

4. เมืDอขึ�นหนา้จอเชลลถ์า้ลืมรหสัผา่นผูใ้ชค้นใดใหช้ค้าํสัDง passwd ชืDอผูใ้ช ้และใส่รหสัผา่น/ยนืยนัรหสัผา่น 

กรณีทีDรีเซตรหสัผา่น root ใหใ้ชค้าํสัDง passwd และใส่รหสัผา่น และยนืยนัเพืDออพัเดตรหสัผา่น 

 
5. พิมพ ์Exit พืDอออกไปสู่หนา้จอในการเลือกเมนูทีDบูต 
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6. เลือก Resume Resume normal boot, เคาะ Enter 

เพืDอเขา้ใชใ้นหนา้จอ Terminal ซึDงใหร้ะบุรหสัผา่นใหม่ทีDระบุ และพิมพว์า่ init 0 เพืDอบูตเขา้สู่กราฟฟิกโหมด 

ก.3 เคลด็ลบัของเดสก์ทอ็ป (Desktop Tricks) 

ในส่วนนี�จะมีรายละเอียดเกีDยวกบัคาํแนะนาํและปรับแต่ง Suriyan's desktop environment(โปรแกรมทีDเรียกวา่ GNOME),
และโปรแกรมจดัการไฟลที์Dเรียกวา่ Nautilus 
ก.3.1 เรียกโปรแกรมใช้เอง 
บางครั� งก็มีประโยชนที์Dสามารถเรียกใชโ้ปรแกรมดว้ยคาํสัDง ยกตวัอยา่งเช่น โปรแกรมไม่มีในรายการของเมนูซึDงสามารถ 
ทาํไดง่้ายดว้ยการเรียกใชห้นา้ไดอะลอ็ก เรียกโปรแกรม (Run Applications) สาํหรับโปรแกรมทีDผูใ้ชต้อ้งการใชต้ลอดเวลา
ทีDไม่มีในรายการของเมนู,ผูใ้ชส้ามารถเพิDมไดง่้ายในSuriyan (see ตอนนี� เรียกวา่“ปรับแต่งเมนู”) 

1. กดคีย ์Alt+F2 เพืDอเรียกโปรแกรม (Run Applications)  

 
2. ใช่ชืDอของโปรแกรมทีDผูใ้ชต้อ้งการจะเรียกใช,้และกดคีย ์Enter 

ก.3.2 เรียกโปรแกรมต่างๆโดยอตัโนมตัเิมื(อเริ(มโปรแกรม GNOME 
1. เลือก Main menu > ระบบ (System) >  ปรับแต่งพื�นโตะ๊ (Preferences) >  โปรแกรมเริDมวาระ 
2. กดเลือกแท็บ โปรแกรมเริDมระบบ (Startup Programs) 
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3. ใชปุ่้ม Add, Edit, and Delete ในการจดัการโปรแกรมทีDตอ้งการเรียกใชข้ณะทีDเครืDองเริDมทาํงาน บางโปรแกรมจะ 
ติดตั�ง ในรายการโดยอตัโนมติัเมืDอผูใ้ชป้รับแต่งโปรแกรมนั�น  

 

ก.4 การเข้าใช้ GNOME โดยอัตโนมัติเมื�อเริ�มเปิดเครื�องคอมพวิเตอร์ 

ผูใ้ชส้ามารถลอ็กอินโดนอตัโนมติัเมืDอเริDมระบบ แต่ไม่แนะนาํสาํหรับเครืDองส่วนใหญ่,เพราะมนัไม่ปลอดภยัและทาํใหผู้อื้Dน 
สามารถ เขา้ถึงขอ้มูลของผูใ้ช ้

1. เลือก Main Menu > ระบบ > ดูแลระบบ > หนา้จอเขา้ระบบ ( Login Screen) 
2. หนา้จอจะถูกลอ็กไวใ้หค้ลิกปุ่ม ปลดลอ็ค (Unlock) และใส่รหสัผา่นของผูใ้ช ้

เลือกชืDอผูใ้ชที้Dจะเขา้ใชโ้ดยอตัโนมติั (automatically logged in) และกาํหนดเวลาทีDนบัถอยหลงัถา้ผูใ้ชไ้ม่ไดท้าํ
อะไร 

 
คลิกปุ่ม “ปิด” 

 

ก.5 แสดงสัญญลกัษน์(icon) Computer, Home, and Trash desktop ใน GNOME 

1. เรียกโปรแกรม Configuration Editor, โดยใชค้าํสัDง gconf-editor (อ่าน ตอนนี� เรียกวา่ “เรียกโปรแกรมใชเ้อง”) 
2. เลือก apps > nautilus > desktop 
3. คลิกในช่องดา้นขา้ง computer_icon_visible, home_icon_visible, and trash_icon_visible.การปรับเปลีDยนจะมี 

ผลใหเ้ห็นทนัที 
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เริ�มโปรแกรม GNOME โดยที�ไม่ต้องปิดเปิดเครื�องใหม่ 

1. เก็บขอ้มูลและออกจากทุกโปรแกรมทีDใชอ้ยู ่
2. กดแป้นพิมพ ์Ctrl-Alt-Backspace เพืDอเริDม GNOME ใหม่ 
3. ถา้แป้นพิมพ ์Ctrl-Alt-Backspace ไม่สามารถใชไ้ด,้ใชค้าํสัDง sudo /etc/init.d/gdm restart 

(อ่าน ตอนนี� เรียกวา่ “ป้องกนัการใชแ้ป้นชุด Ctrl-Alt-Backspace ใชใ้นการเริDมโปรแกรม X ใหม่” เพืDอหยดุใช้
แป้นพิมพ ์Ctrl-Alt-Backspace) 

 
ป้องกนัการใช้แป้นชุด Ctrl-Alt-Backspace ใช้ในการเริ(มโปรแกรม X ใหม่ 

1. ทาํสาํเนาของไฟล ์/etc/X11/xorg.conf ดว้ยคาํสัDง : 
sudo cp /etc/X11/xorg.conf /etc/X11/xorg.conf_backup 

2. เรียกใชไ้ฟล ์/etc/X11/xorg.conf สาํหรับแกไ้ข: 
gksudo gedit /etc/X11/xorg.conf 

3. เพิDมบรรทดัต่อไปนี� เขา้ทา้ยของไฟล:์ 
Section "ServerFlags" 
Option "DontZap" "yes" 
EndSection 

4. เขียนขอ้มูลและออกจากโปรแกรม(ตวัอยา่ง) 
การปรับเปลีDยนจะมีผลในคราวหนา้ทีDผูใ้ชเ้ขา้มาใน GNOMEถา้ผูใ้ชต้อ้งการใหมี้ผลทนัที, เริDมตน้ GNOME ใหม่ 
(อ่าน ตอนนี� เรียกวา่ “เริDมโปรแกรม GNOME โดยทีDไม่ตอ้งปิดเปิดเครืDองใหม่” ) 
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อภธิานศัพท์ 

 

Debian : เดเบียน (องักฤษ: Debian) เป็นชุดของซอฟตแ์วร์เสรีทีDพฒันาโดยอาสาสมคัรภายใตโ้ครงการ เดเบียน ภายใต้

โครงการนี� มีเดเบียนลินุกซ์ (Debian GNU/Linux) ทีDใชลิ้นุกซ์เป็นเคอร์เนล และใชเ้ครืDองมือต่างๆ ในโครงการ GNU  

ประกอบกนัเป็นระบบปฏิบติัการ.........................................................................................................................................8 

Free Software Foundation (FSF) : มูลนิธิซอฟตแ์วร์เสรี (องักฤษ: Free Software Foundation, ชืDอยอ่: FSF) เป็นองคก์รไม่

แสวงหา กาํไรทีDก่อตั�งโดย ริชาร์ด สตอลลแ์มน เมืDอวนัทีD 4 ตุลาคม พ.ศ. 2528 (ค.ศ. 1985) เพืDอสนบัสนุนแนวทาง

ซอฟตแ์วร์เสรี มีจุดประสงคต์อ้งการใหส้ามารถเผยแพร่และแกไ้ขซอฟตแ์วร์คอมพิวเตอร์ไดโ้ดย ปราศจากขอ้จาํกดัใดๆ 

มูลนิธินี�จดทะเบียนในมลรัฐแมสซาชูเซตส์ สหรัฐอเมริกา..................................................................................................1 

GNOME : โครงการ GNOME เป็นการสร้างแพลตฟอร์มทาง คอมพิวเตอร์ ทีDเป็นซอฟตแ์วร์เสรี โดยมีเป้าหมายคือสร้างชุด

เครืDองมือทีDช่วยใหน้กัพฒันาสามารถสร้างโปรแกรม ขึ�นมาไดง่้าย รวมไปถึงสภาวะการทาํ งานแบบเดสกท์็อป (desktop 

environment - ซอฟตแ์วร์ทีDใชเ้รียกซอฟตแ์วร์อืDน ทาํหนา้ทีDจดัการกบัไฟลแ์ละระบบหนา้ต่าง) .......................................21 

GNU : โครงการ กนู (GNU) เป็นชืDอของโครงการพฒันาระบบปฏิบติัการ ริเริDมโดยริชาร์ด สตอลแมน เมืDอปี พ.ศ. 2527 โดย

มีจุดมุ่งหมายทีDจะพฒันาระบบปฏิบติัการเพืDอใหเ้ป็นซอฟตแ์วร์เสรี ทีDทุกคนสามารถนาํไปใช ้แกไ้ข ปรับปรุง หรือ

จาํหน่ายฟรี โดยไม่ตอ้งเสียค่าลิขสิทธิV  โครงการกนู ประกอบไปดว้ย เคอร์เนล ไลบรารี คอมไพเลอร์ โปรแกรมระบบ 

และ โปรแกรมประยกุตต์่าง ๆ........................................................................................................................................1, 12 

Linux Distribution : ลินุกซ์ดิสทริบิวชนั (Linux distribution) หรือ ดิสโทร (distro) เป็นการจดัแพคเกจของระบบปฏิบติัการ

ลินุกซ์ โดยรวมระบบลินุกซ์พร้อมกบั Application อืDนๆ เพืDอใหผู้ใ้ชใ้ชง้านไดส้ะดวก เช่น Ubuntu RedHat ลินุกซ์ทะเล 

เป็นตน้ ..................................................................................................................................................................................8 

Linux TLE : ลินุกซ์ทะเล (LinuxTLE) คือชืDอของระบบปฏิบติัการในลกัษณะของลินุกซ์ทีDปัจจุบนัพฒันาต่อมาจากอูบุนตุ

โดยเพิDมความสามารถภาษาไทย ปัจจุบนัพฒันาโดยเนคเทค โดยรุ่นปัจจุบนัคือ ลินุกซ์ทะเล 9.0 รหสัวา่ "หวัหิน" ทีDเนน้

การใชง้านสาํหรับผูใ้ชท้ัDวไป ทั�งการใชที้Dบา้น ทีDสาํนกังาน ในสถานศึกษา สาํหรับคอมพิวเตอร์ส่วนบุคคล ทั�ง

คอมพิวเตอร์แบบตั�งโตะ๊และคอมพิวเตอร์พกพา .................................................................................................................4 

Open Source : โอเพนซอร์ซ หรือ โอเพนซอร์ส  (open source) คือวธีิการในการออกแบบ พฒันา และแจกจ่ายสาํหรับ

ตน้ฉบบัของสินคา้หรือความรู้ โดยเฉพาะซอฟตแ์วร์ โดยโอเพนซอร์ซถูกพิจารณาวา่เป็นทั�งรูปแบบหนึDงในการออกแบบ 

และแผนการในการดาํเนินการ โดยโอเพนซอร์ซเปิดโอกาสใหบุ้คคลอืDนนาํเอาระบบนั�นไปพฒันาไดต้่อไป..................12 

OpenOffice.org : โอเพนออฟฟิศดอตออ็ก (องักฤษ: OpenOffice.org  ยอ่วา่ OO.o หรือ OOo) เป็นชุดซอฟตแ์วร์สาํนกังานทีD 

ทาํงานบนหลายระบบปฏิบติัการ เผยแพร่ในรูปแบบซอฟตแ์วร์เสรี เขียนขึ�นโดยใชชุ้ดเครืDองมือส่วนต่อประสานกราฟิก
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ของตวัเอง รองรับรูปแบบโอเพนด็อกคิวเมนต ์ (ODF) ซึDงเป็นมาตรฐานไอเอสโอ/ไออีซีเพืDอการแลกเปลีDยน ขอ้มูล และ

ใชเ้ป็นรูปแบบแฟ้มพื�นฐาน อีกทั�งยงัรองรับรูปแบบเอกสารจากไมโครซอฟท ์ออฟฟิศ และอืDน ๆ กระทัDงเดือน

พฤศจิกายน พ.ศ. 2552 โอเพนออฟฟิศดอตออ็กรองรับมากกวา่ 110 ภาษา.........................................................................7 

Slackware : สแลกแวร์ (องักฤษ: Slackware) เป็นระบบปฏิบติัการลินุกซ์แบบเสรีและโอเพนซอร์ซ ทีDพฒันาขึ�นโดย Patrick 

Volkerding โปรแกรมเมอร์ชาวอเมริกนั โดยปรับปรุงมาจาก Softlanding Linux System (SLS Linux) เผยแพร่เป็นครั� ง

แรกเมืDอปี ค.ศ. 1993 และยงัมีการพฒันาต่อเนืDองจนถึงปัจจุบนั เป็นลินุกซ์ดิสทริบิวชนัทีDเก่าแก่ทีDสุด ทีDยงัมีการพฒันาอยู่ 3 

UNIX : ยนิูกซ์ (Unix แต่ชืDอตามเครืDองหมายการคา้คือ UNIX) เป็นระบบปฏิบติัการคอมพิวเตอร์แบบหลายงาน หลายผูใ้ช ้ทีD

เริDมพฒันาโดยกลุ่มพนกังานของหอ้งปฏิบติัการ AT&T Bell Labs โดยกลุ่มนกัพฒันาทีDเป็นทีDรู้จกั คือ Ken Thompson, 

Dennis Ritchie และ Douglas McIlroy .................................................................................................................................1 

X-Window : X Window System (อาจรู้จกัในชืDอ X11 หรือ X) เป็นระบบการแสดงผลหนา้ต่างแบบบิตแมปในคอมพิวเตอร์ 

X Window เป็นระบบ GUI  มาตรฐานของระบบปฏิบติัการในตระกลูยนิูกซ์ และ OpenVMS ..........................................2 
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